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Excel Overview

This chapter is a brief overview of Microsoft Excel. Excel is one of the top-used business applications across virtually
any industry. It’s much more than graphed paper; the programing in this application streamlines and solves complicated
business problems. It has data management abilities, meaning you can store a database of customer information and
perform analysis to gather important data about your business like sales data, popular items, etc. 

Understanding how to properly use Excel is a highly employable skill and can lead to opportunities for promotion. It
helps you lead in resolving challenging issues and share the most important information.

This textbook provides practice instructions to understand how to use Excel. Take your time to use this text to practice
and rework skills in Excel to quickly learn how to use the program. It will take practice and effort, but as you learn Excel,
you will see benefits throughout your life. Speak with your instructor, tutors, and group chats to better understand this
content. 

Let’s get started by learning some of the Excel basics:

Download Excel
To install Excel on your computer, follow the steps located in the class syllabus. It’s important to note that you cannot
use the online version of Excel for this class. You need the full version of Excel not the mobile app or browser version.

Opening Excel
After downloading Excel on your computer, open it by accessing the Start Menu and searching Excel. Open the
application.

 The first menu available to you will show you template workbooks and recent workbooks. A workbook is a collection of
one or more spreadsheets, or worksheets, in a single file. 

Open a blank workbook. It should look like Figure 38.1.

3



Figure 38.1

Let’s take a look at different elements of a workbook. 

Ribbon & Tabs
The Ribbon has a selection of Tabs that offer different tools available in Excel. (See Figure 38.2)

Figure 38.2
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In the File tab, you’ll be directed to a menu where you can get more information, save, print, share, etc. your
workbook.

 Figure 38.3

 
The Home tab has basic document tools, such as access to your clipboard, formatting fonts, text alignment,
number formatting, styles, cell structure, editing tools, and analysis.

 Figure 38.4

The Insert Tab has tools you can use to insert tables, illustrations, add-ins, charts, tours, sparklines, filters, links,
comments, text boxes, and symbols.

 Figure 38.5

The Page Layout tab has tools regarding page themes, setup, scale, sheet options, and arrangements.

 Figure 38.6

The Formulas tab has tools like the function library, defined names, formula auditing, and calculation.

5



 Figure 38.7
The Data tab has tools for getting and receiving data, queries, data types, sorting and filtering data, data tools,
forecasting, and outlining tools.

 Figure 38.8

The Review tab has tools for proofing, accessibility checks, insights, languages, comments, notes, protections, and
ink.

 Figure 38.9

The View tab has options for how to view your workbook, what to show in your worksheet, zooming options, and
window arrangement.

 Figure 38.10

The Help tab has basic support options.

 Figure 38.11

The Acrobat tab has tools for creating, sharing, reviewing, and running actions in your workbook as a PDF.
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 Figure 38.12

Name Box
The Name Box indicates what cell is selected.

Figure 38.13

Formula Box
The Formula Box is where you can see or type in the information for selected cell(s).
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Figure 38.14

Rows
A row is the horizontal selection of cells, indicated by numbers on the left side of the worksheet. 

Columns
A column is the vertical selection of cells, indicated by letters at the top of the worksheet. 

Cells
Cells are the individual boxes within the grids. A single cell is indicated by the column letter and row number (for
example, A1 or F26). 

Objects
Objects are images, illustrations, charts etc. that float above the cells rather than rest inside of a specific cell.

Figure 38.15
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Worksheets
A worksheet is a spreadsheet within a workbook. Multiple worksheets can exist in a workbook. They can be added by
selecting the Plus sign ( + ) next to the most recent worksheet. Worksheets can be renamed by double-clicking the
current title.

Figure 38.16

 

Navigating Your Workbook
There are three essential data types in Excel: Text, Numbers, and Functions. 

Text
Text is just letters or words. If you type a word into a cell and it’s recognized as text, Excel defaults to align the text to
the left of the cell. You can use text to organize elements of your worksheet by labeling rows or columns according to
the data you add.

Figure 38.17

 

Numbers
Numbers come in multiple formats, including general data. Numbers are automatically aligned to the right of a cell. The
special type of numbers you’ll encounter frequently are Date or Time.

Date
You can format dates in Excel. You can use long-form dates (January 1, 2000) or short-form dates (1/1/2000). You can
also represent a date as a serial number by using the General format.

If you type in a serial number and then change the format from General to Date, it will change the serial number to its
respective date. For example, if you type in the number 1 in a General format and change the format to Date, the date
will show you 1/1/1900, which is the first date available in Excel.
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You can change the format of the date by going to the Home tab and selecting the drop-down menu in Number.
(See Figure 38.18)

Figure 38.18

 

Time
Times are similar to dates in the fact that they use serial numbers as well. For example, if we type 1.8 into a cell and
change the format to Time, it will show us 7:12:00 PM in the cell. In the formula bar, it will read, 1/1/1900 7:12:00 PM
because the serial number is attributed to that day, at that time. (See Figures 38.19 and 38.20)
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Figure 38.19
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Figure 38.20

You won’t need to memorize serial numbers of dates or times; this is only important to know because it makes it easier
to add or subtract days or time. Let’s test out how you can add days to a date in Excel:
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1. In E9, type the number 1.
2. Change the formatting to Short Date.

a. The date should change to 1/1/1900. (See Figure 38.21)

Figure 38.21

3. In F9, type in an equation to add 50 days to the date.
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a. Your equation should be =E9+50. (See Figure 38.22)

Figure 38.22
4. Press the Enter key.

a. F9 should now be a date: 2/20/1900, or 50 days past 1/1/1900. (See Figure 38.23)

Figure 38.23

Functions
Functions are predefined formulas that perform calculations using specific values in a particular order. Excel has
dozens of functions available for your use. Functions are viewable in the formula bar, and vary from adding, multiplying,
subtracting, and sorting data. This section will teach you how to insert a basic function: 

In Figure 38.25, you can see there are numbers in cells C13, C14, and C15. Use a SUM function in C16 to add them all
together. 
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1. In C16, use the equal sign ( = ) to start the function. 
2. Type SUM after the equal sign to indicate you want to add numbers together. 
3. Open the equation with a parenthesis ( ( ). 
4. Select C13 and drag down to C15 and then close the parenthesis ( ) ). 

a. The equation should read =SUM(C13:C15). (See Figure 38.24)

Figure 38.24

5. Press the Enter key.
a. C16 should have the sum of the three numbers: 6. (See Figure 38.25)

Figure 38.25

Functions are helpful because if you change one of the numbers from the selection, it will change the answer in the cell
with the function. For example, if you change the number 1 in C13 to 5, the number in C16 will change to 10. (See Figure
38.26)
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Figure 38.26

 

Note: If you have text and numbers in a cell together, Excel will recognize the cell as text-based as shown in Figure
38.27. If you ever need to label a row or column, separate it from the data to ensure you can use the appropriate
functions.

Figure 38.27

 

Change Text Format
You can change how the text or numbers in a cell appears. You can change it to bold, italic, or underline.

For example, you can change the text in a cell to bold:

16



1. Click on the cell with the text you want to change.
2. Go to the Home tab.
3. Click on B for Bold. (See Figure 38.28)

Figure 38.28

 

Change Text Alignment
Changing the position of the text within a cell is text alignment. The text can be centered, and aligned right or left. (See
Figure 38.29)

Figure 38.29

 
You can use the Wrap Text if the text is too long. 

To use Wrap Text:

1. Click on the cell you want to use Wrap Text.
2. Go to the Home tab then under the Alignment section.
3. Click on Wrap Text. (See Figure 38.30)

Figure 38.30
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Applying Borders
You can add borders to a cell or multiple cells. There is a variety of types of borders you can select. 

For example, you can apply All Borders to a particular range like B2:D5.

1. Highlight the range of cells B2:D5. (See Figure 38.31)

Figure 38.31

 
2. Go to the Home tab.
3. Click on the Borders icon.
4. Select All Borders. (See Figure 38.32)
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Figure 38.32

 

Applying Printing Setup
Many times, you want to make sure your spreadsheet prints properly.  You can adjust how many pages a spreadsheet
prints on.

1. Go to the Page Layout tab then under the Scale to Fit section (See Figure 38.33).
2. Adjust the Width to 1 page (or your desired width)
3. Adjust the Height to 1 page (or your desired length)

Figure 38.33
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Saving Your Workbook
Saving an Excel workbook is easy. 
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1. Go to the Ribbon. 
2. Select the File tab.
3. Select the Save option if it’s a new workbook. If it’s a workbook that you’ve downloaded from the files in this class,

you will use the Save As option instead. (See Figure 38.34)

Figure 38.34

 
4. Select where you would like to save it on your computer (for example, OneDrive, as shown in Figure 38.35).

Figure 38.35

a. A secondary window will open showing the path of where you can save your workbook on your device, as well
as the kind of file you’ll save it as.

5. The first textbox is where you put the title of the workbook.
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a. In this class, save the workbook with a title and your last name. (See Figure 38.36)

Figure 38.36
�. The second textbox is the file type. (See Figure 38.37)

a. It defaults to be an Excel workbook; we recommend you leave it on its default.

 Figure 38.37

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/excel_overview.
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Time Saver

This semester, we will watch a lot of videos. Before we get started in Excel, let’s take a few minutes to learn how to use
the video player to the best of its capabilities, as well as how to use it in conjunction with Excel.

Open Link in New Tab or Window
Many of you already know how to use these embedded video players, but the following tips will be very useful to you as
you work with Excel. If you follow these tips, you may save hours over this semester.

Typically, when we see a video, we would hit the play button or make it full screen. Instead of doing that, complete
the following.

1. Right-click on the Play button in the center.
2. Choose Open Link in New Tab or Open Link in New Window.

a. The video will open on a separate page. (See Figure 1.1)

Figure 1.1
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Control Bar
When you push play, you can then hit the same button and push pause. The volume control is the button to the right and
can be adjusted up or down. Directly beside it is the minute counter. This tells you how many minutes there are and how
many minutes have passed in the video.

On the right-hand side, the arrows represent the full screen mode. If you select full screen, it will take up the whole
screen. Push Escape on your keyboard to exit full screen. (See Figure 1.2)

Figure 1.2

 

There is a Closed Caption (CC)  button on the left side of the control bar. If
you would like, you can turn closed captioning on to English. When you do
that, the text of the video will be shown at the bottom as the video is
progressing. You can turn closed captioning off by selecting the CC button
and then selecting Off. (See Figure 1.3)

Figure 1.3

 
The gear-shaped button is the quality button, which should remain on auto to adjust to your internet bandwidth. (See
Figure 1.4)

Figure 1.4

 
The two arrows represent the full-screen option, and then up in the top left there is an information button that tells you a
bit about the video. (See Figure 1.5)
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Figure 1.5

       

 
In the top right corner, there is a button for smart-casting if you happen to have another device nearby that you can
broadcast this video onto, and the second is a download button in case you need to download the video to view offline
later when you’re not connected to the internet. (See Figure 1.6)

Figure 1.6

Following Along: Video Speed
The 1X button is the speed of the video, the default being 1X as shown in Figure 1.7, which is normal speed. If you want
to speed up or slow down the video, you can go faster to 1.5X, which will be one and a half times as fast as normal, or
you can slow it down to 0.75X. Now, for most videos, you should not go up to 2X speed because the video will be
playing so fast that you will not be able to understand what’s being said. But if you want to go up to 1.5X, you can save
yourself quite a bit of time by speeding up the videos. As long as you can still understand what’s being said and follow
along in your workbook. Since you’re following along in your workbook, in some cases, it may be necessary to slow it
down or pause.

25



Figure 1.7

 

Following Along: Side by Side
These instructions cover how you can work with a video on one side of your screen and an Excel workbook on the other
while working on a PC.

1. While you have the video window open, press the Windows key and the right arrow. 
a. That will move that arrow to the right side of the page. 

2. When you have your Excel file open, push the Windows key and the left arrow.
a. That will put it on the left side of the screen. 

Note: On a Mac computer, while the tab is open, go to the Window option at the top of the screen and select Tile
Window to the Right/Left. This will move the window to the right or left of the screen and give you an option of which
other windows to tile to the other side.

This gives you the option to switch between windows. This way, you can watch the video on one half of your screen
while you are doing the work on the other half of your screen. If you adjust in the middle, you can also slide over the
windows so that they fit just as you may need them to fit. If you had been using the embedded video player, when you
go to put that to the side, the embedded video is too small to be useful for you. That’s why it is recommended to use the
Open Link in New Tab or Open Link in New Window feature.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/time_saver.
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Auto Fill and Fill Series

This chapter covers the autofill and fill series features in Excel, typically used for creating numbered lists, lists of dates,
and so on.

Practice Spreadsheet

Open a blank workbook for this chapter.

Basics of Autofill
Excel can recognize and repeat patterns by automatically filling cells. Although one could type in each number by hand,
the longer the list of numbers or data is, the longer it will take to input the information by hand. To use the autofill, use
the following steps:
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1. Select a cell, and type 1.
2. Move your cursor to the little square in the bottom-right corner of the selected cell.

a. Your cursor will turn into a black cross.
3. Select and drag this little square down over the empty cells below.

a. When you release, Excel will autofill each of those cells, putting a 1 in each cell. (See Figure 2.1)

Figure 2.1

 

Creating Numbered Lists
As long as the first few numbers in the desired pattern are put into a column, the autofill function will be able to
recognize and continue the pattern for as long as you need it. Open a blank Excel workbook to practice making the
following lists. To make a basic numbered list, use the following steps:
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1. Select a cell, and type 1.
2. Press Enter to select the next cell down and type 2.
3. Select both of these cells. 
4. Move your cursor to the little square in the bottom-right corner of the selected cells.

a. Your cursor will turn into a black cross.
5. Select and drag this little square down over the empty cells below.

a. When you release, Excel will autofill each of those cells, following the numerical pattern it has recognized (1, 2,
3, 4, etc.). (See Figure 2.2)

Figure 2.2

 

Now, select a new cell in an empty column. To make the list go by twos, use the following steps:

1. Select a cell, and type 2.
2. Press Enter to select the next cell down and type 4.
3. Press Enter to select the next cell down and type 6.
4. Select all three of these cells. 
5. Move your cursor to the little square in the bottom-right corner of the selected cells.

a. Your cursor will turn into a black cross.
�. Select and drag this little square down over the empty cells below.

a. When you release, Excel will autofill each of those cells,
 following the numerical pattern it has recognized (2, 4, 6, 8, 10, etc.). (See Figure 2.3)

This function will also work with odd numbers (1, 3, 5, etc.), every five numbers (5, 10, 15, etc.), every ten numbers (10,
20, 30, etc.), and so on. It will repeat the pattern again and again, as long as it can recognize the pattern.
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Figure 2.3

 

Months and Dates
The autofill function also recognizes months and dates as patterns. 

To create a monthly list, use the following steps:

1. Select a cell, and type January.
a. Excel will automatically recognize this as a pattern.

2. Move your cursor to the little square in the bottom-right corner of the selected cells.
a. Your cursor will turn into a black cross.

3. Click and drag this little square down over the empty cells below.
a. When you release, Excel will autofill each of these cells, following the monthly pattern it has recognized

(January, February, March, etc.).

To create a daily list, use the following steps:

1. Select a cell, and type a date (for example, 4-Jul-00).
a. Excel will automatically recognize this as a pattern.

2. Move your cursor to the little square in the bottom-right corner of the selected cells.
a. Your cursor will turn into a black cross.

3. Click and drag this little square down over the empty cells below.
a. When you release, Excel will autofill each of these cells, following the daily pattern it has recognized (4-Jul-00,

5-Jul-00, 6-Jul-00, etc.).
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To create a weekly list, use the following steps:

1. Select a cell, and type a date (for example, 4-Jul-00).
2. Press Enter to select the next cell down and type the date a week from the first entry (for example, 11-Jul-00). 
3. Select these two cells.
4. Move your cursor to the little square in the bottom-right corner of the selected cells.

a. Your cursor will turn into a black cross.
5. Click and drag this little square down over the empty cells below.

a. When you release, Excel will autofill each of these cells, following the weekly pattern it has recognized (4-Jul-
00, 11-Jul-00, 18-Jul-00, 25-Jul-00, etc.). 

The autofill function will also recognize yearly patterns.

Fill Patterns
Excel’s autofill function will also recognize patterns made by the fill color within each cell. This allows the user to make
the cells alternate colors as the list continues. To do this, use the following steps:
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1. Select a cell, and type 1.
2. Press Enter to select the next cell down and type 2.
3. While the second cell is still selected, select the Home tab from the toolbar, then select the Fill Color icon, and

select the desired color. (See Figure 2.4)

 Figure 2.4

 
4. Select both of these cells. 
5.  Move your cursor to the little square in the bottom-right corner of the selected cells.

a. Your cursor will turn into a black cross.
�. Select and drag this little square down over the empty cells below.

a. When you release, Excel will autofill each of these cells, continuing the pattern of numbers and alternating
colors every other cell. (See Figure 2.5)
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Figure 2.5

 

More Options
After you have done one of these select-and-drag autofills, a little option button will appear in the bottom-right corner of
the selected pattern. This gives you the following options:

Copy Cells.
Fill Series.
Fill Formatting Only.
Fill Without Formatting.
Flash Fill.

Fill Series is the default option, which is what happens when you click and drag the little square down through the cells
to continue the pattern. Copy Formatting Only will copy the formatting of the selected cells, but not the formula or data
in the cells. Fill Without Formatting will repeat the pattern of numbers, but not the formatting. For example, in Figure
2.6, this option would repeat the pattern of numbers, but not the fill color pattern. Flash Fill is what happens when you
double-click the little square instead of dragging it down, which will fill the cells to the bottom of an adjacent list. (See
Figure 2.7)
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Figure 2.6
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Figure 2.7

 
This only works if there is data to the left of the selected list so that Excel knows where to end the data.

Here’s a tip: If your data is in the column to the right of the adjacent cells you want to use the length of, you can select
both the data you want to continue the pattern for and the empty cells that are adjacent to data of the desired length,
then double-click to autofill down to your desired length. (See Figure 2.8)
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Figure 2.8

 

Fill Series with Longer Lists
Some lists may seem too long to put into Excel, but there’s a trick that can take care of this quickly. Let’s say we wanted
to do a number list that goes up to 375,000. If we go by 100s (100, 200, 300, etc.) and start to drag down, getting to
375,000 is going to take a long time. Instead of clicking and dragging, we can use the Fill Series feature in Excel. To use
the Fill Series feature for this list, use the following steps:
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1. Select a cell, and type 100.
2. Press Enter to select the next cell down and type 200.
3. While the cell containing 100 is selected, select the Home tab, select Fill from the toolbar, and select Series. (See

Figure 2.9)

Figure 2.9

 
4. Under Series In, select Columns. 
5. Type 100 in Step Value. 
�. Type 375000 in Stop Value. (See Figure 2.10)

a. Do not include a comma in 375000.
7. Select OK. 

a. Excel will fill the cells in that column from 100 to 375,000.
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Figure 2.10

 
The Fill Series function is typically only used in place of the click and drag when you need to fill in large amounts of
data. Reasonably short sets of data (a couple hundred cells or so) can typically be clicked and dragged down in a
relatively short time.

 

Fill Series with Exponential Growth
The Fill Series function can also be used to create lists that grow exponentially.

To make a list that starts at 2 and grows to 100,000 exponentially use the following steps:

1. Select an empty cell.
2. Select the Home tab, select Fill from the toolbar, and select Series. (See Figure 2.9)
3. Under Series In, select Columns. 
4. Under Type, select Growth. (See Figure 2.11)
5. Type 2 in Step Value.
�. Type 100000 in Stop Value.

a. Do not include a comma in 100000.
7. Select OK.

a. Excel will create a list from 2 to 100,000 that grows exponentially by multiplication. 
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Figure 2.11

 
The list will multiply by two each cell down. You may notice in Figure 2.11 the data does not end with 100,000. Rather, it
ends on the number immediately before 100,000. This is because if 65,536 were to be multiplied by two, it would result
in a number greater than 100,000. If the data cannot get to the specific stop value, it will stop at the highest number it
can get to below the stop value. The same selecting-and-dragging feature works on formulas as well. This will be
covered in future chapters.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/auto_fill_and_fill_s.

Figure 2.12
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Cell Referencing

We are going to learn about cell referencing. Cell referencing in Excel is when you go to a cell and type in a formula that
refers to data in other cells, which makes it calculate the result automatically. One of the main reasons cell referencing
is important to learn is because it directly connects to a concept called circular referencing; circular referencing is a
problem caused by referencing cells in the wrong way.

First, let's suppose that we have ten different shapes. The shapes could either be a rectangle or a triangle. We want to
know the area of the shape if it’s a rectangle and the area of a shape if it's a triangle. We are given the base and the
height for each shape. (See Figure 3.1)

Figure 3.1

Practice Spreadsheet

Download this workbook for the chapter.
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Area of a Rectangle
We start by calculating the area of the rectangle, and a triangle as well. To get the area of a rectangle, it’s simply the
base multiplied by the height.

1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Select the reference cell for the Base data (B4 in Figure 3.2).
3. Type an asterisk symbol ( * ) for multiplication.
4. Select the reference cell for the Height data (C4 in Figure 3.2).
5. Press Enter to complete the cell’s formula (=B4*C4).

 Figure 3.2

 

Area of a Triangle
1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Select the reference cell for the Base data.
3. Type an asterisk symbol ( * ) for multiplication.
4. Select the reference cell for the Height data.
5. Type a forward slash ( / ) for division, and type 2 to divide the height by half.
�. Press Enter to complete the cell’s formula (=B4*C4/2).

We can select both formulas and double-click the little box in the lower-right to drag the formulas all the way to the
bottom. (See Figure 3.3)
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Figure 3.3

 

Let's assume that the base on this example is 18, which is the same as the height (see Figure 3.4). If the Base cell’s
data changes, the formula’s cell will recalculate the area of the rectangle because it is referencing the Base cell.

Figure 3.4
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Area of a Square
Another way to calculate the area of a shape is if it is a square. In this case, it’s 18 by 18 so the base and height are the
same (see Figure 3.5). We can do that by just taking either the base or the height and squaring it.

1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Select the reference cell for the Base data.
3. Type a caret symbol ( ^ ) and 2 to square the base.
4. Press Enter to complete the cell’s formula (=B4^2).

Figure 3.5

 

Circular Referencing
Now let's talk about what a circular reference is by going through an example. If we want to calculate the height of the
rectangle, and we know its area and base data, we could divide the area by the base. (See Figure 3.6)
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Figure 3.6

 

However, when we press Enter, we get an error message: 

“There are one or more circular references where a formula refers to its own cell either directly or indirectly. This might
cause them to calculate incorrectly. Try removing or changing these references, or moving the formulas to different
cells.” 

Whenever you see this warning or any type of warning in Excel where it doesn’t recognize your formula or see some kind
of problem, you should never ignore it. (See Figure 3.7)

Figure 3.7
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In this case, it has a circular reference. When we select OK, we will see a blue line showing us where the reference is
circular. It is circular because our area data cell refers to the Base and Height cells, and our calculation for the Height
cell refers to the result of the initial area formula, so it’s referencing itself. (See Figure 3.8)

Figure 3.8

 
This reasoning or logic that we have used is circular and Excel cannot compute it—no calculator could compute it. We
will need to eliminate one of the formulas. We can only reference the area formula on the inserted base and height data,
or the height based on the inserted area and base data. We cannot do both.

If you see circular referencing or an error message, you can navigate to the Formulas tab, select Error Checking, and
choose Circular References to view cells with an error. (See Figure 3.9)
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Figure 3.9

 
It may help solve the problem if you receive a workbook with a circular reference from someone else, or if you save your
work and return to it later. Understanding how to resolve circular references is a key skill as you work and create
formulas throughout a workbook that reference other cells.

When completed, your practiced worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/cell_referencing.

Figure 3.10
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Absolute and Relative Referencing

In this chapter, we’re going to learn about formula anchoring. This is also referred to as absolute or relative cell
referencing. The terms anchoring and absolute referencing can be used interchangeably.

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Cell Referencing chapter.

Anchors
Ships drop anchors to prevent drifting when there are waves. I’d like you to think about the following scriptures and how
an anchor for a ship relates to our personal lives.

“But now, behold, the [wicked] are led about by Satan, even … as a vessel is tossed about upon the waves, without …
anchor, … and even as she is, so are they” (Mormon 5:18).

“Wherefore, … hope cometh of faith [and] maketh an anchor to the souls of men, which would make them sure and
steadfast, always abounding in good works, being led to glorify God” (Ether 12:4).

This concept has some connection in Excel as well. 

Relative Referencing
When formula anchoring in a spreadsheet, a cell reference is anchored and this prevents the formula from referring to
other cells when it is dragged or copied down. This will be best described through examples:

This example includes seven or so different individuals, their annual salary, the percent of their salary that they have
deductions to go to benefits (health care insurance deductions, dental insurance deductions, 401K deductions), and
what percent of their salary they would like to have deducted for their personal savings as well. This table also includes
tithing and tax. 

We’ll start without really looking at the full table. Instead, start by going to G5 in reference to Anne’s salary. (See Figure
4.1) 
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Figure 4.1

 
1. Refer to that cell by typing =C5, and then pushing the Enter key. (See Figure 4.1)

a. It will give you the same result as cell C5: $45,000
2. Select the cell with the dotted line and drag it over the two cells to the right (D5 and E5).

a. When you hit the Enter key, the Benefits and Savings cells will show as zeros in cells H5 and I5 because they
are not formatted as percentages. 

3. Select Format Painter, then select cells C5, D5, and E5. Once they are selected, simply select G5 and it will format
from the original information. (See Figure 4.2)

Figure 4.2

 
Because it referred from C5, the formula drifted as it was dragged over. It went from C5, and then when dragged over it
went to D5 and then to E5. This is because the formula is not anchored. Similarly, if you grab the whole row and drag it
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down, it will repeat everything in the original table because none of the formulas are anchored. (See Figure 4.3)

Figure 4.3

 

You’ll notice that each cell references the corresponding relative cell, relative to the first top-left cell in our new grid. 

Absolute Referencing
Absolute referencing is also called anchoring. Learn to anchor by following the following steps.
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1. Select columns G through J.
2. Right-click on the highlighted columns and select Insert. (See Figure 4.4)

Figure 4.4

 
3. Start in G5 and reference the C5 cell by typing =C5.
4. Press the F4 key or type in an America dollar sign in front of the column and row indicators. (See Figure 4.5)
5. Press Enter.

a. This will bring in the $45,000 again.
b. However, when you drag the G5 cell over, all the cells stay at 45,000. This is because it maintains the same

reference as cell C5.
�. Label the first grid Absolute, and the second Relative.

 

Referencing the Row or the Column
Let’s try again, this time referencing either only a row or only a column.
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1. Insert four new columns again.
2. In G5, reference cell C5.
3. Press F4.

a. This will create an absolute reference for both the column and row.
4. Press F4 a second time.

a. This will create an absolute reference for only the row.
b. The column will change as you drag it across to the right, but the row will stay anchored to the original row, 5.

5. Drag cell G5 to the right and use the format painter to change the second and third values to percentages.
�. Drag these three cells down, and you’ll notice that all the rows now match row 5. (See Figure 4.6)

Figure 4.6

 

1. Insert four new columns again.
2. In G5, reference cell C5.
3. Press F4.

a. This will create an absolute reference for both the column and row.
4. Press F4 a second time.

a. This will create an absolute reference for only the row.
5. Press F4 a third time.

a. This will create an absolute reference for only the column.
b. The row will change as you drag down, but the columns will stay anchored to the original column, C.

�. Drag cell G5 to the right and note that the column stays the same. 
7. Drag these three cells down, and you’ll notice that all the columns now match column C. 
�. Label the new grids “Row” and “Column” according to which part of the formula was absolutely referenced.
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Calculating Take-Home Pay
Let’s suppose that we ultimately want to know their take-home pay. To get to that, we are going to want to know their
benefits in dollars, and also we want to know their savings in dollars. Let’s start by calculating. Make sure you widen
your cells up a little bit so that you can see them.

1. Insert four new columns once more. We want to understand take-home pay after benefits, savings, tithing, and tax.
2. Label the columns Benefits, Savings, Tithing, and Tax.
3. Use the format painter to paint the format from the salary column into the new four columns.
4. Right-click to insert a fifth column between Tithing and Tax.

a. It will inherit the currency formatting you just painted in.
5. Name this new column Tax, and rename the fifth column from Tax to Take-Home.
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Benefits and Savings
1. In F5, reference C5 with the anchor on the column. (=$C5).
2. Use the asterisk symbol (*) to multiply $C5 by D5. (See Figure 4.7)

a. It is not necessary to anchor D5 because as it is dragged down, the benefits percentage will change. As
dragged over, it will also bring in the savings percentages and calculate them automatically into dollars.

 Figure 4.7

 
3. Push Enter. The dollar amount for 25% of $45,000 will automatically be calculated.
4. Drag it across to the savings column. Note that the formula references the next column over for the percent, but it

remains anchored to the salary column.
5. Take those two formulas, and drag them all the way down. Note that whichever cell you select, it now references

the appropriate salary and benefits or savings. (See Figure 4.8)

Figure 4.8
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Tithing and Tax
1. To calculate tithing, start by referencing the salary, anchoring only the column. (=$C5)
2. Multiply that by the cell that represents the percentage of tithing, C1. Anchor both the row and column of C1 by

pressing F4.
a. This ensures that the tithing percentage will not move when dragged.

3. Press Enter and drag the column down for the rest of the information.
4. To calculate tax, create the same formula, but instead of multiplying by C1 and anchoring it, multiply it by C2 and

anchor both the row and column. 
5. Press Enter and drag the column down for the rest of the information. (See Figure 4.9)

Figure 4.9

 

Take-Home Pay
To calculate the take-home pay or the money left from the salary after deductions from benefits, savings, tithing, and
tax have been factored in, we will need to subtract those things from the salary.

1. In the Take Home column, start by referencing C5. 
a. Leave it as an unanchored, relative reference, as the reference salary will change as it is pulled down.

2. Subtract the sum of the calculated benefits, savings, tithing, and tax, and close the parenthesis. (See Figure 4.10)
3. Press Enter and drag down to calculate the take-home pay for the rest of the employees.
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Figure 4.10

Anchoring takes a lot of practice and you’re encouraged to do so whenever possible, as anchoring will be critical in any
career using Excel. It is vital when creating workbooks or worksheets that are fast and intuitive for you and the user. It
may be challenging at first, but as you practice, anchoring will become second nature!

Supplemental Resource

When completed, your practice worksheet should look like the following:

Figure 4.11
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/absolute_and_relativ.
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Navigation Shortcuts

In this chapter, we’re going to take a look at a few navigation shortcuts.

Practice Spreadsheet

Use this workbook for the chapter.

Navigating Through Large Amounts of Data
We have a list of parts that a company is buying with the price, the lead time, which is how long it takes for an order to
arrive, how many were ordered for each part, and then a classification for each part. The thing about this list is that it is
really large. There are 2,000 parts in this list. With a large list of parts like this, navigation of the spreadsheet can get
pretty awkward.

For instance, let’s say we want to calculate the average price of all of our parts. 

1. Move to an open cell and type in =average. 
2. Attempt to select the list of parts.

a. Notice that even scrolling down as fast as you can, it can get pretty annoying to have to wait for it to go all the
way down to 2,000, not to mention once you reach it, you’ll have to scroll back to the top again.

3. Hit the Escape key to navigate out of the formula.

So, here is a quick way to navigate using the keyboard. 

1. Select cell A1 and push Control and End on your keyboard, it will take you to the end of your data set.
a. For Mac, +Arrow key
b. There are still cells below and cells to the right, but it will recognize where the data ends and go to that cell at

the very bottom right of your data set.
2. To go the other direction, anywhere you’re located in the spreadsheet, you can press Control and then Home on my

keyboard. (Fn+Control+Left Arrow for Mac)
a. This will take you all the way up to cell A1. 

That’s a quick way to get down to the bottom of a data set or back up to the top.

The other thing that I can do is automatically go to the bottom of the list and select everything.
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1. Go to a specific column, any column, and select the first cell in it.
2. Push Control and Shift and hold those two keys in together, and then push the Down Arrow key.

a. Control+Shift+Up will go back up to the top.
3. To grab more than one column after one has already been selected, rather than going back up to the top and

starting over, push Shift and then Right Arrow, and it will select the next column over. 
a. If you push it again, it’ll do the next column and the next column, so on and so forth.
b. If you push Shift+Left Arrow, it’ll go back and select one less column.

4. Push Shift+Up Arrow, notice at the bottom it will select one less row. And if I push Shift+Down Arrow, it’ll go back
down one row at a time. 

So, how can you use this for doing formulas? Let’s suppose that you want to find the average of the price, this time
using the shortcut keys.

1. In an empty cell, type =average(.
2. Select the top cell in the price column, and then hit Control+Shift+Down, 
3. Push Enter, and it’s already done.

So, rather than waiting for it to go all the way down 2,000 rows, we can simply use those shortcut keys.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/navigation_shortcuts.
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Managing Cells

This chapter covers how to manage cells, rows, and columns. 

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Navigation Shortcuts chapter.

Deleting Data in Cells
To delete data in a cell, use the following steps:

1. Select the cell you want to empty.
2. Press the Backspace key.

a. Any content in that cell will be cleared out.

Deleting Cells
Sometimes, you need to delete cells themselves, and not just the contents in them. Selecting a cell and pressing the
Delete key or Backspace key will delete the content in cells, but the cells themselves remain. To delete cells, use the
following steps:
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1. Select the cells you want to delete.
2. Right-click on the selected cells, and select Delete. (See Figure 10.1)

a. The selected cells will be deleted, and a dialog box will appear, asking what to do with the information that was
contained in those cells.

 Figure 10.1

 
3. Select Shift cells left in the dialog box.
4. Select OK. (See Figure 10.2)

a. Excel will move the information in the cells that were to the right of the deleted cells over to the left.

Other options in this dialogue box include Shift Cells Up, which will shift the other cells in the column up; Entire Row,
which will delete the entire row the selected cells are found in; and Entire Column, which will delete the entire column
the selected cells are found in. Be careful when deleting cells of data, because it can make your data mismatched, and
it will leave an empty space at the end of the data. 
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Figure 10.2

 

Deleting Rows and Columns Quickly
There is a quicker way to delete entire rows and columns without having to bring up the dialog box. To delete an entire
column more quickly, use the following steps:
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1. Right-click the letter of the column that you want to delete.
a. This will select the entire column automatically.

2. Select Delete. (See Figure 10.3) 
a. The entire selected column will be deleted.

 Figure 10.3

 

To delete an entire row more quickly, use the following steps:
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1. Right-click the row number that you want to delete.
2. Excel will automatically select the entire row.
3. Select Delete. (See Figure 10.4)

a. The entire row will be deleted.

Figure 10.4

 

Inserting New Cells, Rows, and Columns
You can also insert new cells as well as delete them. To insert a new cell into a worksheet, use the following steps:
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1. Right-click a cell.
2. Select Insert. (See Figure 10.5)

a. A dialog box will appear.

 Figure 10.5

 
3. Select Shift Cells Down. (See Figure 10.6)
4. Select OK.

a. Excel will insert a cell above the cell you right-clicked on and shift the rest of the cells down.

 Figure 10.6

 
To insert an entirely new column, use the following steps:
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1. Right-click a cell.
2. Select Insert. (See Figure 10.5)

a. A dialog box will appear.
3. Select Entire Column. (See Figure 10.7)
4. Select OK.

a. Excel will insert a new column to the left of the cell you right-clicked.

Caption

 

To make a new column more quickly, use the following steps:

1. Select a column, and right-click it. 
2. Select Insert. (See Figure 10.8)

a. Excel will make a new column to the right of the one you right-clicked.

Figure 10.8

 

To add a new row, use the following steps:
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1. Select a row, and right-click it. 
2. Select Insert. (See Figure 10.9)

a. Excel will create a new row above the row you right-clicked.

Figure 10.9

 

Changing the Width of a Column
If a column is too small or too big, you can change the width of the column to fit your needs. To change the width of a
column, use the following steps:
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1. Select a column, and right-click it.
2. Select Column Width. (See Figure 10.10)

a. A dialog box will appear.

Figure 10.10

 
3. Type the desired width.

a. For practice, type 20. (See Figure 10.11)
4. Select OK.

a. Excel will change the width of the column.
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Figure 10.11

 
Another way to change the width of a column is to hover your cursor over the line that divides the column at the top, and
then click and drag the column divider left or right to make it bigger or smaller. A dotted line will appear as a guide that
can help show the new width of the cell before you release it. A box will pop up, showing the new measurement of the
width as you move it to the left or right. (See Figure 10.12)
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Figure 10.12

 

In general, it is best to make the columns wide enough so you can see everything in the column. A quick way to fix the
width of a column to the correct size without having to guess how wide it should be is to double-click the letter at the
top of the column. Excel will auto-fit the column so that it can show all of the information within the cells in that column.
Excel will check every cell in the column. Even if you have a long bit of information off the view of that page, when you
auto-fit that column, it will take that into account. You can do the same thing with rows, by dragging to change its height
or right-clicking and choosing Row Height. (See Figure 10.13)
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Figure 10.13

 

Making Comments and Notes
Next, we’ll look at commenting in a cell. A comment is something that can help a user to better understand what a cell
means, or it can help you to remember what you’ve done in that cell. To add a comment to the price column, use the
following steps:

Figure 10.14
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1. Select the Price cell.
2. Select the Review tab on the toolbar. 
3. Select New Comment or New Note. (See Figure 10.14)

a. Comments allow you to notify people and work collaboratively.
b. Notes are just built-in boxes that appear while the user is hovering over something.

4. Type your message in the comment box or note box. 
a. For this exercise, type Negotiated on day 1.

i. This will let people know that that is the assumption that is being made in the price.

Every time you hover over a box that has a note attached to it, you will be able to see the note. (See Figure 10.15) 

Figure 10.15

 
You can also mention another user of the document using comments. To do this to the cell that contains Order Qty, use
the following steps:
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1. Select the cell that contains Order Qty.
2. Select the Review tab on the toolbar. 
3. Select New Comment. (See Figure 10.14)
4. Type the @ symbol and the name of who you want to mention in the comment. (See Figure 10.16)
5. Type a message.

a. For this practice, type When were these updated?

 Figure 10.16

 

When the comment is saved, the person who was mentioned in the comment will get a notification in their account
inbox. As people reply to the comments, a chain of messages will appear with the original comment when the user
hovers over the cell.

Deleting Comments and Notes
To delete a comment or note, use the following steps:

1. Select the cell that has the comment or note you wish to delete.
2. Select Delete on the toolbar. (See Figure 10.17)

Figure 10.17

Editing Comments and Notes
To edit a comment or note, use the following steps:
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1. Right-click the comment or note.
2. Select Edit Note. (See Figure 10.18)

a. For comments, the options bar will say Edit Comment.

Figure 10.18

 
3. Type any edits into the box.

You can also use this options bar to reply to a comment or delete a comment. If you are the comment author, there will
also be an Edit button on the comment when you hover over the cell with the comment. (See Figure 10.19)

Figure 10.19
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Showing All Comments
Sometimes when someone shares a new workbook with you, you might want to see all of the comments or notes that
have been put onto the workbook. To see all the comments on the worksheet, use the following steps:

Figure 10.20

1. Select the Review tab on the toolbar.
2. Select the Show Comments button. (See Figure 10.20)

a. All comments that have been made on the worksheet will appear on the right in a dialog box. (See Figure
10.21)

 Figure 10.21

 

To see all of the notes on a worksheet, use the following steps:

1. Select the Review tab from the toolbar. 
2. Select the Notes option,

a. An options bar will appear.
3. Select Show All Notes. (See Figure 10.22)

a. All notes will pop up over the cells they correspond to on the worksheet. 
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Figure 10.22

These are two different options to share information within a given worksheet to help either yourself or someone using
it understand what’s going on.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/managing_cells.

Figure 10.23
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Sorting and Filtering

In this chapter, we're going to learn how to do sorting and filtering.

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Navigation Shortcuts chapter.

Sorting
Let's start with sorting. In our spreadsheet, we have a list with a header at the top. It always helps to have a header of
labels at the top for sorting. To sort, do the following. 

Figure 12.1

 
1. Select all of the data in the list that we want to sort.

a. Select the upper left-hand cell in the list.
b. Control+Shift+Right, Control+Shift+Down to get the whole thing selected.  

2. On the right side of the Home tab, you will find the Sort & Filter option. (See Figure 12.1)
a. If we select Sort A–Z, it will sort everything in ascending order by the first column selected. Z–A will go in

descending order. 
b. If we know that we want to sort by the first column, then we can go ahead and use one of those two. But if we

want to sort by another column, or by multiple columns, we select Custom Sort.  
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Custom Sorting
Let's suppose we want to do a little bit different sort. Once you have selected custom sort, you can select multiple levels
of sorting. The box that opens starts with a single row, telling you that it will sort by the first column based on the order
Z to A. (See Figure 12.2)

Figure 12.2

 
To add a level, choose to sort next based on any of the other columns that we have. 

In this example, we’ll do the following. 

1. Change first to sort by our class, and sort it A to Z on our next level. 
2. On the next level, sort by price, this time from the largest to the smallest price.

a. You’ll notice it recognizes that this column contains numbers because it switched the verbs in the order
column. 

3. Select OK. 
a. You'll notice it now sorted the list based first on the class, next on the price.
b. As you scroll down and get past the A section, you’ll begin to see the B section and eventually the C section,

with all of those sorted with their prices from highest to lowest within that subset.

One other thing to note here is that when you do a custom sort, there is a check box here at the top of the box that
appears that says My Data Has Headers. (See Figure 12.3)
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 Figure 12.3

 

When this is selected, it means that there is a header row at the top, and it will automatically deselect that row. It also
allows it to know what options should exist in the drop-down lists. If you deselect this, now it will include the top row in
the sorting and it only does it by column. So, generally, it makes sense to have a header row, and then to checkmark that
your data has a header row in it.

Data Filters
The second thing you will learn about is data filters. In order to turn on a filter, go onto the Home tab again. Off to the
upper right-hand corner under Sort and Filter, select Filter. (See Figure 12.4)

Figure 12.4

 
When you do this, it will recognize all of the data on the sheet and put a filter in place at the top. A filter is a series of
drop-down lists that allows us to manage a table using those drop-down arrows. (See Figures 12.5 and 12.6)
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Figure 12.5

 

Figure 12.6

 
Instead of sorting, if you want, you can also filter out certain entries. By default, everything is selected. If you open up
the drop-down arrow again, for example, in the Class column, when you uncheck the Select All box, nothing will be
selected. Then, you can scroll down and select the items that you want to be sorted. (See Figure 12.7) 
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Figure 12.7

 

When you select OK, notice that it filters out everything in the list, except for the items that you had check marked. When
something is filtered, a filter icon will replace the arrow icon that had previously been displayed. Only the items selected
are shown in the list. Now, it's important to note that they're not gone. They're just hidden. You'll notice with the row that
the numbers jump because the information that wasn’t selected is hidden. 

In addition to the filter in the Class column, you could also add a filter to the Lead Time. This time, instead of checking
things off the list, you can choose Number Filters, which provides many more different automatic filters. For example,
you can select a Less Than filter, and show only items Less Than 10. (See Figure 12.8)
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Figure 12.8

 
Why is this useful? Suppose you wanted to look at only the A items. With a filter, rather than having to scroll through
thousands of items, you now can scroll through a much smaller and more specific list. Taking it a step further, if you
added one more number filter to the Price column, you can select everything that’s less than ten dollars. Now, you only
have 32 items that you can see very quickly and go through line by line if needed.

Removing Filters
To remove all these filters, you can individually go through and choose clear filter. Or, you can also go back to the Sort
and Filter button in the top right, and choose Clear. This resets everything to the way it was prior to the filter being
applied.

In addition, you can use the Control+Shift+L shortcut to add or clear filters, but to make sure all your data is included, it
is recommended that you select all of the data before entering the shortcut.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/sorting_and_filterin.

Figure 12.9
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Hiding and Grouping

In this chapter, we are going to take a brief look at hiding and grouping rows and columns. 

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Navigation Shortcuts chapter.

Hiding and Unhiding Rows
There may be times where you want to hide calculations occurring in different cells from users. You can hide rows
individually or hide multiple rows. To hide rows, use the following steps:

1. Select the row or rows that you would like to hide.
2. Right-click the selected rows.

a. An options bar will appear.
3. Select Hide. (See Figure 13.1)

a. Excel will hide the selected rows from view.
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Figure 13.1

 
These rows are still there; they’re just hidden from view. You will see that the rows go up to 7 and then skip to 13 in the
next row. (See Figure 13.2)

Figure 13.2
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To unhide a row, use the following steps:

1. Select the row above the hidden cells and the row below the hidden cells.
2. Right-click on these selected rows.

a. An options bar will appear.
3. Select Unhide. (See Figure 13.3)

a. Excel will unhide the hidden rows.

Figure 13.3

 

Hiding and Unhiding Columns
You can hide and unhide columns. To hide columns, use the following steps:

1. Select the column or columns you want to hide.
i. These are columns C and D

a. For this practice, select the columns that contain the Price and Lead Time (wks) information.
2. Right-click on the selected columns.

a. An options bar will appear.
3. Select Hide. (See Figure 13.4)

a. Excel will hide the selected columns from view.
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Figure 13.4

 
In this case, both columns C and D will be hidden, and the column will skip from B to E. (See Figure 13.5)

Figure 13.5

 

To unhide these columns, use the following steps:

1. Select the column before the hidden cells and the column after the hidden cells.
2. Right-click on the selected columns. 

a. An options bar will appear.
3. Select Unhide. (See Figure 13.6)

a. Excel will unhide the hidden columns.
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Figure 13.6

 

Grouping and Ungrouping Columns

Figure 13.7

Grouping works the same way, but it’s even more convenient in some ways. To group columns, use the following steps:

1. Select the columns that you want to group.
2. Select the Data tab on the toolbar. 
3. Select Group. (See Figure 13.7)

a. A grouping bar will appear above the grouped columns. (See Figure 13.8)
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Figure 13.8

 
This grouping bar has a collapsible button. When you select that button, those columns are collapsed into one group.
The button will be replaced with an expand button, which will allow the user to see those columns visibly again once
selected. (See Figure 13.9)

Figure 13.9

 
This allows you to expand or collapse quickly without having to right-click and choose Hide or Unhide.

To unhide a group, use the following steps:

1. Select the grouped columns.
2. Select the Data tab. (See Figure 13.7)
3. Select Ungroup. (See Figure 13.10)

a. The columns will be ungrouped, and the grouping bar will disappear.
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Figure 13.10

Grouping in Multiple Layers
To create two levels of grouping, use the following steps:

1. Group columns C and D like you did before.
2. Select columns B through F.
3. Select the Data tab. 
4. Select Group. (See Figure 13.7)

a. Two grouping bars will appear, one longer than the other. (See Figure 13.11)

The numbers to the left of the grouping bars refer to the level of grouping. (See Figure 13.11)

Figure 13.11

 

If the number 1 is selected, it collapses everything. If the number 2 is selected, the first level expands (columns B, E, and
F). If the number 3 is selected, all of the levels will be expanded. To get rid of the grouping, use the following steps:

1. Select all the grouped columns.
2. Select the Data tab. (See Figure 13.7)
3. Select Ungroup. (See Figure 13.10)

a. The selected columns will be ungrouped, and the grouping bars will disappear, 

Grouping and Ungrouping Rows
Grouping and ungrouping rows works the same way. To group rows, use the following steps:
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1. Select the rows you want to group.
2. Select the Data tab. 
3. Select Group. (See Figure 13.7)

a. The selected rows will be grouped, and a grouping bar will appear to the left. (See Figure 13.12)

Figure 13.12

 
To group rows in multiple layers, use the following steps:

1. Select five or six rows, including the already grouped rows. 
2. Select the Data tab. 
3. Select Group. (See Figure 13.7)

a. Excel will group these rows, and a second grouping bar will appear. (See Figure 13.13)

Just like with columns, you can expand and collapse these individually or as a full group using the numbers at the top.
(See Figure 13.13)
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Figure 13.13

 

With hiding, you right-click and select Hide and Unhide like the exercises before. Grouping can accomplish the same
thing, but it gives you the options to quickly expand or collapse those groupings.

When completed, your practice worksheet should look like the following:

99

https://books.byui.edu/bus_115_business_app/


 

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/hiding_and_grouping.

Figure 13.14
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Paste Special

In this chapter, we’re going to take a look at some of the Paste Special features in Excel. Let’s say we’ve got a table of
data and we want to copy the table to another location. We’ll copy the table using the Copy button in the top-left of the
menu, or by pressing CTRL + C on the keyboard as shown in Figure 11.1. Next, we select the new location and select
Paste on the menu or press CTRL + V. It will paste everything that was in the table, including the formatting, all of the
numbers, as well as the formulas.

Figure 11.1

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Navigation Shortcuts chapter.
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However, let’s suppose that we don’t want to copy all of the formatting and the formulas. Instead, we can press the
arrow under the Paste button and select Paste Special or press CTRL + ALT + V. It will open a Paste Special dialogue
box with several options. (See Figure 11.2)

Figure 11.2

 
Additionally, we can paste the table and select the clipboard button on the bottom-right corner of the pasted data for
quick paste options. (See Figure 11.3)
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Figure 11.3

 

Paste All
The All selection will paste the copied data with all formulas, values, and other formatting intact.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select All and press OK to paste the data. (See Figure 11.4)
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Figure 11.4

 

Paste Formulas
The Formulas selection will paste the copied data with all formulas intact, but values and other formatting will not be
kept.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select Formulas and press OK to paste the data. (See Figure 11.5)

Figure 11.5
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Paste Values
The Values selection will paste the copied data with all values intact, but formulas and other formatting will not be kept.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select Values and press OK to paste the data. (See Figure 11.6)

Figure 11.6

 

Paste Formats
The Formats selection will paste the copied data with all formatting intact, but formulas and values will not be kept.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select Formats and press OK to paste the data. (See Figure 11.7)
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Figure 11.7

 

Paste Values and Number Formats
The Values and number formats selection will paste the copied data with all values and number formatting intact, but
formulas will not be kept.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select Values and number formats and press OK to paste the data. (See Figure 11.8)

Figure 11.8
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Paste Column Widths
The Column widths selection will paste the copied data with all column widths intact.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select Column widths and press OK to paste the data. (See Figure 11.9)

Figure 11.9

 

Paste Transpose
The Transpose selection will swap table data on the y and x-axis planes. Data displayed across the first row will be
pasted vertically in the first column and so on.

1. Copy the desired data and select a location to paste.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select the Transpose box and press OK to paste the data.

a. Alternatively, paste the data and select the clipboard button in the bottom-right corner of the pasted content.
Then select the Transpose button to adjust the data accordingly. (See Figure 11.10)
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Figure 11.10

 

Paste Picture or Linked Picture
The Paste Picture button will adjust the pasted data as an image. The contents of the image won’t reflect changes to
the table. However, the Paste Linked Picture button will paste an image that will reflect changes to the table.
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1. Copy the desired data and select a location to paste.
2. Paste the data and press the clipboard button in the bottom-right corner of the pasted content.
3. Select the Paste Picture or Paste Linked Picture button and press OK. (See Figure 11.11)

 Figure 11.11

 

Paste Operations
The Operations section of the Paste Special window can apply (paste) copied numerical data to selected cells. The
method provides a quick way to add, subtract, multiply, or divide multiple cells with the copied numerical data.
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Figure 11.12

1. Copy the desired data and select the relevant cells with existing numerical data.
2. Press the arrow under the Paste button in the top-right of the ribbon menu and select Paste Special.
3. Select the operation to apply to the selected cells and press OK.

a. For example, in Figure 11.12, the copied cell containing 2 in the Lead Time column can be added to the
selected cells in the Order Qty column, thereby increasing each of their values by 2.

F4 Repeat
The F4 key on the keyboard has special functions in Excel. It can lock reference cells in a formula, and it can repeat the
last formatting function applied in the spreadsheet. For example, if we apply a background color to one cell, we can
repeat the action by selecting another cell and pressing F4. It also works for adding rows or columns and other
repeatable functions.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/paste_special.

Figure 11.13
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Named Ranges

In this chapter, we will be looking at naming cells and ranges in Excel. Naming cells and ranges can be very helpful
because those cells or ranges can be referred to without reference to their actual cell address. 

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Ranking chapter.

Taking Average Without Names
Shown in Figure 8.1 is a list of employees and their information, including their ages, their college GPA, and their
salaries. Their ages are shown in Column D. To calculate the average of their ages, which are not named, use the
following steps:
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Figure 8.1

 

1. Select an empty cell, and type =AVERAGE( into the cell. (See Figure 8.2)
a. Excel will recognize this as a formula.

2. Select all of the cells under Age. (See Figure 8.2)
a. Excel will automatically fill in the cell range in the formula.

3. Press Enter.
a. Excel will calculate the average age of the employees.
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Figure 8.2

 

Naming a Cell
Notice when we did that, the average formula had to specify the range of cells needed to calculate the average. See
Figure 8.2. Instead of doing this, we can name a cell or range. For example, look at Alice’s age in Figure 8.1. To name
this cell, use the following steps:
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1. Select the cell you want to name.
a. In the top left of the formula bar, the cell’s name comes up as D3. (See Figure 8.3)

2. Select the name, and type alice_age. (See Figure 8.3)

Figure 8.3

 
3. Press Enter to save the name.

You can’t use spaces or special characters in a named range. It’s a good idea to use an underscore in place of a space
when you name a cell or range. 

Referencing a Named Cell
Now, when you select a new cell, you can reference this named cell by typing the name rather than selecting the cell
manually. To do this, use the following steps:
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1. Select a new cell, and type the equals sign =.
a. Excel will automatically recognize this as a formula.

2. Start to type alice_age.
a. Excel will bring up a list of suggestions, including the name of this cell. (See Figure 8.4)

Figure 8.4

 
3. Press Tab to allow Excel to autofill alice_age into this cell. 
4. Press Enter.

a. Excel will input the data found in the cell named alice_age, which in this case is 49. 

If you want to use the data in the named cell in a calculation, use the following steps:

1. Select a cell, and type the equals sign =.
2. Select the cell named alice_age. 

a. Excel will automatically recognize that cell as “alice_age.” (See Figure 8.5)
3. Type *5. 
4. Press Enter. 

a. Excel will calculate 49 times 5.

 Figure 8.5
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This can be helpful because the name of the cell allows you to refer to a cell without even knowing exactly where it is.

Naming a Range
You can also name an entire array of cells, or in other words, an entire range. To practice naming a range, use the
following steps:

1. Select all of the data under Age. (See Figure 8.6)
2. Select name in the top left of the formula bar. (See Figure 8.6)
3. Type age. (See Figure 8.6)
4. Press Enter to save the name.

Figure 8.6

Use the same process for the data in the other categories. The data under College GPA should be named gpa, the data
under Salary should be named salary, the data under Employee should be named names, and the data under Position
should be named job.

Calculating Average of a Named Range
Once a range of numbers has been named, it can be referenced by name rather than having to select the entire set of
data every time. To do this to the set of data under Age, use the following steps:
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1. Select a new cell, and type =AVERAGE(.
a. Excel will recognize this as a formula.

2. Instead of selecting all of the data under Age, simply type age. (See Figure 8.7) 
3. Make sure to close the parentheses. (See Figure 8.7)
4. Press Enter. 

a. Excel will calculate the average age of the employees.

Figure 8.7

 

Referencing Named Ranges Across Worksheets
Naming cells and ranges allow you to do formulas much more quickly. It is especially helpful with calculations that exist
on other worksheets. To do this, use the following steps:
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1. Add a new worksheet.
2. Select a cell, and type =AVERAGE(gpa). (See Figure 8.8)

Figure 8.8

 
a. Excel will recognize the name of the range.
b. Make sure to close the parentheses. 

3. Press Enter.
a. Excel will calculate the average GPA of the employees.

When you have a named range, you no longer have to flip back to a different worksheet to reference that range; all you
need to do is type the name into the formula.

This will also work for totals. To calculate the total of the employees’ salaries across worksheets, use the following
steps:

1. Select an empty cell in the new worksheet.
2. Type =SUM(salary). (See Figure 8.9)

 Figure 8.9

 
a. Excel will recognize the name of the range.
b. Make sure to close the parentheses.

3. Press Enter. 
a. Excel will calculate the total of the employees’ salaries.

Once you’ve created these named ranges, you can always see which ones they are by selecting the drop-down list in the
top left of the formula bar, the same place that allows you to name the range. (See Figure 8.10)

If you select any of the names on this list, it will take you to the location in the workbook of that named range. 
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Figure 8.10

 

Renaming Named Ranges
Let’s say that we wanted to rename alice_age so that it was simply named alice. This can be done using the same steps
as when we first renamed the cell. But once the cell is renamed again, both versions of the name show up in the drop-
down list. See Figure 8.11. Even though the cell is renamed, the use of either of the names in a formula will still work.
There are now two named ranges that refer to that same cell.

Figure 8.11
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Removing Range Names
If you don’t want duplicate names, you can remove or delete a name that you no longer need. To remove alice_age, use
the following steps:

Figure 8.12

1. Select the Formulas tab on the toolbar. (See Figure 8.12)
2. Select Name Manager. (See Figure 8.12)

a. This will bring up a dialogue box that gives you the details of every named range that exists in the sheet. (See
Figure 8.13) 

b. Selecting a name will bring up its value if it has one, which cell it refers to, and its scope.
3. Select alice_age. (See Figure 8.13)

Figure 8.13

 
4. Select Delete. (See Figure 8.14)
5. When the pop-up message appears, select OK. (See Figure 8.14)

a. When you select Done, any cells that had a formula that used the deleted name will now have errors in them,
because Excel no longer recognizes that name.
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Figure 8.14

 
When you make edits or remove names of ranges, make sure you are aware of what formulas might be impacted. 

Changing Ranges
Sometimes if you add more data after naming a range, you will want to add this data to the named range. Let’s say that
we added a new employee to the data. To add another cell to the range named age, use the following steps:
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1. Select the Formulas tab on the toolbar. (See Figure 8.12)
2. Select Name Manager. (See Figure 8.12)

a. This will bring up a dialogue box that gives you the details of every named range that exists in the sheet. (See
Figure 8.13)

3. Select age. 
a. Information about what this named range refers to will show up. (See Figure 8.15)

Figure 8.15

 
4. In the box under Refers to:, change 17 to 18. (See Figure 8.16)
5. Select the green checkmark. (See Figure 8.16)

a. The range will be updated.
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Figure 8.16

 
This dialogue box allows you to make all those types of edits in one place across all named ranges in your workbook.

Named ranges can be very useful, especially when your spreadsheets are large and have lots of information with lots of
different sheets, making it difficult to remember where the cells you want to reference are located. It can also make
creating formulas a lot easier, simplifying the problem-solving process by seeing exactly what you’re referring to in the
formula using a named range, instead of having to reference every unique cell or range in each formula. 

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/named_ranges.

Figure 8.17
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Ranking

In this practice, you will learn how to organize data in an Excel spreadsheet by rank.

Practice Spreadsheet

Use this workbook for the chapter.

Maximum and Minimum
Looking at the table, notice the different columns: employee, position, age, college GPA, and salary. Let's suppose that
we wanted to find the oldest age in this list of employees.

We could scan the list with our eyes and find the answer that way, but suppose the list was much longer, perhaps
thousands of rows. You wouldn’t be able to do that. However, there is a way to have Excel calculate the answer for us.

Figure 7.1

In this practice, we will explore how to find the maximum age, the minimum, the third-largest, and the fourth smallest.
Type these into 4 cells in the same column, then copy and paste the headers for Age, College GPA, and Salary in the
next three columns. (See Figure 7.1)

Let’s begin with the maximum age. Complete the following steps. 
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1. Type =MAX into the cell, followed by an open parentheses.
2. Select all the values in the Age column, then close the parentheses and push Enter.

This will automatically calculate the maximum age from the selected range. Your formula should look similar to the one
in Figure 7.2.

Figure 7.2

 
To calculate the minimum age, do the following in the cell beside the one labeled Min.

1. Type =MIN into the cell, followed by an open parentheses. 
2. Select all the values in the same range as before, then close the parentheses and push Enter. 

This will automatically calculate the minimum age from the selected range.

Large and Small Functions
To find the third-largest, there is a formula called “large” that allows you to find within a given array, what largest number
you would find. This is represented in the formula as k. This variable tells Excel which number “largest” you’d like to
identify. For example, in the circumstance of third largest, k would equal three. (See Figure 7.3)
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Figure 7.3

 

To calculate the third-largest, do the following in the cell beside the one labeled Min.

1. Type =LARGE into the cell, followed by an open parentheses. 
2. Select all the values in the same range as before, replace the spot for k with 3, then close the parentheses and push

Enter.

This principle is also applicable to finding, for example, the fourth smallest. This formula is called “small.” 

1. Type =SMALL into the cell, followed by an open parentheses. 
2. Select all the values in the same range as before, replace the spot for k with 4, then close the parentheses and push

Enter. (See Figure 7.4)

Figure 7.4

 

Matching the Format
Now, because we didn't anchor the references for these functions, we can drag them across to calculate the maximum
and the minimum for GPA and salary as well. Since we want the number formats to match, use the format painter.
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1. Select one row of the original age, GPA, and salary.
2. Select the format painter on the upper left-hand side. (See Figure 7.5)

 Figure 7.5

 
3. Drag your mouse over the new age, GPA, and salary. (See Figure 7.6)

Figure 7.6

 
a. This will automatically adjust the format to match that of the original reference. (See Figure 7.7)
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Figure 7.7

 

Cell Referencing
One slight alteration we can do to our formulas to make them even more dynamic is that if we didn’t want to be “hard-
coding” or just typing in, for example, a three for “third largest” we can reference an additional cell.
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1. Copy the cells with the =LARGE and =SMALL functions, and paste them below. (See Figure 7.8)

Figure 7.8

 
2. Notice that the pasted cells are now referencing the wrong set of cells. 
3. Delete the incorrect information.
4. Off to the side, type a 3 beside the 3rd Largest cell, and a 4 beside the 4th Smallest cell.
5. Type =LARGE in the cell beside the 3rd Largest, choose your array, (which is just all of the ages,) and then reference

the 3 cell. (See Figure 7.9)
�. Hit F4 to anchor the formula so that as you drag and copy it over, it won't move.
7. Repeat with the =SMALL function.
�. Drag over to the right, hover over the icon in the corner, and choose Fill Without Formatting to maintain the number

formats it had previously.
a. Now, if instead of the third-largest we'd like to see, for example, the fifth-largest, we can change the 3 to a 5,

and the referenced information will change along with it.
b. Manually change the label to match, from third largest to fifth largest.
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Figure 7.9

 

Numbered List 
We can also create a numbered list to rank the items from smallest to largest. 
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1. You can manually type and drag a list of, for example, 1–8, or you can use the fill series option as learned in a
previous video.  

2. Then, type =LARGE, select the array, and then anchor it, or make it an absolute reference, by pressing F4. 
3. Then, for k, (which rank we want), we want the first largest, so you will select the number 1 from the list you

previously created. (See Figure 7.10)

Figure 7.10

 
4. You can then drag it down, and because you have attached it to the proper references, it should fill in with the

corresponding numbers.
5. Label the list with the word Large.

You’ll notice that if you attempt to drag over the ages for the GPA and salary, it will give you an error. This has to do with
the anchoring because rather than being referenced to the number 1, k is now referenced to 52. 

To anchor just the cell, you will need to anchor to just the row, rather than the column and the row. 

1. Change your formula so that only the row is being referenced. (See Figures 7.11 and 7.12)
a. This makes it so that it won’t move when you move cells down, but it will move columns to the right if dragged

over.
2. Use the format painter to keep the data looking consistent. 

You could do the same exercise with the small formula. 
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Figure 7.11

Figure 7.12

 

Rank Function
For our next example of ranking, let’s say that instead of creating a list off to the side, we want to add a column into our
data to give it a rank relative to the list and will rank every single item in the list.

1. Select columns G through L, right-click, and select Insert.
a. This will shift all the formulas to the right so you don’t lose them but have a space to work in.

2. Label columns for ranking each of the elements. 
a. The ampersand gives you the ability to combine terms.

i. Type =”Rank ”& 
b. Select D2, the cell labeled Age
c. Press Enter.
d. Drag this cell over, and the information should fill in until all the columns are labeled properly. 
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RANK.AVG
If there's more than one age in the list that are the same and you choose RANK.AVG, the rank assigned to both of them
will be the average of their rank.

1. Select the first cell under Rank Age, G3, and type =RANK.AVG.
2. Select the corresponding Age cell in the same row, D3, and type a comma after.
3. Select the entire Age array, and anchor just the rows.
4. Type a comma, and it will give you the option between descending or ascending. Choose descending (the largest

number gets the highest rank).
5. Note that when the formula is complete, it will rank the age with a dollar sign. Update the format by selecting

Number rather than Currency. Remove the decimals.
�. Drag this cell all the way down.
7. Drag that new array across. 

a. If your anchoring is set up correctly, each cell should correlate with the number in the same row in the
assigned column of that information.

b. If you expand the decimals, note that some ranks contain a .5 at the end. This is because the RANK.AVG
formula is being used. It is averaging the two places to give you together and giving them the average of the
two ranks.

i. For example, the average of place 10 and place 11 would be 10.5.

RANK.EQ
If you choose rank.eq, instead of averaging the two ranks that happen to be the same, it will take the highest of the two
and it will assign that rank to both of them.  

1. Copy the formulas from the rank titles by referencing them.
2. Add a note in the column above that says AVG for the averaged ranks, and EQ for the ones you are about to

complete.
a. Color code them using the fill colors.

3. Set up the rank formula again, but this time, choose RANK.EQ instead of RANK.AVG.
a. Don’t forget to anchor only the rows and not the columns.

4. Copy the cell over to the rest of the columns.
5. Copy these three cells down to the rest of the rows.
�. Change the formatting from Currency to Numbers.

a. Notice that there’s no .5 in the decimal places this time because the higher rank of the two that match is being
used.

b. For example, if two values at the 10 and 11 place were the same, they would both become 10.

 That’s how the RANK function works, along with the MIN, MAX, LARGE, and SMALL functions.

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/ranking.

Figure 7.13
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Rounding

In this chapter, we are going to take a look at various rounding functions in Excel.

Figure 9.1

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Ranking chapter.

Let’s look at the first cell in the GPA column. Alice has a GPA of 3.92. You’ll notice in the formula bar, the value of her
GPA is actually 3.919 (see Figure 9.2), but we only have two decimals showing in the cell itself—it rounds to 3.92.
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Figure 9.2

If we want to change the number of decimals that show in the cell, we can select the cell, make sure we’re on the Home
tab, and then change the number of decimal digits showing using the Increase Decimal and Decrease Decimal buttons.
This will increase or decrease the number of decimal digits displayed. (See Figure 9.3)

Figure 9.3

In each case when it removes a decimal, it will round what is showing according to the actual number in the cell. For
instance, if we reduce the number of decimals to the nearest whole number, 3.919 rounds to four. The important thing
to note is that regardless of how many decimals are showing in the cell, the actual number in the cell is whatever it is—
3.919 in this case—which may be different from what actually shows in the cell. This is important because if you use
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any functions or formulas that refer to this cell, what actually is used to calculate is the number that is embedded in the
cell rather than what is shown in it. This method of rounding is different from using a rounding formula.

Round Function
We can also round the numbers with a formula. The Round function will round up or down to the nearest decimal place
specified in the formula.

1. Type =ROUND and an open (left) parenthesis ( ( ) in an empty cell.
2. Select the reference cell with the data to round (E3 in Figure 9.4).
3. Type a comma ( , ) followed by the number for the nearest digit to round to (2 in Figure 9.4).

a. This number is the digit after the decimal point. For example, 1 will round to the nearest tenth, 2 will round to
the nearest hundredth, and 3 will round to the nearest thousandth.

4. Type a close (right) parenthesis ( ) ) to close the formula.
5. Press Enter to complete the cell’s formula (=ROUND(E3,2)).

Figure 9.4

Round Down Function
The Round Down function will round down to the nearest decimal place specified in the formula.
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1. Type =ROUNDDOWN and an open (left) parenthesis ( ( ) in an empty cell.
2. Select the reference cell with the data to round (E3 in Figure 9.5).
3. Type a comma ( , ) followed by the number for the nearest digit to round down to (2 in Figure 9.5).

a. This number is the digit after the decimal point. For example, 1 will round down to the nearest tenth, 2 will
round down to the nearest hundredth, and 3 will round down to the nearest thousandth.

4. Type a close (right) parenthesis ( ) ) to close the formula.
5. Press Enter to complete the cell’s formula (=ROUNDDOWN(E3,2)).

Figure 9.5

Roundup function
The Roundup Function will round up to the nearest decimal place specified in the formula.

1. Type =ROUNDUP and an open (left) parenthesis ( ( ) in an empty cell.
2. Select the reference cell with the data to round (E3 in Figure 9.6).
3. Type a comma ( , ) followed by the number for the nearest digit to round up to (2 in Figure 9.6).

1. This number is the digit after the decimal point. For example, 1 will round up to the nearest tenth, 2 will round
up to the nearest hundredth, and 3 will round up to the nearest thousandth.

4. Type a close (right) parenthesis ( ) ) to close the formula.
5. Press Enter to complete the cell’s formula (=ROUNDUP(E9,2)).
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Figure 9.6

Ceiling Function
The Ceiling Function will round up to the nearest multiple of the number specified in the formula.

1. Type =CEILING.MATH and an open (left) parenthesis ( ( ) in an empty cell.
2. Select the reference cell with the data to round (D3 in Figure 9.7).
3. Type a comma ( , ) followed by the number for the nearest multiple to round up to (5 in Figure 9.7).

1. This number represents the number of significance that rounds up to the nearest integer. For example, 5 will
round up the reference number to the nearest multiple of 5.

4. Type a close (right) parenthesis ( ) ) to close the formula.
5. Press Enter to complete the cell’s formula (=CEILING.MATH(D3,5)).
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Figure 9.7

Floor Function
The Floor Function will round down to the nearest multiple of the number specified in the formula.

1. Type =FLOOR.MATH and an open (left) parenthesis ( ( ) in an empty cell.
2. Select the reference cell with the data to round (D3 in Figure 9.8).
3. Type a comma ( , ) followed by the number for the nearest multiple to round down to (5 in Figure 9.8).

1. This number represents the number of significance that rounds down to the nearest integers. For example, 5
will round down the reference number to the nearest multiple of 5.

4. Type a close (right) parenthesis ( ) ) to close the formula.
5. Press Enter to complete the cell’s formula (=FLOOR.MATH(D3,5)).

146



Figure 9.8

When completed, your practice worksheet should look like the following:

Figure 9.9

147

https://books.byui.edu/bus_115_business_app/


Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/rounding.
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Sum and Count

In this chapter, you will learn how to summarize data with the sum and count functions. We have a table of data of
some employees at a business. We have the name of the employee, their position, age, college GPA, and current salary.
(See Figure 6.1)

Figure 6.1

 

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Managing Worksheets chapter.
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Sum Function
Let’s look at the salary column. Let’s suppose that we want to calculate the sum total of all the employees’ salaries. We
can do this with the Sum function.

1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Type sum and an open (left) parentheses ( ( ).
3. Select all of the data to sum (F3 to F17 in Figure 6.2).
4. Type a close (right) parenthesis ( ) ) to close the formula data reference.
5. Press Enter to complete the cell’s formula (=sum(F3:F17)).

a. The total comes to $749,000.
b. If one of the salaries changes, then the sum total will automatically reflect that change. For example, if the F3

cell’s data changes from $36,000 to $38,000, the sum total will reflect the change: $751,000.

Figure 6.2

 

Count Function
Let’s suppose that we want to count the number of salaries in the list. We can do it with the Count function. The Count
function counts numerical data only; it will not recognize text.
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1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Type count and an open (left) parenthesis ( ( ).
3. Select all of the data to count (F3 to F17 in Figure 6.3).
4. Type a close (right) parenthesis ( ) ) to close the formula data reference.
5. Press Enter to complete the cell’s formula (=count(F3:F17)).

a. The total count of salaries in Figure 6.3 is 15.
b. If one or more of the counted data is deleted, the count will recognize that change. For example, if the salary

data for Carl in cell F5 is deleted, the total count will change from 15 to 14.

Figure 6.3

 

CountA Function
Another count function is the CountA Function. This function works the same as the Count function, except it is used to
count non-numerical data—textual data such as names or positions.
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1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Type counta and an open (left) parenthesis ( ( ).
3. Select all of the data to count (B3 to B17 in Figure 6.4).
4. Type a close (right) parenthesis ( ) ) to close the formula data reference.
5. Press Enter to complete the cell’s formula (=counta(B3:B17)).

a. The total count of employees is 15.
b. If another CountA is inserted for the Positions column, the total count of positions comes to 11. The difference

between the results reveals 4 employees do not have positions.

Figure 6.5

 

CountBlank Function
The CountBlank function can tell us the number of blank cells in a data set. In this case, we can verify the number of
employees without positions from the CountA function example.
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1. Select an empty cell and type an equals symbol ( = ) to start the formula.
2. Type countblank and an open (left) parenthesis ( ( ).
3. Select all of the data to count (C3 to C17 in Figure 6.5).
4. Type a close (right) parenthesis ( ) ) to close the formula data reference.
5. Press Enter to complete the cell’s formula (=countblank(C3:C17)).

a. The total count of blank cells is 4 in the Positions data set.

Figure 6.5

 

When completed, your practice worksheet should look like the following:
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/sum_and_count.

Figure 6.6
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Managing Worksheets

This chapter covers referencing and managing worksheets in Excel.

Practice Spreadsheet

Use this workbook for the chapter.

Workbook vs. Worksheet
There is a difference between workbooks and worksheets in Excel. When you open up a spreadsheet, save it, and give it
a name, you have created a workbook. A workbook can contain one or more worksheets, which can be found at the
bottom of the page (See Figure 5.1). The smallest reference point in a workbook is an individual cell. A page full of cells
is called a worksheet. A file full of worksheets is called a workbook.
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Figure 5.1

 

Adding Worksheets
To add more worksheets, select the plus sign in the bottom left of the screen (see Figure 5.2). A new worksheet will
open, and a new tab will appear at the bottom. You can use this step to make as many worksheets within the workbook
as you need.

Figure 5.2

 

Referencing Cells Across Worksheets
Cells in each worksheet can be referenced across worksheets. To do this, use the following steps:
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1. Select a cell, and type the equals symbol, =.
2. Select the desired worksheet.
3. Select the cell you want to input into the cell on the first worksheet. (See Figure 5.3)

Figure 5.3
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a. Excel will bring that value over to the second worksheet. (See Figure 5.4)
b. The formula bar will read Sheet1!B4.

i. If the worksheet you are referencing has a different name, the formula bar will have the name of the
worksheet, an exclamation point, and the cell number that the original value is found in.

 Figure 5.4

 

Selecting the cell and dragging down or to the right will bring over more information from the other worksheet (see
Figure 5.5 and Figure 5.6), just like you learned in the Absolute and Relative Referencing chapter. 
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Figure 5.5

 

Figure 5.6

 

Making an Absolute Reference
If you don’t want the rest of the data from the other worksheet to appear when you drag down or to the right, you need
to anchor the desired data by making it an absolute reference. 

To make an absolute reference, use the following steps:
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1. Select a cell, and type the equals symbol, =.
2. Select the desired worksheet.
3. Select the cell you want to input into the cell on the first worksheet. (See Figure 5.3)

a. Excel will bring that value over to the second worksheet. (See Figure 5.4)
b. The formula bar will read =Sheet1!B4.

i. If the worksheet you are referencing has a different name, the formula bar will have the name of the
worksheet, an exclamation point, and the cell number that the original value is found in.

4. Press F5, or input dollar signs into the formula bar before and after the column letter manually. (See Figure 5.7)
a. For example, =Sheet1!$B$4.
b. These dollar signs will make the value an absolute reference and will allow autofill, fill series, and other

functions to function normally.

 Figure 5.7

 

Renaming Worksheets
Use the following steps to rename a worksheet:

1. Select the tab for the worksheet you want to rename.
2. Double-click the tab. 

a. The text will be highlighted to allow you to type a new name.
3. Type the desired name.

a. For example, Data. 
4. Select any cell to allow the name to be saved onto the tab.

Any references to cells on the renamed worksheet will be updated with the new name. If there is a space in the name,
the reference to the cell will put the worksheet name in single quotes when it appears in the formula bar. For example, if
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the name of the worksheet is Data Sheet, the formula bar would read, ‘Data Sheet’!$B$4 when you reference cell B4 on
the Data Sheet worksheet. (See Figure 5.8)

Figure 5.8

 

Deleting Worksheets
To delete a worksheet, use the following steps:

1. Select the tab for the worksheet you want to delete.
2. Right-click the tab.
3. Select Delete. (See Figure 5.9)
4. When the warning message appears, select Delete.

 Figure 5.9
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Moving and Copying Worksheets
You can click and drag the worksheet tabs to move them into the orientation that you prefer. 

To make a copy of a worksheet, use the following steps:

1. Hold down the Control key (PC) or the Command key (Mac).
2. Click and drag the tab of the worksheet you want to copy to a new location.

Here is another way to move or copy a worksheet:

1. Right-click the tab of the worksheet you want to copy.
a. An options bar will appear.

2. Select Move or Copy. (See Figure 5.10)
a. A small window will appear, allowing you to select the worksheet you want to come after the worksheet you

are moving. It also allows you to move the worksheet to the end of the list of tabs. (See Figure 5.11)

Figure 5.10

 
3. If you want to make a copy of the worksheet, select the Create a Copy checkbox option. (See Figure 5.11) If you

just want to move the worksheet, leave this checkbox unchecked.
4. Select OK.
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Figure 5.11

 
You can also move worksheets to different workbooks. To do this, use the following steps:

1. Right-click the tab of the worksheet you want to copy.
a. An options bar will appear.

2. Select Move or Copy. (See Figure 5.10)
3. In the small window that appears, select the dropdown menu under To Book. 
4. Select the workbook you want to move the worksheet to. (See Figure 5.12)
5. Select OK.

Data on copied sheets will not have any references attached to them. It will be as if it is the original worksheet, but the
title of the copy will have (2) after the title to distinguish it from the original. 
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Figure 5.12

 

Deleting More than One Worksheet
If you need to delete more than one worksheet at a time, use the following steps:

1. Hold down the Control key (PC) or the Command key (Mac). 
a. This will allow you to select more than one tab at the same time.

2. Select the worksheets you want to delete.
3. Right-click the selected tabs.

a. An options bar will appear.
4. Select Delete from the options bar.
5. When the warning message appears, select the Delete button.

a. Both of the selected worksheets will be deleted.

Changing the Color of Worksheet Tabs
To further customize the tabs for your worksheets, you have the option to change the colors of the tabs. To do this, use
the following steps:

1. Right-click on the tab you want to customize.
a. An options bar will appear.

2. Select Tab Color.
3. Select the color you want to change the tab to. (See Figure 5.13)

You can also select More Colors, and it will give you a palette. If you select Custom, it allows you to choose a color from
a wider variety of options.

Customization like this allows you to denote different things. For example, you could have one color that denotes
different datasheets, and another color that denotes a dashboard or summary sheet. 
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Figure 5.13

 

Hiding and Unhiding Worksheets
Often, you will have worksheets that exist not to show user information, but to run calculations in the background or
store large amounts of data. Sometimes, it makes sense to hide these worksheets so they are not seen by the end-user,
or so that they don’t clutter the workbook while you’re trying to work through a different subset of data.

To hide a worksheet, use the following steps:
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1. Right-click on the worksheet you want to hide.
a. An options bar will appear. 

2. Select Hide. (See Figure 5.14)
a. The worksheet will no longer appear on the list of tabs across the bottom.

 Figure 5.14

 

Although it seems like hidden worksheets no longer exist, they are still there. To unhide a hidden worksheet, use the
following steps:
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1. Right-click one of the worksheet tabs.
a. An options bar will appear.

2. Select Unhide. (See Figure 5.15)
a. A list of hidden worksheets will appear.

 Figure 5.15

 
3. Select the worksheet you wish to unhide. (See Figure 5.16)
4. Select OK.

a. The worksheet will reappear on the list of worksheet tabs.
b. You can also double-click the worksheet you wish to unhide instead of selecting it and selecting OK.

 Figure 5.16

 

To hide more than one worksheet at the same time, use the following steps:
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1. Hold down the Control key (PC) or the Command key (Mac).
a. This will allow you to select more than one tab at the same time.

2. Select the worksheets that you want to hide.
3. Right-click the selected worksheet tabs.

a. An options bar will appear.
4. Select Hide. (See Figure 5.14)

This is a nice way to help clean up the presentation for an end-user.

 

Referencing Cells on Different Workbooks
You can reference cells not only across different worksheets within the same workbook but also across different
worksheets in a different workbook.

To reference cells from a different workbook, use the following steps:

1. For PC, hold the Control key, and press N. For Mac, hold the Command key, and press O. Make sure you are in an
open workbook when you do this, or these commands will do something different on your computer.

a. This will open a new workbook.
2. Type in some data. 

a. For practice, simply type Data in an empty cell.
3. Return to the original workbook, and select an empty cell.
4. Type an equal sign (=) into the cell.

a. Excel will recognize this as a formula.
5. Go back to the new workbook.
�. Select the data you want to reference.

a. For practice, select the cell that contains the word Data.
b. The formula bar will put the workbook title in square brackets, the name of the worksheet with an exclamation

point, and the cell reference. (See Figure 5.17)

Figure 5.17

 
By default, Excel makes any reference in a different workbook an absolute reference by putting dollar signs in the
reference to the cell. You can remove those dollar signs using F4, or by backspacing manually. 

The challenge of referencing cells in different workbooks is if you were to share or submit a file that references a
different file on your computer, the user will not be able to see what was saved on your computer. They will only be able
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to see what is in the workbook that was sent to them. When you do these references, please be careful about what it is
that you’re sharing or sending along. If you were to send just one workbook, the link would be broken. When the new
person opens that one workbook, it would produce an error for them. It will still try to remember the result there, but you
need to be careful when you have cells referring to data in other workbooks; those links will only be active if both
workbooks are stored on the user’s computer.

These have been some helpful tips on how to manage workbooks and worksheets. As you work with different files, it is
highly recommended that you spend time labeling each sheet appropriately. It makes it very easy to follow what you or
someone else has already done in that file. 

Supplemental Resource

When completed, your practice worksheet should look like the following:

Figure 5.18
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/managing_worksheets.
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Lookup Functions

In this chapter, you will learn one of the most powerful functions Excel has to offer: lookup functions. Specifically, we’ll
learn about V Lookup, X Lookup, H Lookup, and Index/Match. These Functions are so important to know that
companies looking to hire people that know about Excel will ask specifically about these functions in the interview.

Practice Spreadsheet

Use this workbook for the chapter.

Preface
As we go through this practice, we will suppose that we have a student-run company that makes pizzas. There are
about a dozen or so ingredients that they use to make those pizzas. We have an ingredient list from the procurement
team. From the purchases that the company has made, we have a list of the day we purchased an item, what the item
was, and how much we purchased. You will want to add three columns titled Price Per Unit to practice V Lookup, X
Lookup, and Index/Match. (See Figure 19.1)

Figure 19.1

Once we have the price per unit, we can calculate the total cost by multiplying that unit price by the quantity that we
purchased so that we can show the finance team on our summary sheet how much it is that we’re spending on a given
item and over time.
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VLOOKUP
Let’s get started with the VLOOKUP formula. Use the following steps:

1. Select a cell. 
2. Type =VLOOKUP( . (See Figure 19.2)

a. The V stands for vertical lookup.
3. Select the cell that contains the value that you want to look up.

a. For this practice, select Salt. (See Figure 19.2)

Figure 19.2

4. Add a comma.
a. Excel will next need to know what table array you would like to look in.

5. Select the Ingredient List tab.
a. Notice that Salt is listed in the first column.

i. This means that whatever value you are attempting to look up with the V Lookup function has to be in the
first column of your table array.

�. Select the entire table and add another comma. 
7. Type in the index number.

a. The index in this practice starts with Ingredient as column one, Vendor as column two, Location as column
three, and Price Per Unit as column four.

b. Whichever number you type in is the column of the information that will be returned.
c. If we wanted to pull back the price per unit, we need to type in the number 4, because it’s the fourth column in

this table. 
�. Type False or 0 to get an exact match.

a. The last item is looking for whether you would like to use an approximate match or an exact match.
b. In almost every scenario you encounter, you will want to use an exact match.

9. Close the parentheses.
a. The full function in the function bar should read =VLOOKUP(C3,’Ingredient List’!B2:E14,4,0). (See Figure 19.3)

10. Press Enter. 
a. Excel will pull back the price per unit of salt at $4.95. If you check the ingredient list, you will see that this value

is correct.
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Figure 19.3

Fixing VLOOKUP Errors
If you select and drag the formula down to apply it to the rest of the items in the list, you will notice that some errors
start to occur. This is because we did not use anchoring when we created the formula so all of the references are
relative references. When we wrote the initial formula, we referenced B2 through E14. However, as the formula was
dragged down, another cell will reference a different range, like B6 through E18. 

When we create these formulas, there are parts that we want to move. For example, we want to change the lookup value
as we drag it down each row. However, we want the table array to be consistent when we look it up. In this practice, we
also want the column number to stay the same, and we want the range lookup to always be false. If you exclude the
false argument, your formula will come back with errors, although those errors will not happen every time. You need to
make sure as you create these functions that you’re including that final optional lookup option as false. 

There are a couple of ways to fix this reference error. One of them is using dollar signs in the formula to make it an
absolute reference. In this case, the reference will read !$B$2:$E$14. (See Figure 19.4)

Figure 19.4

Then when you drag the formula down, it will reference correctly.

Sometimes you may add things to the list after a formula was created. When you try to drag the function down to those
added items, they won’t show up in the range. To avoid having to change the formula every time something is added,
you can use a named range. For this exercise, use the following steps:
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1. Select the table, but stop at the Olive data entry.
a. For this practice, we will pretend that the rest of the list has not been added yet.

2. Select the name of the range and rename it to ing_table. (See Figure 19.5)
a. The ing stands for ingredient. 

3. Press Enter. 

Once you have done this, go back to the formula. Instead of referencing the long string of B2 through E10 with dollar
signs, just type in ing_table. (See Figure 19.5)

Figure 19.5

Now it will always reference that array. You don’t have to worry about anchoring because it is automatically anchored.
However, there are additional ingredients not included in that table array.

We can fix the issue without having to change the formulas. To do this, use the following steps:
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1. Select the Formulas tab.  
2. Select Name Manager. 

a. This will open a dialog box.
3. Select Edit. (See Figure 19.6)

a. This will open a smaller dialog box.

Figure 19.6

 
4. After Refers to:, change $E$10 to $E$14. (See Figure 19.7)
5. Select OK.

a. The formula will now select the entire table. 
�. Select Close on the bigger dialog box. 

a. The formulas will automatically update. 
7. After Refers to:, change $E$10 to $E$14. (See Figure 19.7)
�. Select OK.

a. The formula will now select the entire table. 
9. Select Close on the bigger dialog box. 

a. The formulas will automatically update. 
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Figure 19.7

 
If you select and drag the formula all the way down the column, Excel’s auto-fill feature will recognize the formula and
drag it all the way down. But you may notice that there are still errors. 

The function comes back with a N/A because Excel can’t seem to find Yeast on the ingredient list. If you go to the
ingredient list, you will notice that, sure enough, Yeast is not one of the items on the list. 
Pepperoni is on the ingredient list, but if you look closely at the worksheet that we are calculating VLOOKUP on,
Pepperoni is spelled incorrectly. Any spelling mistakes on the data that you’re looking up will cause an error, and it
won’t work. 
Oil has an extra space after the word left in the cell, which you can find when you select the cell and look at the
formula bar. To make sure this error doesn’t occur later without having to search each individual cell, use the
following steps:

1. Select the first cell in the column that has the formula applied to it. 
2. Add TRIM to the formula, and surround the cell reference with parentheses. (See Figure 19.8) 

a. In this practice, the cell reference should be C3.
b. The trim function will remove any trailing spaces when Excel does the lookup.

3. Drag the formula down through the rest of the column to apply it to all of those cells.
a. This will correct the error in the data for Oil.

Figure 19.8

To fix the issue with Yeast, we need to add it to the ingredient list. 
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1. Type Yeast in the Ingredient column. 
2. Type BYU-Idaho in the Vendor column. 
3. Type Rexburg, ID in the Location column. 
4. Type $4.78 in the Price Per Unit column. 

Add the new row into the named range using the following steps:

1. Select the Formulas tab.  
2. Select Name Manager. 

a. This will open a dialog box.
3. Select Edit. (See Figure 19.6)

a. This will open a smaller dialog box.
4. After Refers to:, change $E$14 to $E$15. 
5. Select the green checkmark. (See Figure 19.9)

Figure 19.9

 
�. Select Close. 

a. When you go back to the Purchase History sheet, you will see that the error has been fixed.

It’s important to note that we can’t just reference the Ingredient sheet, select the data for salt, and then select and drag
it down on the Purchase History sheet. The ingredients are not in the same order in the two lists on each sheet. The
items on the Purchase History sheet are randomized by day. You could type the equals sign and reference each
respective price per unit for each item, but there is a lot of room for error in that type of work. Instead, we use these
lookup functions because they look for the exact thing we are trying to find and pull back the exact value that we need. 
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XLOOKUP
The lookup array in XLOOKUP is looking for a single column or a single row. If you go back to the ingredient list, the
lookup array is the Ingredient column. The return array, instead of counting the number of columns, is going to be the
Price Per Unit array. XLOOKUP is beneficial when the data we are looking up is not in front of what we want to return.
For example, you would use XLOOKUP if you wanted to look up the price and return which ingredient it was. Or, you
could have it return the vendor, the location, etc. For this practice, change the title under the XLOOKUP column to
Vendor. These pieces may not be a unique identifier, so that may not be the best business-use case. It could, however,
be an example of how we would use this lookup function. After the lookup array and the return array are put into the
function, Excel will ask what you would like it to return if it doesn’t find anything. 

To use XLOOKUP, use the following steps:

1. Select the first cell under the XLOOKUP Price Per Unit.
2. Type =XLOOKUP(TRIM(.

a. Excel will ask for a lookup value.
3. Choose Salt.

a. Make sure to close the parentheses for the trim function.
4. Add a comma, and select all of the data in the Price Per Unit column.
5. Add another comma, and select all the data in the Vendor column.
�. Add a comma. Type “Nothing found”.

a. This phrase is what will show up if Excel doesn’t find anything during the lookup.
7. Add a comma and type 0 to get an exact match.

a. We always want to be exact, which, in this formula, is the default. 
�. Leave the search mode empty. Our data is not long enough for this part of the function to matter.

a. If it is a large set of data, the search mode will give Excel some hints on where it might find what you’re looking
for. This will help the lookup go faster with larger data sets.

9. Close the parentheses.For this exercise, the formula bar should read as follows: =XLOOKUP(TRIM(C3),‘Ingredient
List’!E3:E15,’Ingredient List’!C3:C15,”Nothing found”,0).

10. Press Enter.

You will notice that Excel pulls up Nothing found. This is because the initial lookup value was to try to find the
ingredient. To reverse engineer the formula to find the Price per unit instead of the ingredient, use the following steps:

1. Highlight TRIM(C3) in the formula. (See Figure 19.10)
2. Select the Price Per Unit you want to look up.

a. For this exercise, select 4.95 in the Salt row. 
3. Press Enter. 

a. Excel will return with the vendor name (Norton).

Figure 19.10
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As you drag the formula down the column, you will notice that you will run into the same issue of the lists not being
anchored. You can fix this by following these instructions:

1. Name the Price Per Unit range price
2. Name the Vendor range vendor. 
3. In the formula bar, change ‘Ingredient List’!E3:E15 to price.
4. In the formula bar, change ‘Ingredient List’!C3:C15 to vendor. 
5. The formula should now read =XLOOKUP(F3,price,vendor,”Nothing found”,0). (See Figure 19.11) 
�. Press Enter. 

You can now drag the formula down the column, and Excel will fill it in with no issues.

Figure 19.11

Index and Match
Index and match is actually a method to look things up using two different functions embedded within each other. We’ll
start with the index function. First, the index function asks what array you would like it to return. In this practice, we are
going to choose a new array to return: location. Then, the index function will ask you what row number to return, so we’ll
use the embedded function Match. Match first wants to know what value to look up. For this practice, we want to look
up the item within the array of the Item column on the Purchase History worksheet.

To use Index and Match for this practice, use the following steps:

1. Type =INDEX(.
2. Select the data in the Location column. 
3. Add a comma and type MATCH(.
4. Go to the Purchase History worksheet and select Salt.
5. Add a comma, and select all the data under the Ingredient column of the Ingredient list.
�. Add a comma, and type 0 to make the match type exact.
7. Add two parentheses at the end to end both the Match and the Index functions.

a. The formula bar should read =INDEX(‘Ingredient List’!D3:D15,MATCH(‘Purchase History’!C3,’Ingredient
List’!B3:B15,0)). (See Figure 19.12)

�. Press Enter.
a. The function should bring back Lubbock, TX.
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Figure 19.12

There are a few improvements needed in this function. Use the following steps to do so:

1. Use the TRIM function to fix the Match data.
a. Type TRIM after the open parenthesis in the Match function. 

2. Rename the data under the Location column location.
3. Rename the data in the Ingredient column ing.
4. In the formula bar, change ‘Ingredient List’!D3:D15 to location. 
5. Change ‘Ingredient List!B3:B15 to ing. (See Figure 19.13)
�. Press Enter. 

a. As you drag the formula down through the column, Excel will return with each of the item’s locations.
b. Change the title of the column under Index/Match to Vendor Location.

Figure 19.13

The final piece of this worksheet will be to input the total cost calculation. The total cost calculation is the quantity
purchased multiplied by our price unit. 

1. Select the first cell under Total Cost.
2. Type the equals ( = ) sign and select the first cell under Qty Purchased.
3. Type an asterisk ( * ).
4. Select the first cell under Price Per Unit.

a. The formula should read =D3*F3. (See Figure 19.14)
5. Press Enter.

a. Excel should return with 49.5. 
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Figure 19.14

Select all of the data under Total Cost and Price Per Unit and put it into currency format (for PC and Mac use Control +
Shift + 4). The summary sheet will have two input cells: Ingredient and Information. Use the following steps to complete
a data validation for Ingredients:

181



1. Select the cell to the right of Ingredient.
2. Select the Data tab. 
3. Select Data Validation. (See Figure 19.15) 

a. A dialog box will appear.

 Figure 19.15

 
4. In the Allow dropdown bar, choose List. 
5. Under Source, type =ing to signal the named range for the Ingredient column. (See Figure 19.16) 

 Figure 19.16
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�. Select OK. 

a. Excel will make the selected cell a dropdown list that allows you to choose an ingredient from the list. (See
Figure 19.17)

Figure 19.17

 
7. On the Home tab, use the Input cell style. (See Figure 19.18)
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Figure 19.18

 
We’ll also use data validation in the Information cells. To do so, use the following steps:
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1. Select the cell to the right of Information. 
2. Select the Data tab. 
3. Select Data Validation. 

a. A dialog box will appear.
4. In the Allow dropdown bar, choose List.
5. Select the arrow next to the Source bar. (See Figure 19.19)

Figure 19.19

 
�. Go to the ingredient list, and choose Vendor, Location, and Price Per Unit. 
7. Press the arrow again. (See Figure 19.20)
�. Select OK.
9. On the Home tab, use the Input cell style.

 Figure 19.20
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HLOOKUP
Next, we’ll use HLOOKUP. The H stands for Horizontal Lookup. To use HLOOKUP, complete the following steps:

1. Type Result into another cell on the Summary worksheet. 
2. Format the cell to the right of it with the Output style. (See Figure 19.21)

Figure 19.21

 
3. Type =HLOOKUP(.
4. Select the Location cell. 
5. Add a comma, and select the entire table on the Ingredient List worksheet.

a. Excel will automatically remember the name of this range as ing_table.
�. Add a comma, and type in the row index number.

a. This refers to which row down you want Excel to go to. 
b. In this case, let’s assume we want the row for Flour. This is the second row down on the table, so type 2.

7. Add a comma, and type 0 to get an exact match.
�. Press Enter.

a. Excel will pull back the location in the second row of the Ingredient List table, which is Lansing, MI.

Next, let’s pull back the location for the tomato sauce vendor. To do this, complete the following: 
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1. Include Tomato Sauce in the row index number in the formula. 
2. Select the formula next to Result.
3. Remove the 2 in the row index number slot in the formula. (See Figure 19.22)

Figure 19.22

 
4. Replace the 2 with a Match function by typing MATCH(.
5. Select Tomato Sauce next to Ingredient. This is our lookup value.
�. Add a comma, and select the entire Ingredient column in the Ingredient List page. This is the lookup array.
7. Add another comma, and type 0 for the match type.
�. Close the parentheses.
9. Press Enter. 

a. Excel will pull up the location for Tomato Sauce, which is Sacramento, California.
b. The full formula should read =HLOOKUP(C6,ing_table,MATCH(C4,’Ingredient List’!B2:B15,0),0).

If you wanted the vendor name instead, use the following steps:

1. Select the formula cell next to Information, then select the arrow on the right of the cell.
a. A drop-down menu should appear. 

2. Select Vendor. (See Figure 19.23)
a. Excel will move the result one cell to the left on the Ingredient List sheet and pull up the vendor for Tomato

Sauce, Hintz.
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Figure 19.23

 

Finishing the Summary Sheet
Let’s finish up our summary sheet. Using the lookup function, we may want to have a static ability to pull back the total
cost of items we have purchased. To do this, complete the following: 
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1. Add a column to the Ingredient List chart and title it Total Cost. 
2. Format the Total Cost column like the Price Per Unit column.

a. Select the entire Price Per Unit column.
b. Select the Format Painter. (See Figure 19.24) 
c. Select the entire Total Cost column. The format painter will copy the format from Price Per Unit and apply it to

the new Total Cost column.

Figure 19.24

 

Next, we will use the SUMIFS formula. To do this complete the following steps:

1. Select the first cell under Total Cost.
2. Type =SUMIFS(.
3. Go to the Purchase History sheet and select the entire Total Cost column.

a. This should be Column E.
b. This is the sum range.

4. Add a comma, and select the entire Item column.
a. This should be Column C.
b. This is the criteria range.

5. Add a comma, go back to the Ingredient List sheet, and select Flour.
a. This is the criteria.

�. Close the parentheses. The whole formula should read =SUMIFS(‘Purchase History’!E:E,’Purchase
History’!C:C,’Ingredient List’!B3).

7. Press Enter.
a. Excel will pull up the total cost for Flour. 

�. Drag the formula down the rest of the column to apply it to the rest of the ingredients in the table. 
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Let’s finish up the Summary sheet by including the total cost. To do this, complete the following steps:
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1. On the Summary sheet, select a cell under Result and type Total Cost.
2. In the cell to the right of Total Cost, add three lookup functions. 

a. VLOOKUP
b. XLOOKUP
c. INDEX/MATCH

3. Format the three cells to the left of the lookup functions as Outputs. (See Figure 19.25)

Figure 19.25

 
4. Format the lookup types as Explanatory Notes. (See Figure 19.26)
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Figure 19.26

 
5. Above all of the information, type Pizza Company Lookup. 

a. Format it across the top as a heading, and adjust the row height accordingly. 
b. Hide the rest of the columns and rows that are not part of this data. 

�. Go to the View tab and uncheck the Gridlines checkbox to turn off the ability to see gridlines. (See Figure 19.27)
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Figure 19.27

 

Let’s formulate the VLOOKUP in the Total Cost. Complete the following steps:

1. Select the output-formatted cell to the left of the VLOOKUP label.
2. Type =VLOOKUP(.
3. Select the Ingredient input box.

a. It should still say “Tomato Sauce.” 
b. This is the value for the formula.

4. Add a comma. On the Ingredient List sheet, select the entire table.
a. This is the table array.
b. Remember that we have added a column, so we cannot use our named range this time.

5. Add a comma, and add 5, since there are five columns in your table.
a. This is the column index number.

�. Add a comma, and add 0.
a. This is the range lookup, and it should always be false.

7. Close the parentheses. The final formula should read as follows: =VLOOKUP(C4.’Ingredient List’!B2:F15,5,0)
�. Press Enter.

Let’s formulate the XLOOKUP in the Total Cost. Complete the following steps: 
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1. Select the output-formatted cell to the left of the XLOOKUP label.
2. Type =XLOOKUP(.
3. Select the Ingredient input box.

a. This is the value for the formula.
4. Add a comma, and select the data in the Ingredient column on the Ingredient List sheet. 

a. This is the lookup array. 
5. Add a comma, and select the data in the Total Cost column on the Ingredient List sheet.

a. This is the return array. 
�. Add a comma, and type “Not found”.

a. This will display if the value you are trying to look up could not be found.
7. Add a comma, and type 0 for an exact match.
�. Close the parentheses. The final formula should read as follows: =XLOOKUP(C4,ing,’Ingredient List’!F3:F15,”Not

found”,0)
9. Press Enter. 

Let’s formulate the Index/Match Total Cost Formula. Complete the following steps:

1. Select the output-formatted cell to the left of the INDEX/MATCH label.
2. Type =INDEX(.
3. Go to the Ingredient List sheet and select the data in the Total Cost column.

a. Remember that Index starts with the array you would like to return.
4. Add a comma, and type MATCH(.

a. This will help the formula find the right row number.
5. Add a comma. On the Summary sheet, select Tomato Sauce.

a. This is the lookup value.
�. Add a comma. On the Ingredient List, select the data in the Ingredient column.

a. This is the lookup array.
7. Add a comma, and add 0 for an exact match. 
�. Close both sets of parentheses. The final formula should read as follows: =INDEX(‘Ingredient

List’!F3:F15,MATCH(Summary!C4,ing,0))
9. Press Enter.

You will see that these three formulas illustrate three ways to get the same type of information. Lookup functions are
some of the most valuable and powerful functions that Excel has to offer because you can combine information across
different worksheets, either on a dashboard or within embedded data tables. You will need to practice these in order to
get the hang of how they work and to be confident in correcting errors that come up. Over the course of the projects and
practices that we do, please try out using the different methods that have been demonstrated here in this chapter so
that you can be comfortable with any and all of them.

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/lookup_functions_.
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Data Validation

In Excel, you can enter any value into a cell by default. Data validation is used to help prevent a user from accidentally or
incorrectly entering information into a cell. 

Practice Spreadsheet

Use this workbook for the chapter.

To open the Data Validation window, complete the following steps:

1. Choose the cell(s) to apply data validation to.
2. Select the Data tab on the ribbon toolbar
3. Select Data Validation in the Data Tools field. (See Figure 20.1)

Figure 20.1

The Data Validation window will open. The window will include three tabs for Settings, Input Message, and Error Alert.
Let’s look at the Input Message tab.

Input Message
The Input Message menu has Shows Input Message When Cell is Selected enabled by default. An input message will
display whenever the user selects the designated cell. Fill in the Title and Input message fields, then press OK. (See
Figure 20.2)
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Figure 20.2

 
Although they appear similar, an input message is different from a comment attached to a cell. An input message
requires that the user selects the cell first to view it. A cell comment is displayed whenever the user moves the mouse
over the cell, and the cell contains a little colored triangle in the top right corner.

Now, let’s look at Data Validation’s Settings tab. In this tab, we can set the validation criteria by allowing specific data.
For example, let’s select Text length from the Allow field’s drop-down list.

Text Length
The Text length option allows the user to enter text into a cell as long as the length is between the designated minimum
and maximum values.

For example, if the minimum value is 4, and the maximum is 10, then the user must enter between four and ten
characters into the cell. Otherwise, if less than four or more than ten letters are entered, an error will display stating that
the entry isn’t valid. (See Figure 20.3)
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Figure 20.3

 
Additionally, we can select other data rules such as Equal To to restrict valid input data to the designated length. (See
Figure 20.4)

Figure 20.4

 

Decimal Number
The Decimal Number option will require the user to input a decimal between the designated minimum and maximum
values.

For example, if the minimum is zero and the maximum is one, then the user must enter a decimal number between 0
and 1 (such as 0.3). Otherwise, if the user enters a number lower than 0 or higher than 1 (such as 5), an error message
will be displayed. (See Figure 20.5)
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Figure 20.5

 

Date
The Date option works the same way. The Start and End date values designate the range of valid dates that can be
entered in the cell. (See Figure 20.6)

Figure 20.6

 

List
The List option is an essential tool that will be used frequently. It allows the user to enter or select valid data from a
drop-down list designated in the Source input. 
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For example, if “Item1,Item2” is entered into the Source input, a drop-down list will be available in the specified cell with
those options. The user may also type “Item2” without receiving an error. Additionally, the Source data may reference a
list of cells with the desired input options. (See Figure 20.7)

Figure 20.7

 

Error Alert
The error message for an invalid cell input can be modified in the Error Alert tab. The type of error symbol can change to
Stop, Warning, or Information associated icons. The title of the error message pop-up window and the window’s content
can be customized in the Title and Error message fields. (See Figure 20.8)

Figure 20.8
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XLOOKUP Function
The XLOOKUP function in conjunction with a data validation list is a powerful tool for a dashboard. We can create a
dashboard to look up data about a specific part selected using the data validation list.

In this example, we’ll create our dashboard with a cell formatted with the data validation list referencing part numbers in
our Data spreadsheet. (See Figure 20.9)

Figure 20.9

 
Next, we’ll enter an XLOOKUP formula into a separate cell. The XLOOKUP formula requires three data references—
lookup value, lookup array, and return array. The result will display the data of the designated column in the formula
depending on the part selected in our list. (See Figure 20.10)

Figure 20.10
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1. Type =XLOOKUP and a left parenthesis ( ( ).
2. Select the lookup_value data; in this case, it will be the data validation list of part numbers.

a. The lookup_value in the formula designates the value to search for in the lookup_array coming up.
b. Tip: Use the F4 key to anchor this referenced cell. We will be copying this formula for other data references,

but we don’t want this cell reference to change.
3. Select the lookup_array; this will be the list of part numbers on the Data spreadsheet.

a. The lookup_array is the index of cells the formula will search through to find the previously designated
lookup_value.

b. Tip: Use the F4 key to anchor these referenced cells too.
4. Select the return_array data; this will be the column of data associated with the parts (Price, Lead Time, Order Qty,

Class, % OTD columns). (See Figure 20.11)
a. The return_array is the index of values the formula will reference and return the specific data based on the

search performed using lookup_value and lookup_array.
b. Tip: Use the F4 key to anchor only the rows.

5. Type a right parenthesis ( ) ) and press Enter to complete the formula. 

Figure 20.11

Finally, copy the formula for the remaining data, check that the formulas reference the correct cells, and organize the
dashboard as needed. The dashboard will now display the data for the specified part number that the user selects from
the list.

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/data_validation_.
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IF Statements

In this chapter, we’re going to look at conditional logic in Excel—specifically IF statements. We’ll start with a spreadsheet
that lists employees for a company and includes their gender, position, age, college GPA, and current salary.

Practice Spreadsheet

Use this workbook for the chapter.

Figure 17.1
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Dashboard Setup
Next, we’ll create a dashboard. The dashboard will include input and output cells. The input cells labeled as “Conditional
Inputs” will include gender, age, retirement age, years window, bonus percent, raise over percent, raise under percent,
and two GPA cells. The output cells labeled as “Conditional Outputs” will include average salary, number of employees,
and employees eligible to retire. Finally, we’ll insert data into the input cells. (See Figure 17.1)

Figure 17.2

 
Gender will contain a data list with Male and Female options created with the Data Validation tool.
Age is 40.
Retirement age is 65.
Years window is 35.
GPA related to bonus is 3.5.
Bonus percent is 10%.
GPA related to raise is 3.0.
Raise percent over is 8%.
Raise percent under is 3%.

Note: We can name these cells as we learned in the “Named Ranges” chapter. The cell names can be used hereafter in
the formulas we will work on within this chapter.

IF Data and Average
On the data spreadsheet shown in Figure 17.1, if we want to find the average salary of employees of a specific gender,
we can use an IF function to list salaries in an empty column based on the dashboard’s input cell for employees’ gender.
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The IF function will check if an operation (equal to, less than, or greater than) involving two data values is true or false,
and it can display a specific result if true or a different result if false. In this example, the logic test will check if the
employee’s gender matches the gender displayed on the dashboard, and if true, it will display the employee’s salary.
Then, we can reference the column’s cells in an AVERAGE function to find the total average salary for that gender.

1. Type =IF and a left parenthesis ( ( ) in an empty cell.
2. Select the employee’s gender cell for the logic test’s first value (C3 in Figure 17.3).
3. Type an equals sign ( = ).

a. In other situations, a less than symbol ( < ) or greater than symbol ( > ) may also be used to test values in an IF
logic test.

4. Select the dashboard’s gender input cell or type the cell’s name for the logic test’s second value (the dashboard’s
gender input cell in Figure 17.3).

a. The cell being compared in Figure 17.3 is from the dashboard sheet and has been named “in_gender.” If you
named the cell differently, type the correct name. Otherwise, select the appropriate cell from the dashboard
sheet.

5. Type a comma ( , ) and select the appropriate salary cell to display its value if the logic test is true (G3 in Figure
17.3).

�. Type a comma ( , ) and two double quotation marks ( " ).
a. The double quotation marks signify a text string. However, since no text is inserted between the marks, the cell

will not display anything if the logic test is false.

Figure 17.3

 
7. Type a right parenthesis ( ) ) and press Enter to complete the formula (=IF(C3=in_gender,G3,"")).

a. Notice the formula in Figure 17.3 displays additional text for the referenced cells. Excel requires the
appropriate spreadsheet’s name to be included in the formula when referencing cells on another spreadsheet.
In this case, the first referenced cell is 'IF Statements'!C3 (including the single quotation marks enclosing the
spreadsheet name and followed by an exclamation mark).

Copy the formula down the column for each employee. Finally, create an AVERAGE function on the dashboard's Average
salary output cell to reference this column's cells. The cell will display an overall average based on the gender selected
in the dashboard's Gender input cell.
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Note: There is a specific function known as AverageIFS that can calculate the same result using similar formula
concepts in a single cell. Please research the AverageIFS function and learn more about how it can calculate the same
result.

IF Data and Sum
If we want to find the total employees under a specific age, we can use an IF function in an empty column to check if the
employee’s age is less than the age specified on the dashboard’s Age input cell.

1. Type =IF and a left parenthesis ( ( ) in an empty cell.
2. Select the employee’s age cell for the logic test’s first value (E3 in Figure 17.4).

Figure 17.4

 
3. Type a less than sign ( < ).
4. Select the dashboard’s age input cell or type the cell’s name for the logic test’s second value.

a. In Figure 17.4’s example, the referenced cell’s name is in_age.
5. Type a comma ( , ) and a 1.
�. Type a comma ( , ) and a 0.
7. Type a right parenthesis ( ) ) and press Enter to complete the formula (=IF(E3<in_age,1,0)).

Copy the formula down the column for each employee. Finally, create a SUM function on the dashboard's # of
employees under the output cell to reference this column's cells. The cell will display a total of employees under the age
specified in the Age input cell.

IF Data and Operations
If we want to determine an employee’s raise based on their college GPA, we can write a formula to check the GPA and
whether the raise will be 3% or 8%.
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1. Type =IF and a left parenthesis ( ( ) in an empty cell.
2. Select the cell for the employee’s GPA (F3 in Figure 17.5).
3. Type a greater than sign ( > ).
4. Select the cell for GPA raise on the dashboard sheet.

a. In Figure 17.5, the referenced cell’s name is in_raise_gpa. If you named the cell differently, type the correct
name. Otherwise, select the appropriate cell from the dashboard sheet.

5. Type a comma ( , ) and select the cell for raise percent over to indicate the raise percent for a GPA over the
specified value.

a. In Figure 17.5, the referenced cell’s name is in_raise_over.
�. Type a comma ( , ) and select the cell for raise percent under to indicate the raise percent for a GPA under the

specified value.
a. In Figure 17.5, the referenced cell’s name is in_raise_under.

7. Type a right parenthesis ( ) ) to complete the formula (=IF(F3>in_raise_gpa,in_raise_over,in_raise_under)).

Figure 17.5

 
Format the cell as a percentage and copy the formula down the column for each employee.

If we want to find the raise dollar amount, we can multiply the percentage by the current salary in a new cell.
Alternatively, we can copy or add to the raise percentage formula to multiply by the salary
(=IF(F3>in_raise_gpa,in_raise_over,in_raise_under)*G3).

If we want to know the total new salary, we can modify the formula to add the IF calculation to 1 which signifies 103% or
108% (depending on the percent returned based on the employee’s GPA). The formula will calculate the total new salary
in a single cell.
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1. Type an equals symbol ( = ) and a left parenthesis ( ( ) in a new cell.
2. Type 1 to represent 100% and an addition sign ( + ).
3. Type IF and a second left parenthesis ( ( ).
4. Select the cell for the employee’s GPA (F3 in Figure 17.6).
5. Type a greater than sign ( > ).
�. Select the cell for GPA raise on the dashboard sheet.

a. In Figure 17.6, the referenced cell’s name is in_raise_gpa. If you named the cell differently, type the correct
name. Otherwise, select the appropriate cell from the dashboard sheet.

7. Type a comma ( , ) and select the cell for raise percent over to indicate the raise percent for a GPA over the
specified value.

a. In Figure 17.6, the referenced cell’s name is in_raise_over.
�. Type a comma ( , ) and select the cell for raise percent under to indicate the raise percent for a GPA under the

specified value.
a. In Figure 17.6, the referenced cell’s name is in_raise_under.

9. Type a right parenthesis ( ) ) to close the IF logic formula.
10. Type a second right parenthesis ( ) ) to close the addition operation.
11. Type an asterisk ( * ) for multiplication.
12. Select the cell with the employee’s current salary (G3 in Figure 17.6).
13. Press Enter to complete the formula (=(1+IF(F3>in_raise_gpa,in_raise_over,in_raise_under))*G3).

Figure 17.6

 

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/if_statements_.
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Formula Errors

In this chapter, we’re going to take a look at some of the common errors that occur when formulas are entered into
Excel incorrectly.  

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the If Statements chapter.

Four Common Errors
A common problem that can produce errors is misspelling. For instance, let’s say we’d like to take the average of all of
the ages. If you complete the formula but “average” is spelled incorrectly, Excel cannot recognize the formula itself. It
will give you an error that says “#NAME?” This can be corrected by typing in the correct spelling of the formula and
hitting Enter.

Another type of error is called the value error. Let’s say you are trying to calculate the sum of a few random cells, but
rather than using the sum formula, you just select cells and put the plus sign between them. If you select a cell that is
text rather than numbers, it will show you an error that says, “#VALUE!” This is because it cannot calculate text.
However, if you use the =SUM formula and include a text cell, it will calculate the sum because it has the capability to
add together only the numeral cells. In the case of a value error, simply get rid of the cell that contains text.

A third error type is the divide-by-zero error. For instance, if you type, “=100/0,” it will give you an error that says,
“#DIV/0!” Since Excel can’t calculate an infinite number, it gives this error. For example, this could occur with sales
history. If you’re trying to calculate the difference in sales between four years, in year zero, you have no “last-year’s
sales.” For example, in the following data, if you divide the new year by the old year and Subtract one, it will give you the
percentage increase. (See Figure 18.1)

Figure 18.1
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However, if you drag that formula up to the other years, when it gets to 1, there is no former year to divide it by, and you
get a divide-by-zero error. 

The fourth type of error that we’ll look at is called the reference error. Let’s suppose we reference two cells and add
them together, and then delete one of the cells being referenced or the row that a reference cell is in by right-clicking
and selecting “delete the cell” or “delete the row.” It will give you an error that looks like “#REF!” in place of the
referenced cell. This is because that cell technically no longer exists. However, if you select a referenced cell and just
press the Delete key, the formula still calculates. This is because the Delete key only gets rid of the text, not the cell
itself, whereas if you right-click and choose delete, it would delete the cell itself, and the formula would no longer
understand what it is supposed to be referencing.

IFERROR Formula
As we think about other ways to handle these various errors that we’ll see in Excel, there’s a formula to be made aware
of called “IFERROR.”

1. To get to it, type =IFERROR(.
a. You’ll notice it asks for a value as the first argument, and the second argument is for if there’s an error.

(See Figure 18.2)

Figure 18.2

 
b. For example, if the formula was to calculate the sum of two salaries, let’s say we want to anticipate there could

be some sort of error in the future. 
c. Reference cells G13 and G17 to add them together for the first argument.
d. For the second argument, put in a text string saying, Error Found. (See Figure 18.3)

Figure 18.3

 
e. Delete G17 by right-clicking and selecting Delete.
f. You’ll notice once you do this that the original sum formula gives a #REF! error, but the IFERROR formula lets

you know in regular text that an error was found.
i. Of course, a formula doesn’t have to be text strings. It could be a separate formula. This could be useful if

the first formula receives an error and you want to use a different calculation instead.
g. How the formula works is that it first tries to calculate everything in the first argument. If an error of any type is

found in the formula, it then reverts the response to the second argument.

There are other formulas that you can use to direct certain types of errors. For example, you can use ISERR, and it
checks whether a value is an error other than #N/A.

214



While this has been a basic overview of the error types you may see in Excel, the key takeaway from this chapter is that
you should pay attention to potential areas where errors could occur, and you use formulas like IFERROR to mitigate the
effects those errors might have on future calculations throughout your worksheet.

For a closing example, let’s say you use the SUM formula to calculate the sum of all the salaries and suppose an error
of some type is found within the formula. That sum formula now cannot calculate what had been where the error is
now. So, as you’re thinking about where to mitigate error possibilities, if you have a formula that’s looking up a salary
from another location, you may want to figure out a way for it to handle if that lookup fails so that your sum of all the
salaries does not also fail.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/formula_errors_.
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Text Functions

Excel includes functions for textual strings to reformat, separate, combine, and rewrite the text. These functions can be
combined together to do advanced actions when working with textual strings.

In this chapter, we will reference data in Figure 32.1 that includes a City, State, Zip Code text string, and Population and
Rank data. However, we only need the former text string.

Practice Spreadsheet

Use this workbook for the chapter.

Figure 32.1

For ease of reference, it is recommended to freeze our top row(s) containing headers and the left column(s) containing
the City, State, Zip Code information. We can do this by selecting the cell below the header row and right of the
aforementioned column, then going to the View tab of the ribbon toolbar, and selecting Freeze Panes and Freeze Panes
again.
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Figure 32.2

 

Lower
The Lower function is used to edit a text string to have all lowercase letters. In this example, we will use it to lowercase
all letters in the city, state, and zip code information cell.

1. Type =LOWER and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data.
3. Type a right parenthesis ( ) ) to close the formula.
4. Press Enter to complete the function. (See Figure 32.3)

Figure 32.3

 

Upper
The Upper function is used to edit a text string to have all uppercase letters. We can use it to uppercase all letters in the
city, state, and zip code information cell.

1. Type =UPPER and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data.
3. Type a right parenthesis ( ) ) to close the formula.
4. Press Enter to complete the function. (See Figure 32.4)

Figure 32.4
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Proper
The Proper function is used to edit a text string to uppercase the first letter of each word. Our original reference data
already has words formatted in this manner, but we can use one of the previously completed Lower or Upper function
cells for reference.

1. Type =PROPER and a left parenthesis ( ( ) to start the function.
2. Select one of the previous function cells containing all lower or upper case text.
3. Type a right parenthesis ( ) ) to close the formula.
4. Press Enter to complete the function. (See Figure 32.5)

Figure 32.5

 

Left
The Left function can be used to pull and display a designated number of characters beginning from the left of a text
string.

1. Type =LEFT and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type a preferred number of characters to pull from the selected cell.

a. In this example, we'll pull three characters from the text string of the selected cell.
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function. (See Figure 32.6)

Figure 32.6

 

Right
Identical to the Left function, the Right function can be used to pull and display a designated number of textual
characters beginning from the right of a text string. For this example, we'll pull five characters to copy the zip code at
the end of the text string.
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1. Type =RIGHT and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type a preferred number of characters to pull from the selected cell.

a. In this example, we'll pull five characters from the text string of the selected cell.
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function. (See Figure 32.7)

Figure 32.7

 

Length
The Length function counts the number of characters in a cell's text string.

1. Type =LEN and a left parenthesis ( ( ) to start the function.
2. Select the preferred cell to evaluate the number of characters it contains.
3. Type a right parenthesis ( ) ) to close the formula.
4. Press Enter to complete the function. (See Figure 32.8)

Figure 32.8

 

Trim
The Trim function removes any extra spaces found within the cell's text string. The data for city, state, and zip code
includes two spaces between state and zip code information. We can use Trim to remove the second space.

1. Type =TRIM and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data.
3. Type a right parenthesis ( ) ) to close the formula.
4. Press Enter to complete the function. (See Figure 32.9)

Figure 32.9
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Ampersand
An ampersand symbol instructs Excel to combine two references in an argument.

1. Type an equals sign ( = ).
2. Select the first cell to be combined and type an ampersand ( & ).
3. Type " " (with a space between the quotation marks).
4. Type an ampersand ( & ) and select the second cell to be combined.
5. Press Enter to complete the formula. (See Figure 32.10)

Figure 32.10

 

Concatenate
Similar in function to the ampersand, the CONCAT (Concatenate) function combines multiple cell references into one
cell.

1. Type =CONCAT and a left parenthesis ( ( ) to start the function.
2. Select the first cell to be combined and type a comma ( , ).
3. Select a second cell to be combined.

a. Additional cells may be combined by typing another comma and selecting the next cell. 
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function. (See Figure 32.11)

Note: Like the previous function example, you may need to include a space between quotation marks to separate the
selected items. For example, the Figure 32.11 formula would look like the following: =CONCAT(M3," ",K3," ",J3)

Figure 32.11

 

Value
The Value function converts numbers used in a textual string format to number format. In the case of the zip code
produced in the earlier Right function section, we'll use Value combined with Right to convert the zip code into a
numerical format whereby it will be right-aligned in the cell.

1. Type =VALUE and a left parenthesis ( ( ) to start the function.
2. Type RIGHT and a second left parenthesis ( ( ).
3. Select the previous Right function cell containing the zip code data.
4. Type two right parenthesis ( ) ) to close both formulas.
5. Press Enter to complete the function. (See Figure 32.12)
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Figure 32.12

 

Find
The Find function is used to locate the first position of an indicated character in a referenced textual string.
Note: This function is case-sensitive.

1. Type =FIND and a left parenthesis ( ( ) to start the function.
2. Type "," and a comma ( , ).
3. Select the cell containing the City, State, Zip Code data.
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function. (See Figure 32.13)

Figure 32.13

 

Search
Identical to the Find function, the Search function will locate the first position of an indicated character in a text string.
Note: This function is not case-sensitive.

1. Type =SEARCH and a left parenthesis ( ( ) to start the function.
2. Type "a" and a comma ( , ).
3. Select the cell containing the City, State, Zip Code data.
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function. (See Figure 32.14)

Figure 32.14

 

Replace
The Replace function is capable of rewriting a designated portion of the referenced cell's text. In this example, we'll
reference the city, state, and zip code cell, indicate a starting point, determine the number of characters from that point
to be replaced, and insert a new string.
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1. Type =REPLACE and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type 1 to indicate the beginning of the text string.
4. Type a comma ( , ).
5. Type 10 or another number to indicate the number of characters to replace.
�. Type the new text enclosed in double quotation marks.

a. In this example, we will use "Example" for the new text.
7. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function. (See Figure 32.15)

Figure 32.15

 

Substitute
Substitute works similarly to the Replace function by searching for a designated character or text to be substituted and
inserting the new text.

1. Type =SUBSTITUTE and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type "a" and a comma ( , ).
4. Type "_" to indicate the new character.
5. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function. (See Figure 32.16)

Figure 32.16

 

Middle
The Middle function works like the Left and Right functions by beginning at a specified position in a text string and
pulling a determined number of characters.

1. Type =MID and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type the preferred number of characters to indicate the start point and a comma ( , ).
4. Type the preferred number of characters to pull from the selected cell.
5. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function. (See Figure 32.17)

Figure 32.17
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Now, we want to extract individual data from the City, State, Zip Code column. We will start by finding the city using the
=LEFT function, then the state using the =MID function, and finally, the zip code using the =RIGHT function.

Combining Functions
The City column will be our first step. In this column, we’ll be using the =LEFT function. Use the following steps to
extrapolate the city from the City, State, Zip Code column:, 

1. Type =LEFT and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type FIND and a second left parenthesis ( ( ).
4. Type "," and a comma ( , ).
5. Select the same cell containing City, State, Zip Code data.
�. Type a right parenthesis ( ) ) to close the FIND formula.
7. Type -1 or another number to subtract extra characters as needed.
�. Type a right parenthesis ( ) ) to close the LEFT formula.
9. Press Enter to complete the function. (See Figure 32.18)

Figure 32.18

 
The State column is a little trickier. In this column, we’ll be using the =MID function. Use the following steps to
extrapolate the state from the City, State, Zip Code column:

1. Type =MID and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. Type LEN and a second left parenthesis ( ( ).
4. Select the previous cell containing only the city name.
5. Type a right parenthesis ( ) ) to close the LEN formula.
�. Type +3 or another number to add extra characters as needed.
7. Type a comma ( , ).
�. Type FIND and a left parenthesis ( ( ).
9. Type "  " (with two spaces between the quotation marks) and a comma ( , ).

10. Select the same cell containing City, State, Zip Code data.
11. Type a right parenthesis ( ) ) to close the FIND formula.
12. Type -LEN and a left parenthesis ( ( ).
13. Select the previous cell containing only the city name.
14. Type a right parenthesis ( ) ) to close the LEN function.
15. Type -3 or another number to subtract extra characters as needed.
1�. Type a right parenthesis ( ) ) to close the MID formula.
17. Press Enter to complete the function. (See Figure 32.19)

Figure 32.19
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If you ever want to make sure you have those extra spaces removed, you can always wrap the entire formula in a trim
function, which will remove the extra spaces for you. (See Figure 32.20)

Figure 32.20

 
The Zip Code will be the most straightforward step. In this column, we’ll be using the =RIGHT function. Use the
following steps to extrapolate the zip code from the City, State, Zip Code column:

1. Type =RIGHT and a left parenthesis ( ( ) to start the function.
2. Select the cell containing the City, State, Zip Code data and type a comma ( , ).
3. We only want the five characters from the right of the cell, so type the number 5. 
4. Embed the =RIGHT formula in a value by typing value( between the equal sign ( = ) and RIGHT.
5. Add a left parenthesis ( ( ) after value to embed the function. 
�. Close the formula with a right parenthesis ( ) ) at the end. See Figure 32.21 for a completed formula.

Figure 32.21

 
Now that you have the City, State, and Zip Code in separate columns, select all three input cells and click and drag down
to automatically update the columns. It will even account for spaces between words, like Little Rock. 

These text functions are invaluable when manipulating data; take the time to learn them to manipulate text quickly and
accurately.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/text_functions.
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Text to Columns

Excel has a built-in function called Text to Column to parse information into separate columns from a single column.
We're going to use a spreadsheet with data listed in three columns. The first column contains data for city, state, and zip
code. (See Figure 22.1)

Practice Spreadsheet

Use this workbook for the chapter.

Note: This is the same workbook used in the Text Functions chapter.

Figure 22.1
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However, we want to separate the information from this single column into individual columns. To achieve this, we use
Excel’s Text to Column function. To get started, navigate to the Data tab in the ribbon toolbar. Then, press the Text to
Columns button. (See Figure 22.2)

Note: We can use functions to separate data, but Text to Columns can be useful when the data does not need to update
after separation.

Figure 22.2

 

Using a Delimiter for Text to Column
The Text to Columns button will open a dialogue box with two options as shown in Figure 22.3: Delimited and Fixed
Width. Delimited parses data by using specific symbols as separators to represent the point data will be divided. Fixed
Width parses data determined by the number of spaces between characters specified for separation. 

We’re going to look at the Delimited option first, then we’ll address Fixed Width. Complete the following steps:
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1. Select Delimited and press Next. (See Figure 22.3)
a. The window will ask what we want to be the delimiter. We can choose tabs, semicolon , comma, space, or

another specific character of our choice. (See Figure 22.4)

Figure 22.3

 
2. Look at what separates the city, state, and zip code.

a. A comma separates the city and state, then a double space separates the zip code. 
3. Select Comma to separate the city data. 

a. Notice the preview demonstrates where the separation will occur and it will remove the comma. 
4. Press Next to continue.
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Figure 22.4

 
5. Determine how the separated data is formatted. 

a. Note: The Do not import column (skip) option can be selected to simply remove excess data. 
�. For this example, we’ll select General to port the excess data to the next cell. 
7. Press Finish to complete the function. (See Figure 22.5)

Figure 22.5
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Choosing a Delimiter
Now that we have separated the city data, we need to do the same for state and zip code because they are divided by
two blank spaces instead of a comma. However, attempting to separate state and zip code by a space delimiter could
pose a problem with state names containing a space. For example, New York would be divided with New and York in
their own columns.

One solution would be to replace the double spaces with a valid delimiter. We can do this by using the Find & Replace
tool. 

1. Navigate to the Home tab of the ribbon toolbar and press the Find & Select button (See Figure 22.6)
2. Select Replace….

Figure 22.6

 
3. The Find and Replace window will prompt you to type the characters to search, then the character to replace the

found selection. 
a. Enter two blank spaces in the Find what field
b. Enter a “pipe” or vertical bar ( | ) in the Replace with field. 

4. Press Find Next and Replace for each instance, or press Replace All to complete the action for every instance.
(See Figure 22.7)

Figure 22.7

 
Once completed, the Text to Column function can be used again to separate the data by the vertical bar delimiter as it
did with the comma.
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Using Fixed Width for Text to Column
The Fixed Width option will separate data based on the selected space between characters. For example, we could
select the eighth space on the ruler and everything after will be separated into the new cell(s). This option can be useful
if all the data equals the same number of characters, such as a five-digit zip code (Ssee Figure 22.8), but we only need
the first two digits.

Figure 22.8

 

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/text_to_columns.
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Logic Functions 2

Excel logic functions are powerful tools to evaluate data. In addition to the IF logic function, the OR and AND functions
can expand the logic criteria when used in conjunction with the IF function.

For this chapter, we will reference data from Figure 33.1, including employee names, genders, positions, tenures, GPAs,
and salaries. We want to evaluate the data in varying scenarios to award employees with a bonus.

Practice Spreadsheet

Use this workbook for the chapter.

Figure 33.1
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IF Function
In the first scenario, we want to give employees who have a tenure greater than 15 years $5,000, and $1,000 for those
with a tenure of 15 and less. We can evaluate the criteria using the IF function.

1. Type =IF and a left parenthesis ( ( ) to start the function on the first employee's row.
2. Select the cell containing the employee's tenure data.
3. Type >15 to indicate a greater than 15 evaluation and type a comma ( , ).
4. Type 5000 as the bonus value for the employee if the greater than evaluation is true.
5. Type a comma ( , ).
�. Type 1000 as the bonus value for the employee if the greater than evaluation is false.
7. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function (shown as =IF(E3>15,5000,1000) in Figure 33.2).

Figure 33.2

OR Function
If we want to evaluate multiple criteria and award the employee based on tenure or GPA, we can use the OR function
within an IF function. In this example, we will use an OR function to check if the employee's tenure is greater than 15, or
if their GPA is greater than 3.5, and award them with $5,000 if one of the conditions is true. Otherwise, the employee will
receive $1,000 if neither tenure nor GPA is greater than the set value.

1. Type =IF and a left parenthesis ( ( ) to start the function on the first employee's row.
2. Type OR and a second left parenthesis ( ( ).
3. Select the cell containing the employee's tenure data.
4. Type >15 to indicate a greater than 15 tenure evaluation and type a comma ( , ).
5. Select the cell containing the employee's GPA data.
�. Type >3.5 to indicate a greater than 3.5 GPA evaluation.
7. Type a right parenthesis ( ) ) to close the OR formula.
�. Type a comma ( , ).
9. Type 5000 as the bonus value for the employee if the greater than evaluation is true.

10. Type a comma ( , ).
11. Type 1000 as the bonus value for the employee if the greater than evaluation is false.
12. Type a right parenthesis ( ) ) to close the IF formula.
13. Press Enter to complete the function (shown as =IF(OR(E3>15,F3>3.5),5000,1000) in Figure 33.3).

Figure 33.3

AND Function
The AND function requires both criteria to be true. We will use this function to evaluate if the employee's tenure is
greater than 15 and GPA is greater than 3.5 to determine if the employee receives a $5,000 bonus.
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1. Type =IF and a left parenthesis ( ( ) to start the function on the first employee's row.
2. Type AND and a second left parenthesis ( ( ).
3. Select the cell containing the employee's tenure data.
4. Type >15 to indicate a greater than 15 tenure evaluation and type a comma ( , ).
5. Select the cell containing the employee's GPA data.
�. Type >3.5 to indicate a greater than 3.5 GPA evaluation.
7. Type a right parenthesis ( ) ) to close the AND formula.
�. Type a comma ( , ).
9. Type 5000 as the bonus value for the employee if the greater than evaluation is true.

10. Type a comma ( , ).
11. Type 1000 as the bonus value for the employee if the greater than evaluation is false.
12. Type a right parenthesis ( ) ) to close the IF formula.
13. Press Enter to complete the function (shown as =IF(AND(E3>15,F3>3.5),5000,1000) in Figure 33.4).

Figure 33.4

Nested IF Function
A nested IF function sets a condition within another IF function's true or false arguments. These may be chained
multiple times to set degrees of logic. For example, we want to build a varying bonus amount based on the number of
years an employee has been with the company. If the employee has a tenure of 11–15 years, they will receive $2,000.
Another employee with a tenure of 21–25 years will receive $6,000.

First, we'll build a table to determine every tenure range and bonus amount (see Figure 33.5). The first column will
contain years beginning with five and increase in integrals of five until 30 years. The second column will contain bonus
amounts beginning with $1,000 for five years and increase to $2,000, $5,000, $6,000, $7,500, and $10,000. We'll add a
final row for 100 years with $10,000 for reference.

Figure 33.5

 
Then we'll write an IF function using the table. It will start by awarding $10,000 to employees with a tenure greater than
30 years, but if the logic is false (the employee's tenure is 30 or below), a new IF function will be inserted for the false
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argument and descend through the table's data. The chain of IF functions for false conditions will continue until the
table's final values wherein the false argument returns zero for tenure below five.

1. Type =IF and a left parenthesis ( ( ) to start the function on the first employee's row.
2. Select the cell containing the employee's tenure data.
3. Type > to indicate a greater than evaluation.
4. Select and anchor the table's cell containing 30 to indicate a greater than 30 evaluation and type a comma ( , ).

(See Figure 33.5)
5. Select and anchor the cell containing the bonus value for 30 years ($10,000) and type a comma ( , ).
�. Type IF and a left parenthesis ( ( ) to insert a new IF argument if the greater than evaluation is false.
7. Repeat steps 2–6 for each value of Years and Bonus appropriately until the final value_if_false argument.
�. Type 0 (zero) as the final value_if_false argument.
9. Type six right parentheses ( ) ) to close all IF formulas.

10. Press Enter to complete the function
(=IF(E8>$P$8,$Q$8,IF(E3>$P$7,$Q$7,IF(E8>$P$6,$Q$6,IF(E8>$P$5,$Q$5,IF(E8,$P$4,$Q$4,IF(E3>$P$3,$Q$3,0))
as the final formula).

However, a nested IF function can be complex and prone to errors. There is a time and place for nested IF functions, but
there may be more efficient alternatives.

Match and Index Functions
The Match and Index functions can achieve the same results as a nested IF function. We'll start with the Match function
to identify the row in the Figure 33.5 chart that closely matches the employee's tenure.

1. Type =MATCH and a left parenthesis ( ( ) to start the function on the first employee's row.
2. Select the cell containing the employee's tenure data and type a comma ( , ).
3. Select and anchor the table's range of cells containing year values and type a comma ( , ).
4. Type 1 to indicate an approximate less than match.
5. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function (shown as =MATCH(E3,$P$3:$P$9,1) in Figure 33.6).

Figure 33.6

Now we need to add the Index function to return the value associated with the tenure match. To do it, we'll insert the
Index function before Match and select the range of cells containing the bonus data for the lookup_value argument. The
Match function will take the place of the Index function's lookup_array. Finally, the match type will be 1 to indicate an
approximate less than match.
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Figure 33.7

 
The results may be a little different from the nested IF function due to a difference in the evaluations. The nested IF
function returned bonus amounts based on if the employee's tenure is greater than the table's Year values. Whereas the
Index and Match functions return a bonus amount based on if the employee's tenure is less than or equal to the chart's
values.

These functions will also result in an error if the employee's tenure is less than five because the chart does not include a
row for years below five. One way to resolve this problem is to enclose the Index and Match operations with another
function: IFERROR. The IFERROR function can be set to return zero if the other functions produce an error.

Figure 33.8

 

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/logic_functions_2.
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Date and Time

In this chapter, you will practice some date and time functions. 

Practice Spreadsheet

Open a blank workbook for this chapter.

The TODAY Function
The TODAY function will put the current date in the cell. To use the TODAY function, use the following steps:

1. Select an empty cell.
2. Type =TODAY().

a. This function does not require any arguments, so you can just close the parentheses without anything in them.
3. Press Enter.

a. Excel will enter the current date into the cell.

The NOW Function
The NOW function will put both the current date and the current time in the cell. To use the NOW function, use the
following steps:

1. Select an empty cell.
2. Type =NOW().

a. Like the TODAY function, the NOW function does not require any arguments, and the parentheses can be left
empty.

3. Press Enter.
a. Excel will enter the current date and time into the cell.

The time that is entered, however, is not real time. The time only updates whenever the cell recalculates. If you were to
select the cell, select the formula bar, and press Enter again, the cell would update to the most current time. Sometimes,
if another cell recalculates, this cell will also recalculate. However, the time in this cell is not going to tick through every
minute and every second. 

The YEAR Function
Next, we will use the YEAR function, which requires a serial number. A serial number is how Excel interprets dates. If you
reference the date from the TODAY function, it will automatically format it as a date. If you use the dropdown menu in
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the Number section of the Home tab and format the date as General, the date turns into a number. (See Figures 31.1
and 31.2) 

Figure 31.1

 

Figure 31.2

 
This number is how Excel interprets dates. They are serial numbers. Each day is an additional number on the serial
number. If you made a function in the next cell that added 1 to the cell with the serial number and then formatted the
result as a date, Excel would input tomorrow’s date into the cell. You will notice that the time in the Now data updates
when the cell containing tomorrow’s date had recalculated. 

To use the YEAR function, use the following steps:
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1. Select an empty cell.
2. Type =YEAR(.
3. Select the cell that contains the date from the TODAY function.
4. Close the parentheses.

a. For this exercise, the whole formula should read =YEAR(C2)
5. Press Enter.

a. Excel will return with the year of today’s date.
i. For example, the YEAR function in the figures for this chapter would return with 2021.

Keep in mind that this function returns the year as a number, not a date. It’s not returning a date with only the year
showing. To make a date only show the year, use the following steps:

1. Select an empty cell, and reference the date we got from the TODAY function. 
2. To open the cell’s Format menu, right-click and choose Format or use Control + 1 (PC) or Command + 1 (Mac).
3. Under Category, choose Custom. (See Figure 31.3)
4. In the Type box, type YYYY. (See Figure 31.3)

a. This will show only the year of the date.
5. Select OK.

a. Excel will keep it formatted as a date, but it will only show the year.

Figure 31.3

 
However, this is not the same as what showed up when we used the YEAR function the first time. In this example, the
function returned with the number, 2,021, not a date. If you were to type = and test to see if the two results of 2021 were
the same, Excel would return with FALSE. (See Figure 31.4)
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Figure 31.4

 

The MONTH Function
The MONTH function will do something similar. To use the MONTH function, use the following steps:

1. Select the cell next to Month, and type =MONTH(.
2. Select the date that was returned from the TODAY function. (See Figure 31.5)
3. Make sure to close the parentheses.
4. Press Enter. 

a. Excel will return with the number of the month.
b. In the example from the figures, this would be 8.

Figure 31.5

 

The DAY Function
The DAY function works the same way as well. To use the DAY function, use the following steps:
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1. Select the cell next to Day, and type =DAY(.
2. Select the date that was returned from the TODAY function. 
3. Make sure to close the parentheses.
4. Press Enter.

a. Excel will return with the number of the day.
i. We give Excel a serial number, and it returns with a number.

b. In the example from the figures, this would be 6.

The HOUR Function
The HOUR function works in a similar way, but there is something different. To use the HOUR function, use the following
steps:

1. Select the cell next to Hour, and type =HOUR(.
2. Select the date that was returned from the TODAY function.
3. Make sure to close the parentheses. 
4. Press Enter.

You will notice that Excel returned with 0. If you press Control + 1 (PC) or Command + 1 (Mac) and select Custom, you
will see that this is because the Type box does not include the hour and the minute. To fix this, add hh:mm a/p and
select OK (See Figure 31.6). This will add the time in a.m. or p.m. in the TODAY function. Because the TODAY function
doesn’t have a time attached to it, it will just show 12:00 a.

Figure 31.6
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To get the result we want, we need to use the HOUR function on the data returned from the Now function. To do this,
use the following steps:

1. Select the cell next to Hour, and type =HOUR(.
2. Select the date that was returned from the Now function.
3. Make sure to close the parentheses. 
4. Press Enter.

a. Excel will return with the hour in the Now result.
i. In the example from the figures, this would be 20.

The DATE Function
Next is the DATE function, and this one works in reverse. You need to tell it a year as a number, a month as a number,
and a day as a number. To use the DATE function, use the following steps:

1. Select the cell next to Date, and type =DATE(.
2. Select the data that was returned from the YEAR function.
3. Add a comma, and select the data returned from the MONTH function.
4. Add a comma, and select the data returned from the DAY function.
5. Make sure to close the parentheses. (See Figure 31.7)
�. Press Enter.

a. Excel will return with a date formatted just like what the TODAY function returned.

Figure 31.7

 

The EDATE Function
In addition to having a specific date, the EDATE formula allows you to take a certain starting date and then add or
subtract a certain number of months from it. To add months using the EDATE function, use the following steps:
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1. Select the cell next to Edate, and type =EDATE(.
2. Select the date from the Date formula. 
3. Add a comma, and type 1.

a. This tells Excel that you want to add one month to the original date.
4. Make sure to close the parentheses. (See Figure 31.8)
5. Press Enter. 

a. Excel will return with the serial number for the new date.
b. Use the format painter to apply the Date formatting to the EDATE result.

Figure 31.8

 
You could try to get the same result by writing a formula that adds 30 to the original date, but since each month has a
different number of days, it will not always be accurate. Using the EDATE function will be more accurate.

To subtract months using the EDATE function, use the following steps:
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1. Select the next empty cell next to Edate, and type =EDATE(.
2. Select the date from the Date formula. 

a. This is the start date.
3. Add a comma, and type -3.

a. A negative number tells Excel you want to subtract three months from the original date.
4. Make sure to close the parentheses. (See Figure 31.9)
5. Press Enter.

a. Excel will return with the serial number for the new date.
b. Use the format painter to apply the Date formatting to the EDATE result.

Figure 31.9

 

The EOMONTH Function
The EOMONTH formula stands for “end of month.” Given a certain start date, the EOMONTH formula adds a certain
amount of months. To use the EOMONTH function, use the following steps:

1. Select the cell next to EOMONTH, and type =EOMONTH(.
2. Select the date from the EDATE formula. 

a. This is the start date.
3. Add a comma, and type 0. 

a. This tells Excel that you want the last day of the month from the start date.
4. Make sure to close the parentheses. (See Figure 31.10)
5. Press Enter.

a. Excel will return with the serial number for the new date.
i. Use the format painter to apply the Date formatting to the EOMONTH result.

b. Once it is formatted as a date, Excel will return with the last day of the start date. 
i. In the example from the figures, this would be 9/30/2021.
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Figure 31.10

 
Instead of going to the end of the current month, you can also go to the end of the next month. To do this, use the
following steps:

1. Select the next empty cell next to EOMONTH, and type =EOMONTH(.
2. Select the date from the EDATE formula. 

a. This is the start date.
3. Add a comma, and type 1. 

a. This tells Excel you want the last day of the month one month from the current date.
4. Make sure to close the parentheses. (See Figure 31.11)
5. Press Enter. 

a. Excel will return with the serial number for the new date.
i. Use the format painter to apply the Date formatting to the EOMONTH result.

b. Once it is formatted as a date, Excel will return with the last day of the start date.
i. In the example from the figures, this would be 10/31/2021.
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Figure 31.11

 
Always make sure that the formatting is correct. Excel thinks of dates as numbers, but we want to see them formatted
as a date. Here is another example of date formatting: 

1. Select a cell that contains a date.
2. Press Control + 1 (PC) or Command + 1 (Mac) to open the Format Cells dialog box.
3. Under Category, select Custom.

a. This will allow you to customize the formatting of your dates.
b. There is also a Date category, which will give you a list of pre-built options, but we will not use it for this

example.
4. In the Type box, type yyyy.

a. This tells Excel you want the date first, with all four digits.
5.  Add a space, and type mmmm. 

a. This tells Excel you want the full name of the month.
i. Typing mmm will give you an abbreviation of the month.

�. Add a space, and type dd. (See Figure 31.12)
a. This tells Excel you want the day to always show up as double digits.

i. Single-digit days will have a zero in front. For example, the first day would appear as 01.
7. Select OK.

a. Excel will change the formatting to the custom format.
b. For example, in the example from the figures, the date would now read as follows: 2021 September 30.
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Figure 31.12

 
There are a lot of ways you can customize how these dates are displayed, but what’s important to remember is the
underlying value. In this case, it’s a date, so it’s going to appear as a serial number as seen in Figure 31.2. In the case of
the YEAR function, it appears as a number, so you can’t actually format it with any of the date formats. If you tried to
format 2021 as a date, Excel would read it as the serial number for the year 1905, which is not what you want. 

The WEEKDAY Function
Next, we’ll look at the WEEKDAY function. This gives you the number of the day of the week of a certain date. To use the
WEEKDAY function, use the following steps:

1. Select the cell next to Weekday, and type =WEEKDAY(.
2. Select the result from the TODAY function.
3. Add a comma to get to the return type.

a. This allows you to choose how Excel counts the days of the week. (See Figure 31.13)
i. The default has Sunday as the first day of the week and Saturday as the last day of the week.

4. Type 1 to set it to the default setting. 
5. Make sure to close the parentheses. (See Figure 31.14)
�. Press Enter.

a. Excel will return with the day number of the day of the week.
b. In the example from the figures, Excel would return with 6, meaning the weekday is a Friday.
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Figure 31.13
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Figure 31.14

 
If you did the same formula and chose a return type where the first day of the week is Thursday, then the formula would
return with 2. When we use this formula, we have to be careful which type that we’re referencing. If you just choose the
date and don’t enter that second argument, Excel will go with the default of the first return-type option.

The WEEKNUM Function
The WEEKNUM function tells you the week number of the date in the year. To use this function, use the following steps:

1. Select the cell next to WEEKNUM and type =WEEKNUM(.
2. Select the result from the TODAY function. 
3. Add a comma, and type 1 to let the week begin on Sunday.
4. Make sure to close the parentheses. (See Figure 31.15)
5. Press Enter.

a. Excel will return with the week number the TODAY date falls in.
b. In the example from the figures, Excel will return with 32, meaning the inputted date falls in the 32nd week of

the year.
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Figure 31.15

 

The WORKDAY Function
The next function that we’ll look at is the WORKDAY function. You’ll notice there are actually two options: WORKDAY and
WORKDAY.INTL. (See Figure 31.16)

Figure 31.16

Some prefer to use the WORKDAY.INTL formula because it’s more extensive in the options that it presents to you, so
this is the one we will use in this practice. This function will tell you what date it will be after a number of inputted
workdays. To use this formula, use the following steps:
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1. Select the cell next to Workday and type WORKDAY.
2. Select the WORKDAY.INTL option. (See Figure 31.16)
3. Select the result from the TODAY function.

a. This is the start date.
4. Add a comma, and type 10.

a. This signifies how many workdays you want to go into the future.
5. Add a comma, and type 1.

a. This is an optional argument, and 1 signifies the default weekend of Saturday and Sunday.
�. Make sure to close the parentheses. (See Figure 31.17)

a. The last parameter has to do with holidays. This could include holidays like Christmas, Easter, or New Year’s
Day. However, you have to have that list in a separate set of cells, and the dates have to be the correct year on
that list of holidays.

7. Press Enter. 
a. Excel will return with the serial number for the date.
b. Use the format painter to format it as a date.
c. In the example from the figures, Excel will return with 8/20/2021.

Figure 31.17

 
You may be wondering why it took all the way from the 6th to the 20th to get through 10 workdays, because that is
longer than 10 days. This is because the WORKDAY function excludes Saturdays and Sundays when it counts out the
ten days. (See Figure 31.18)
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Figure 31.18

 

Applying Our New Knowledge
So that’s a quick introduction to a number of different date and time functions. Let’s go through some examples of how
we can use these in projects or potential work scenarios. 

Using the TODAY Function

The first example uses the TODAY function. Let's say that you have a report that has a number of days in it. Let’s just
say for this month, we start on the first of the month. Use the following steps:

1. Select an empty cell, and type 8/1.
2. Press Enter.

a. Excel will enter 1-Aug into the cell.
3. In the next cell down, type =.
4. Select 1-Aug.
5. Add +1.
�. Press Enter.
7. Click and drag the little box in the bottom-right corner of the cell to make a list that goes down to 15-Aug.

Highlighting Numbers for a Specific Date

Next, let’s try highlighting a specific date. For this example, we’ll use a sales report and forecast using a random number
between 100 and 1000.
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1. Enter the word Sales in cell IA.
2. In cell I2, next to the first date, type =RANDBETWEEN(100,1000).
3. Select the corner of the formulated cell and drag it down to be even with the last date in the column to the left.

We’d like to specifically highlight the day that we’re currently on (August 6) so we can get the actual number of sales; all
days listed after our current date will be considered forecasted numbers. It’ll be easier to differentiate from the actual
number of sales and forecasted number of sales if we highlight the number for the current date.

1. Select the range I2 through I16.
2. Select Conditional Formatting.
3. Select New Rule.
4. Select the option Use a Formula to Determine Which Cells to Format.

a. In the Edit the Rule Description text box, type =$H2=today()-1. (See Figure 31.19)
5. Select Format and choose a fill color.
�. Select Okay.

Figure 31.19

 

You should see that yesterday (August 5), would be the last day there are actual numbers for. This is just one example
of how you can use the TODAY formula. (See Figure 31.20)

257



Figure 31.20

 
Setting a Repeated Schedule

Let’s look at options on how to set up schedules using the TODAY formula.

For this example, we’ll assume that some sort of analysis needs to be completed on a certain day of every month. Let’s
say it’s the 15th. We’ll start by using the date function.

1. Select cell K2 and enter =DATE(YEAR(today()),MONTH(today()),15.
2. Select cell K3 and enter =EDATE(K2,1).
3. Select the corner of cell K3 drag it down to K16.

You’ll notice that the day shows the 15th of each of the months into the future. If you wanted to know what day of the
week it will be, change the format to include the spelled out day of the week.

1. Select the range of cells K2 through K16.
2. Open Format Cells.
3. Select Custom.
4. In the Type text box, type dddd and a space before the month. (See Figure 31.21)
5. Select Okay.
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Figure 31.21

 
You may need to extend the K column to see all of the information in the row. Now you should see the day of the week
the 15th will land on in the following months.

Using EOMONTH

The EOMONTH function is helpful if you have a dashboard you need to reference. Let’s say you have a starting day of
August 1 and you want to know what day is the end of the month; instead of figuring out how many days each month
has, you can have a formula figure it out for you:

1. Select cell F19.
2. Type 8/1
3. Select cell G19.
4. Type =EOMONTH(F19,0)

a. The cell F19 indicates the first of the month and the 0 indicates the end of the month.
5. Select F19, then select the Format Paint tool.
�. With the Format Paint tool still selected, select G19 to correctly format the date.
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Figure 31.22

 
You should now be able to see the first and last dates of the month (see Figure 31.22); you can put the next month into
the first of the month cell and it will automatically update the last date of the month accordingly. This is helpful in
SUMIF or COUNTIF formulas if you ever need to sum up a range of sales information, quantity, or orders received
throughout a course of given dates.

Using WORKDAY.INTL with Holidays

A particularly helpful function is the WORKDAY.INTL function. If you’re in project management, this function helps you
know what day a project will be completed. It can calculate the workdays and factor in holidays. Complete the following
to formulate how long it will take to complete projects within 10 days, 20 days, 50 days, 100 days, and 200 days when
factoring in weekends and holidays. First, let’s anchor in the holidays.
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1. Indicate the project dates.
a. In cell C22, type 10.
b. In cell C23, type 20.
c. In cell C24, type 50.
d. In cell C25, type 100.
e. In cell C26, type 200.

2. In cell D22, next to the number 10, enter the following formula:
a. =WORKDAY.INTL(today(),C22,1,$C$19:$C$20). Hit Enter.
b. The anchored cells will be where we will put information about the holidays.

3. Select cell B19 and type New Years. Enter the following formula into C19:
a. =DATE(YEAR(today())+1,1,1). Hit Enter.

4. Select [##] cell and type in Christmas. Enter the following formula into C20:
a. =DATE(YEAR(today()),12,25). Hit Enter.

5. Select C16, and then select Format Painter.
�. Select D22 to format paint the cell to show as a date.
7. Select the corner of cell D22 and drag it down to cell D26.

Figure 31.23

 
Now you should be able to find the date of completion for a project that is 10, 20, 50, 100, and 200 days out. (See Figure
31.23)

Again, please remember that Excel references dates as numbers, so you have to be sure that your number formatting is
up to date every time.
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/date_and_time.
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Conditional Formatting 1

In Excel, we can use conditional formatting to change the format of a cell-based on its value. We’ll use conditional
formatting in this chapter to highlight important cells in a list of 25 or so different parts. (See Figure 21.1)

Practice Spreadsheet

Use this workbook for the chapter.

In the spreadsheet, we have price, lead time, order quantity, and part classification. Let’s suppose that these parts are
being ordered from one of our vendors, and we want to keep our prices low, so we want to flag all of our parts that are
over $80. We can customize cell formatting if their value exceeds $80 by creating conditional rules.

Figure 21.1
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The Greater Than Rule
First, we’ll set up an input cell as a reference. Select two empty cells. Type Max price into the first, and $80 into the
second. Now we’ll use the cell with the price as a reference for formatting other cells with a value greater than its own.

1. Select the cell(s) to be formatted.
2. Press the Conditional Formatting button on the ribbon toolbar.
3. Select Highlight Cells Rules and then Greater Than… to open an options window. (See Figure 21.2)

Figure 21.2

 
4. Type or select the input cell with the max price value into the reference field.
5. Select the desired format to be applied.

a. For this example, we’ll leave it on the default Light Red Fill with Dark Red Text.
�. Press OK to finish formatting.

Note: If the wrong cell or group of cells is formatted, the formatting rule can be modified using the Conditional
Formatting Rule Manager.
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1. Press the Conditional Formatting button on the ribbon toolbar.
2. Select Manage Rules… (See Figure 21.3)

Figure 21.3

 
3. Use the Applies to field to modify the cells to be formatted. (See Figure 21.4)

a. Additionally, the rule can be edited by selecting the rule and pressing Edit Rule….

Figure 21.4
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The Less Than Rule
We’ll add another rule to format cells below a specific value. We’ll set up another input cell as a reference. Select two
empty cells. Type Min price (for minimum price) into the first, and $40 into the second. Then we’ll select the desired
cells to modify the formatting if their values are lower than the minimum price.

1. Select the cell(s) to be formatted.
2. Press the Conditional Formatting button on the ribbon toolbar.
3. Select Highlight Cells Rules and then Less Than… to open an options window. (See Figure 21.5)
4. Type or select the input cell with the minimum value into the reference field.
5. Select the desired format to be applied.

Figure 21.5

 

If we want to customize the formatting used for the rule instead of the default options, we would select the Custom
Format… option in the drop-down list. A menu window will open with four tabs: Number, Font, Border, and Fill. For this
example, we will choose to apply a green fill and a partial border format.

1. Select the Fill tab.
2. Select a preset light green.
3. Select the Border tab.
4. Select a preset dark green.

a. The border style may also be modified as desired.
5. Press the left edge button to apply the partial border. (See Figure 21.6)
�. Press OK to finish the custom format.
7. Press OK again to complete the conditional formatting rule.
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Figure 21.6

 

The Between Rule
Another rule we can add is to format cells with values between a specific range. For this example, we’ll need to set up
two input cells for the lowest and highest values in the range, and we’ll label them LT Bottom and LT Top respectively.
The LT Bottom will be 6, and LT Top will be 12.

Note: The LT abbreviation represents “Lead Time.”)

1. Select the cell(s) to be formatted.
2. Press the Conditional Formatting button on the ribbon toolbar.
3. Select Highlight Cells Rules and then Between… to open an options window. (See Figure 21.7)
4. Type or select the input cell for the lowest value into the first reference field.
5. Type or select the input cell for the highest value into the second reference field.
�. Select the desired format to be applied.
7. Press OK to finish formatting.
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Figure 21.7

 

Conditional Formatting Rules Manager
The Conditional Formatting Rules Manager lists all the rules applied to the selected cell(s). It can also show all rules in
the worksheet by selecting the Show formatting rules for drop-down list on the top of the window. Any conditional
formatting rule can be modified or deleted from the manager.

1. Press the Conditional Formatting button on the ribbon toolbar.
2. Select Manage Rules….
3. Press the Edit Rule… button to open an options window. (See Figure 21.8)

a. The new window will include four tabs: Number, Font, Border, and Fill. We can customize the format with
various options from these tabs. Multiple format options can be selected and combined as well.

If more than one conditional formatting rule can apply to the same cell(s), the manager displays the rules that are
applied in order from top to bottom; rules listed at the bottom are applied last and will override the previous rule
formatting. To prevent overriding previous formatting rules, the Stop if True checkbox on the right for the rule to be last.
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Figure 21.8

 

Data Bars and Icon Sets
The Data Bars and Icon Sets are also available to format cells based on their values. Data Bars may be used to view in-
cell charts for quick visualization of data comparison. (See Figure 21.9)
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Figure 21.9

 

Icon Sets can be useful to represent values at specific levels. For example, if we format an Order Quantity column to see
which items have sufficient quantities, items that are reaching low inventory, and items that fall under the desired
amount, we can select a basic icon set with green, yellow, and red icons. (See Figure 21.10)

Note: The rule may need to be modified to appropriately represent the desired effect.
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Figure 21.10

 

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/conditional_formatti.
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Standards of Professionalism

Spreadsheets can be used for many purposes. Oftentimes, other people will use or review your spreadsheet, so it’s
important that your work follows standards of professionalism.

In this chapter, we'll work on making a confusing spreadsheet into a professional one. In the spreadsheet (Figure 14.1),
we have textual notes, data tables, and a chart. However, there are many issues with it: the text and numbers are in
varying formats, the sections are uneven, and the chart axes are not clearly labeled.

Standards of Professionalism

Review this document about the Standards of Professionalism.

Practice Spreadsheet

Use this workbook for the chapter.
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Figure 14.1

First, the font style needs to be consistent across the spreadsheet.

1. Select the whole spreadsheet by pressing the arrow in the top-left corner above the first row's number.
2. Go to the Page Layout tab.
3. Press the Fonts button in the ribbon toolbar.
4. Select the desired font style (Arial). (See Figure 14.2)
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Figure 14.2

 
Borders and fill colors may also be removed while cells are rearranged.

1. Select the whole spreadsheet by pressing the arrow in the top-left corner above the first row's number.
2. Press the down arrow on the Borders button on the Home tab and select No border.
3. Press the down arrow on the Fill color button on the Home tab and select No Fill.

Data Input Table
The data input table needs to be formatted to clearly identify cells the user can modify, and it includes cells containing
values that depend on the user's input. The dependent cells need formulas referencing the user's input to prevent
manual data input for all cells each time. First, we will format the data values as currency and percentage respectively.

1. Select the cells containing currency values in the From and To columns.
2. Select the Number Format drop-down list from the Home tab and select Currency.
3. Press the Increase Decimal or Decrease Decimal buttons if needed to adjust the decimal places to show two digits

after the decimal.
4. Select the cells containing percentage values in the % (percent) column.
5. Select the Number Format drop-down list from the Home tab and select Percentage.
�. Press the Increase Decimal or Decrease Decimal buttons to adjust the decimal places to show one digit after the

decimal.
7. Select all cells (including the From, To, and % headers).
�. Press the Align Right button on the Home tab to align cells according to standards of professionalism.
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Figure 14.3

 

Format Input Data
The Annual Sales and Combined Comission cells should be formatted with a fill color to signify user input. Excel
provides a convenient preset input format for this situation.

1. Select the cells intended for input in the Annual Sales and Combined Comission columns.
2. Select the preset Input format from the list of styles on the Home tab of the ribbon toolbar.

Next, the dependent cells need to be rewritten with formulas based on the input cells. In this case, the values under the
Annual Sales's To column are one less than the From input value on the next row. We want the To column's cells to
reference the input on the next row and subtract one.

1. Select the first cell and type an equal sign ( = ) to begin a formula.
2. Select the cell to the left on the next row.
3. Type a hyphen ( - ) for subtraction and a 1.
4. Press Enter to complete the formula (=B9-1). (See Figure 14.4)
5. Select the completed cell and double click the small square in the bottom-right corner to duplicate the formula

down the table's remaining cells in the column.

276



Figure 14.4

 
The Combined Comission dependent cells will need a formula to calculate the input percentage of the Annual Sales
values. To do it, the formula multiplies the associated Annual Sales' From or To cell by the percentage input on the
same row.

1. Select the first cell in the table under From and type an equal sign ( = ) to begin a formula.
2. Select the related From cell in the Annual Sales table.
3. Type an asterisk for multiplication.
4. Select the percentage input cell.
5. Press the F4 key three times to anchor the designated column but not the row.
�. Press Enter to complete the formula (=B8*$D8). (See Figure 14.5)
7. Select the completed cell and press the small square in the bottom-right corner and drag it across the other

relevant From and To cells to copy the formula.
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Figure 14.5

 

Format Headings
A space can be added between the tables for better readability. The headings may also need formatting to clearly label
the tables for other users. In this case, a light fill color can be added to the heading and neighboring cells equal to the
table's width. The revised data input table should look like Figure 14.6.

Note: The heading cells do not need to be merged but should be aligned left and text wrapping removed for
professionalism.

Figure 14.6
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Explanatory Text
The spreadsheet also contains some text that appears to provide information related to the data. In Figure 14.7, we can
see commission and schedule are spelled wrong, numbers are interchangeably spelled out and in numeral form, and
some words are abbreviated. For the standards of professionalism, be sure words are spelled correctly, punctuation is
used appropriately, and style is consistent.

Figure 14.7

 
The first and second items in the list appear to describe the goal of the spreadsheet, so they could be consolidated to a
single line and relocated underneath the spreadsheet's title. Additionally, we may want to present the information in a
text box with a bulleted list instead of individual cells.

 

Text Boxes
A text box can be placed on top of the spreadsheet cells, and it can be resized and moved around freely.

1. Go to the Insert tab on the ribbon toolbar.
2. Press the Shapes button.
3. Select the Rectangle.
4. Move the cursor to an empty space of the spreadsheet, press the left mouse button and drag the cursor until the

shape's desired size is achieved.
5. Type or paste the textual content into the box.
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Figure 14.8

 
The fill and font colors will need to be adjusted to have a white background, dark-gray/black text, and an optional dark-
gray border; dark gray is an effective softer option to help it blend in. Extra spacing can be added between bulleted
items for better readability. We may even add a "Notes" header to identify the content in the box. The result should look
like Figure 14.9.

Figure 14.9

 

Data Chart Presentation
The data chart references a separate table for its data. The table is recommended to be located on a separate
spreadsheet because it is a background function not relevant to the dashboard.

The chart's data table contains sales, percentages, and commissions numbers. The sales numbers show a steady
increment, but we want it to use a formula to automatically update the increment range from a single cell. We will need
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a new input cell denoted as Increment, and formatted as currency.

Formatting Reference Data
Next, the Sales column values need to use a formula referencing the Increment cell and adding its value.

Note: The first cell in the table must begin with a zero and not a formula.

1. Select the second cell in the Sales column.
2. Type an equals sign ( = ).
3. Select the cell above (the first cell containing a value of zero).
4. Type a plus sign ( + ).
5. Select the Increment input cell.
�. Press Enter to complete the formula.
7. Select the completed cell again and double-click the small square in the bottom-right corner of the cell to duplicate

the formula down the table's remaining Sales column cells.

Figure 14.10

 
The Percent column can use the VLOOKUP function; this function will be taught in more detail in a later chapter. The
VLOOKUP function will reference a specific array (or selection) of cells in the previous input data table. Then, it will
identify a specific value from the previous table based on the Sales column value and copy the correlating percentage.
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1. Replace the first cell in the Percent column by typing an equals sign ( = ).
2. Type VLOOKUP and a left parenthesis ( ( ).
3. Select the cell in the Sales column on the left.
4. Type a comma ( , ).
5. Select the Annual Sales' From and To cells, and the Combined Commission's percent range of cells. (See Figure

14.11)

Figure 14.11

 
�. Type a comma ( , ).
7. Type a four ( 4 ) to indicate the column from the array that a value will be sourced.
�. Type a comma ( , ).
9. Type TRUE to find the closest value.

10. Type a right parenthesis ( ) ) and press Enter to complete the formula.
11. Select the completed cell again and double-click the small square in the bottom-right corner to copy the cell down

the table's remaining cells in the column.

Figure 14.12

282



 
Lastly, the Commissions column needs a formula to multiply the Sales value by the percentage.

1. Replace the first cell in the Commissions column by typing an equals sign ( = ).
2. Select the Sales cell on the left in the same row.
3. Type an asterisk ( * ).
4. Select the Percent cell on the left in the same row.
5. Press Enter to complete the formula.
�. Reselect the completed cell and double-click the small square in the bottom-right corner to copy the formula down

the table's remaining cells in the column.

Note: The cells in this table will need to be formatted similarly to the data input table with currency and percent formats.

Notice the chart's data table includes numbers above the previous data input table's $2,000. To make the table and the
chart more effective, we may use an increment of $250 in the increment input cell. The excess data beyond $2,000 can
be deleted and the chart's references updated to the shorter table. Additionally, we can reduce the number of decimal
places to show none and simplify the chart.

Chart Design
Now the chart itself needs a small update. In particular, the axes need clear labels.

1. Select the chart.
2. Go to the Chart Design tab.
3. Press the Add Chart Element button and select Axis Titles.
4. Select Primary Horizontal.
5. Repeat step 2 and step 3 to add Primary Vertical.

The horizontal (bottom) axis needs to be labeled as Sales, and the vertical (left side) axis needs to be labeled
Commissions. The chart's border and title need to be removed because we'll add a heading in the spreadsheet's cells
and format it similar to the data input table headings; the chart's heading will read Potential commissions by sales
bracket. (See Figure 14.13)
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Figure 14.13

 

Highlighting Data Gaps
The chart's purpose could be to identify gaps or leaps in increase. To present the data effectively, we might want to
direct attention to the gaps and add an explanatory note. First, the data line should be replaced with marker points to
show individual data placement.
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1. Select the data line.
2. Go to the Format tab.
3. Press the Format Selection button on the left side of the toolbar to open the Format Data Series side menu.
4. Select the Marker button on the side menu's Fill & Line tab. (See Figure 14.14)

Figure 14.14

 
5. Select Built-in and choose a circular marker type.
�. Format the marker for professionalism and readability as needed.
7. Select the Line button and choose No line.

Then, brackets can be added to emphasize the gap and a text box can be added to briefly explain the increase.

1. Go to the Insert tab.
2. Press the Shapes button and select a brace style shape from the Basic Shapes category.
3. Draw the brace by pressing the mouse button at the starting point and dragging the cursor to the desired size.
4. Use the rotate button on the selected brace to rotate the shape.
5. Move the brace near the data gap to emphasize it.
�. Press the Shapes button and select a text box from the Basic Shapes category.
7. Draw the box by pressing the mouse button at the starting point and dragging the cursor to the desired size.
�. Type the data explanation into the box.
9. Move the text box near the previously drawn brace and resize the box if needed.

10. Go to the Shape Format tab on the toolbar.
11. Press the Shape Fill button and select No Fill.
12. Press the Shape Outline button and select No Outline.
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Figure 14.15

 

Professional Summary
Hide Columns
Extra columns and rows can be hidden to improve a dashboard's design.

1. Select the first column that needs to be hidden.
2. Press Ctrl + Shift + Right arrow keys to select all columns to the end of the spreadsheet.
3. Right-click a selected column's label designation and select Hide.

a. Alternatively, press the Format button on the toolbar's Home tab and select Hide & Unhide, then Hide Columns.
4. Repeat step 1, step 2, and step 3 for rows.

It takes deliberate thought to layout a dashboard in a way that makes sense. All of the standards of professionalism
practices in this chapter can be used in other worksheets to make them legible and usable. As you design your own
dashboards and worksheets, you should design with the intent to make it easy to read and understand. The final result
might look like Figure 14.16 below.
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Figure 14.16

 

Print Layout Setup
Finally, the new dashboard may need to be printed out for handing out to others for review.

1. Select the relevant area of the dashboard to be printed.
2. Go to the Page Layout tab.
3. Press the Print Area button and select Set Print Area.
4. Select the Width and Height scales on the toolbar to one page.
5. Press the Orientation button and select Landscape if needed.

The dashboard will be ready to print.
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Figure 14.17

 

Supplemental Resource

When completed, your practice worksheet should look like the following:

Figure 14.18
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/standards_of_profess.
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Spreadsheet Formatting and Design

In this chapter, we’re going to be talking about spreadsheet formatting and design. We will primarily focus on the Home
tab around the font, alignment, and number sections. 

Practice Spreadsheet

Use this workbook for the chapter.

Heading
When we use Excel, we have a responsibility to make sure that whatever we create is easy for the user or the intended
audience to read. One of the ways we do that is by using consistent design in terms of font, alignment, number, and
sometimes even the Style boxes on the toolbar. (See Figure 16.1)

Figure 16.1

Before we dig into the specifics of font and alignment on this tab, we will introduce you to the Page Layout tab and the
Office Theme section. (See Figure 16.2)

Figure 16.2

 
This section allows you to understand what colors you might want to use, and you can customize them. You can
choose your fonts, and you can change how the page is set up to print. To change the font, use the following steps:
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1. Select the Page Layout tab. 
2. Select Fonts. 

a. This will bring up a drop-down menu.
3. Select the desired font. For this exercise, select Arial. (See Figure 16.3)

Figure 16.3

 

Should you ever need to print an Excel file, you can find print options on the Page Layout tab.

Back on the Home tab, the first section has to do with font. (See Figure 16.1)

After we had changed the font in the directions above, all of the text in the worksheet should be the same font and the
same size. In this case, it should be an 11 point font. The first thing you may notice is that the rows are compressed. To
change the height of the rows, use the following steps:
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1. Select the blank top-left corner, where the first row and the first column meet, to select all of the rows and columns
in the worksheet. (See Figure 16.4)

Figure 16.4

 

2. Right-click on the selected rows.
a. An options bar will appear.

3. Select Row Height. (See Figure 16.5)
4. Insert the desired height. For this exercise, type 20.
5. Select OK.

293



Figure 16.5

 
Across the top of the table, you can see that there are headers for each set of data. You can use some of the effects in
the font section of the Home tab to bold, italicize, or underline the headers for easier identification. You should only use
one of the formats at a time; it isn’t correct to format text to be bolded, italicized, and underlined. In this exercise, use
the bold effect to denote it’s a header row. (See Figure 16.6)
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Figure 16.6

 
You can also choose to double underline things in addition to single underline. To do this, use the following steps:

1. Highlight what you want to double underline. 
2. Select the dropdown menu on the underline option. 
3. Select Double Underline. (See Figure 16.7)
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Figure 16.7

 

Font Size
The next thing we’ll look at is font size. In addition to being able to change to a different font typeface, we can also
change the size. We can pick a specific size, or we can use the Up and Down arrows to automatically move up and
down between sizes. (See Figure 16.8)
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Figure 16.8

 
If something is bold already, it doesn't also need to be bold and larger. However, if we wanted to choose just a larger
font size, we could remove the bold and increase the font size of our header so that it stands out from the rest of the
data. For this exercise, however, keep the header bold, and leave it the regular font size.

Fill Color and Text Color
Excel helps you format your sheet by filling the background color of a cell. To do this, use the following steps:
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1. Select the cells you would like to fill with color. 
2. Select the Theme Colors icon. (See Figure 16.9)
3. Select which color you would like to fill the cell with.

Figure 16.9

 

To change the text color in cells, use the following steps:

1. Select the text that you want to change.
2. Select the font colors icon. (See Figure 16.10)
3. Select the color you want to change the text to.

Figure 16.10

 
Ensure the background and the foreground color are contrasted so that you can read what is in each cell. If you select
the pop-out menu in the bottom right of the Font section, Excel takes you to the Format Cells font section. (See Figure
16.11) 

This allows you to add additional effects like strikethrough, superscript, and subscript. 
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Figure 16.11

 

Alignment
When you made the row height taller, you may have noticed that all of the cells, by default, are aligned to be at the
bottom of the cell vertically. You can align to the top, the middle, or the bottom. (See Figure 16.12)
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Figure 16.12

 
For ease of reading, aligning to the middle is the most comfortable for most cases. 

We can also change the alignment horizontally. (See Figure 16.13)

Figure 16.13

 
Excel recognizes when a value is text, and it automatically left-aligns it. If the value is a number, Excel automatically
right-aligns it. Ensure numbers are right-aligned so that the units line up with each other. There will be more discussion
about this in the number section. Left-align the dates using the following steps:

1. Select the cells with dates in them.
2.  Select the Left-Align icon. (See Figure 16.14)

a. Excel will left-align the values in the selected cells.
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Figure 16.14

 
To right-align the numbers, use the following steps:

1. Select the numbers you want to right-align. 
2. Select the Right-Align icon. (See Figure 16.15)

a. Excel will right-align the values in the selected cells.
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Figure 16.15

 
Another formatting option is to change the angle of the text. For example, if you wanted to angle things upwards and
make the row a little bit taller, this could save some space if you have narrow amounts of data and long headers. It isn’t
something that’s used very frequently. To angle text, use the following steps:

1. Select the cells containing the text you want to angle.
2. Select the Angle Text icon. 
3. Select Angle Clockwise. (See Figure 16.16)

a. Excel will angle the text clockwise.
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Figure 16.16

 

Merging Cells
You can also insert a new row on the top, make a title for the table, and make it span across all four of the columns on
the table. To do this, use the following steps:
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1. Select the cells you want the title to span across. 
2. Select the Merge & Center dropdown menu. 
3. Select Merge & Center. (See Figure 16.17)

a. Excel will join those cells and center the header.
b. Just selecting Merge Across will merge the cells, but it won’t center the data.

Figure 16.17

 
Merging cells can cause issues when it comes to using formulas, copying and pasting, and a number of other things.
One of the best things you can do is select the pop-out arrow in the bottom-left corner of the Alignment section of the
toolbar. (See Figure 16.18)

304



Figure 16.18

 

Once in the dialog box that pops up, use the following steps:

1. Under Horizontal, select Center Across Selection. (See Figure 16.19)
2. Select OK.

a. Excel will center the heading across all four cells, but they remain four distinct cells.
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Figure 16.19

 
When you copy and paste with this formatting feature active, you won’t run into any errors.

Another thing you might notice is that the headers are a bit longer than the available space in the cells. When trying to
maintain a consistent column width for this exercise, you may notice that the headings “Market Share” and “Number of
Employees” do not fit. You could widen the cells to fit the headings, but then you may have a lot of wasted space on the
sheet. Instead, you can choose a reasonable column width and use the following steps to wrap the text:

1. Select the cells that have longer titles.
2. Select Wrap Text. (See Figure 16.20)

a. This allows the text to wrap around onto a second line.
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Figure 16.20

 
You may need to accommodate it with a slightly taller row, but it will allow the text to line up. The challenge we run into,
though, is that not all of the tops will align. In this case, it might be best to align them all with the top so you can read
them clearly.

Number Formatting
When it comes to number formatting, consistency is important. There are some pre-built formats in Excel, including
dates. To format dates as a Long Date, use the following steps:
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1. Select a cell containing a date.
a. The dropdown menu in the Numbers section of the toolbar will now say Date instead of General.

2. Select the dropdown menu in Numbers.
3. Select Long Date. (See Figure 16.21)

a. Excel will write out the entire day of the week, month, date, and year.

 Figure 16.21

 

If you want to change any of these, you can select the whole range and choose one of the pre-existing formats seen in
Figure 21. To use the Format Cells box, use the following steps:

1. Select the range of cells you want to format.
2. Press Control + 1 (PC) or Command + 1 (Mac).

a. This will open up the Format Cells box.
3. Select the Number tab. 
4. Select Custom.

a. This allows you to use special letters and symbols to make a customized format.
5. Type ddd, dd mmm yyyy under Type. 

a. The first three d’s will give an abbreviation of weekday.
i. Adding a fourth will give you the whole day.

b. The three m’s indicate the month.
c. Four y’s indicate the whole year.

�. Select OK. (See Figure 16.22)
a. Excel will change the dates using the custom format. 
b. The dropdown menu in the number section will say Custom when any of these formatted cells are selected.
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Figure 16.22

 
The data in the Revenue column represents dollars. There are typically two types of dollar formats. The first is the
accounting number format in the number section. (See Figure 16.23)

Figure 16.23

 
The second is the Currency number format. (See Figure 16.24)
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Figure 16.24

 
Sometimes, you have to choose to decrease the number of decimal points using the Decrease Decimals button. (See
Figure 16.25)
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Figure 16.25

 
The data in the Market Share column is represented as a percentage. To format a set of data as a percent, use the
following steps:
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1. Select the data you want to turn into a percentage.
2. Select the percentage button. (See Figure 16.26)

a. This will turn decimals into percentages.

Figure 16.26

 
3. For this exercise, use the Increase Decimals button to increase the percentage of decimal points by one. (See

Figure 16.27)
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Figure 16.27

 
The data under Employees is a traditional number, but when you format it using the Number preset, they will have
unneeded decimal points that need to be taken out. If you select the comma style shown in Figure 16.28 to add
commas, it formats the number back to Accounting.
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Figure 16.28

 
To include the comma without it changing it to the Accounting format, use the following steps:

1. Select the pop-out icon in the bottom-right corner of the Number section. 
a. This will bring up the Format Cells dialog box.

2. Select the Number tab. 
3. Make sure the Use 1000 Separator ( , ) box is checked.
4. Set Decimal Places to 0. (See Figure 16.29)
5. Select OK. 

a. Excel will now include the numbers correctly, with a comma and no decimals.
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Figure 16.29

 
There are all sorts of things that you can do with Number Formatting. For example, if you have a negative number, you
can determine how that number is displayed. Let’s say that one of the percentages in the data is negative. You can
make negative numbers show up in parentheses and in different colors. To do this, use the following steps:

1. Select the cell that you want to change the format in.
2. Use Control + 1 (PC) or Command + 1 (Mac) to get into the Format Cells dialog box.
3. Select the Custom tab. 
4. Type ;[red](0.0%) after the original 0.0%. (See Figure 16.30)

a. The semicolon lets Exel know that what comes after it is how you want the number to display if it’s negative.
5. Select OK.

a. The negative number will show up in parentheses, and it will be red.
b. You may choose other colors, like blue or green, using this format as well.
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Figure 16.30

 

More Professional Designs
There are several ways to make this table we are working on look more professional. The Page Layout tab lets you see
the print area. 

The View tab lets you uncheck the Gridline so that you don’t see any of the gridlines in the worksheet. However, you may
still want to see the gridlines that should be in the table. 

To use borders to make those gridlines reappear in the table, use the following steps:
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1. Select the entire table.
2. Select the Home tab. 
3. Select the Borders dropdown menu. 

a. This has all sorts of different border options.
4. Select More Borders. (See Figure 16.31)

a. This will take you to the Format Cells dialog box.

Figure 16.31

 
5. Select the Color dropdown menu and select gray.
�. Select Outline and inside horizontal. (See Figure 16.32)
7. Select OK.

a. The table will be formatted with a border and horizontal lines separating the data.
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Figure 16.32

 
You can also change the thickness of the borders, which can be used to make the outside border thicker than the
horizontal lines on the inside. When you put vertical bonders into the table, you can adjust the width of each column to
help the data fit. Wrap the text on the titles so it all fits together. Make the title of the table larger and adjust the width
accordingly to help it stand out better. Add 1960–1979 to the title of the table. Because the fill color and text color of
the column titles are shades of red, the text doesn’t stand out very well. To fix this issue, change the fill color to a lighter
gray and the text color to black.

Cell Styles
These are just some of the formatting options that you can use in Excel. Much of this can be customized even further
using Cell Styles on the right-hand side of the toolbar. (See Figure 16.33)

Figure 16.33

These Cell Styles allow you to quickly replicate or duplicate the same type of formatting across the workbook.

For example, if you want all of your headers to look the same, use the following steps:
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1. Select the title of the table.
2. Select the Cell Styles dropdown menu. (See Figure 16.33)
3. Select the Heading 1 option.

a. Excel will overwrite any existing formatting to use the Heading 1 Formatting. 
4. Select the column titles.
5. Select Heading 2. (See Figure 16.34)

a. Excel will overwrite any existing formatting, and the result will be the same style and font as the title, but with
smaller font size.

Figure 16.34

 
You may not like all of the styles, but there are some presets in the Cell Styles menu that can help save you time as
you’re seeking to format your data and make it look good.

You may notice that in the Dates column, the dates are all different widths because of the font. Arial is a variable-width
font. This means that if there is an I instead of an F, it takes up less width. To fix this, you can use a fixed-width or mono-
width font. Courier New is a fixed-width font. Using Courier New formats the dates to line up perfectly. This helps the
content read more easily because the units will always line up: the ones, tens, hundreds, thousands, millions, and so on

The More Borders option provides a way to strikethrough in the middle. To do this, use the following steps:
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1. Select the cell you want to have a strikethrough in.
2. Select the Borders dropdown menu.
3. Select More Borders. (See Figure 16.31)

a. This will take you to the Format Cells dialog box.
4. Select both of the diagonal inside borders. (See Figure 16.35)

Figure 16.35

 
5. Select OK.

a. Excel will put an X through the data in that cell. (See Figure 16.36)
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Figure 16.36

 

Format Painter
Another thing that is important to note is the Format Painter option. 

Let’s say that you really like the format in the strikethrough cell, but you don’t want to go through the menu to get it
again. To reproduce a format in another cell quickly, use the following steps:

1. Select the cell with the format you want to reproduce. 
2. Select the Format Painter button. (See Figure 16.37)
3. Select another cell.

a. Excel will copy the formatting and reproduce it in that second cell.
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Figure 16.37

 
In the Standards of Professionalism chapter, we talked about alignment and how things should look. Review the chapter
for information on text alignment and formatting. To some extent, formatting is a matter of personal preference, but you
should always make sure that it’s clear to the user what it is that they’re looking at.

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/spreadsheet_formatti.
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Basic Charts

 In this chapter, we are going to learn how to create charts in Excel.

Practice Spreadsheet

Use this workbook for the chapter.

Creating a Chart from Data
We have a spreadsheet that shows a list of different salespeople in a company, their age in column C, and then the
amount of sales that each one generated for each year for the past 10 years. Let’s suppose that we wanted to create a
simple chart that shows the individual’s name and how old they are.  
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1. Select both columns of data for Sales Person and Age.
a. We generally want to include the header rows because that will give us more information that we’ll feed into

the graph.  
2. Go to the Insert tab on the ribbon and find the options for charts in the middle.

a. There are a lot of different chart types. Excel tries to recommend charts based on the data you provide. 
b. As you hover over the options, Excel will give you a preview of what your information would look like in that

chart.
c. In general, you should never use a 3-D chart, unless you are showcasing a third dimension of data.

3. Choose the clustered bar chart. (See Figure 15.1)
a. It will automatically create a title based on the information you provided.
b. Generally, we’re going to want to make sure that the title is a very clear description of what the graph is

showing. Age is too vague, so what we’d probably want to do is change it to something else.

Figure 15.1

 
4. Select the title and type in the new one: Employee Age.
5. Add axis titles by selecting Add Chart Element on the left of the Chart Designs tab. (See Figure 15.2)
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a. The Primary Horizontal will adjust the axis title at the bottom of the chart. Type Age in Years.
b. The Primary Vertical will adjust the axis title to the left of the chart. The name should be Salesperson Name.

Figure 15.2

 
�. Once created, you can use your cursor to move the graph anywhere you’d like.

a. You can also copy a chart by pressing Control+C or right-clicking and choosing the Copy option.
b. Then, go into another area and paste the chart by pressing Control+V or right-clicking and choosing the Paste

option.

Editing the Chart
If we change anything in the base data, the charts will update. For example, if we go to the Salesperson column and
change Alice to Anne, notice that both charts update accordingly. Sometimes, if you have multiple charts on a single
sheet, you may want to make sure they’re aligned.

1. Select both charts by holding down the Shift Key or Control Key.
2. Go to Shape Format on the ribbon, choose Align on the far right, and align them to the bottom of each other.

In addition to duplicating charts, we can move a copy into a new sheet. 

1. Cut the duplicated sheet using Control+X or right-clicking and selecting Cut.
2. Create a new sheet and paste the chart into that sheet. 

a. Whenever data is updated in the original worksheet, the chart on the new sheet updates and reflects those
changes.

b. You can even get rid of the original chart and the copied chart on the new sheet remains.

Total Sales History
Now let’s suppose that we wanted to create a different kind of graph. In this case, we want to know the total sales
history for the last ten years for each salesperson.  
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1. In the column adjacent to the final column of data, label it Total Sales.
2. Calculate the Total Sales for Ann by entering the equals sum formula and selecting all the sales history for her. (See

Figure 15.3)

Figure 15.3

3. Copy this formula down for the rest of the salespeople.
a. An error reading Formula Omits Adjacent Cells may appear. In this case, we know that we didn’t want to

include the Age column in our calculations, so we can choose to ignore the error.
b. You may need to make the column a little wider to accommodate the larger number.

4. Just like in the first chart, we need to select both columns. Because the two columns are not adjacent, you can
select both of them by selecting the first, Salesperson, and while holding down the Control Key, select the second
column, Total Sales.

5. Go to the Insert tab, and select a chart. In this case, let’s say we want to use a line chart.
a. It will give you a few different options. Select the one with markers.
b. This may seem like a good chart to choose from, but it is not good for representing this data. In this chart, the

salespeople are not sequential. If the chart showed sales over time for a single salesperson, a line chart might
make sense. But comparing salespeople against each other is not effective with this type of chart, because it
almost looks as if they’re related to each other based on the line.

�. Go up to the Change Chart Type option and select the Clustered Column chart.
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a. The human eye is actually much better at being able to tell the differences between sizes in bars of data than
dots just plotted on a chart or even circles, like pie charts.

b. We can see very quickly that Bill is at the top of sales. (See Figure 15.4)

Figure 15.4

 
7. Add a horizontal title and vertical title by adding axis titles in the Chart Design tab.
�. The numbers on the left can get pretty large, so you will need to format them to be represented by smaller numbers

in the Axis Format option on the right.
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a. If you can’t find the Format Axis tab, you can find it by right-clicking on the chart. 
b. Change the display units to Millions.
c. Under the Number section, change the decimal places to 2. (See Figure 15.5)

Figure 15.5

 
9. Make the Millions label a bit smaller so that the eye is more drawn to the Total Sales label.

10. Rename the bottom label Salesperson Name.
11. The title of your chart should tell you what you will be getting out of it. In this case, we will title our chart Total Sales

for the Last 10 Years.

Sorting and Filtering Charts
Now, let’s say we’d like our information sorted from highest on the left to lowest on the right. To do this we don’t edit the
chart itself, but change the data behind the chart. Move the chart aside to begin.
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1. Select all of the data.
2. On the right of the Home tab, select Sort and Filter.

a. The shortcut for this is Control+Shift+L.
3. Under the Filter button, choose to sort from largest to smallest.

a. This will automatically update the chart.
4. To move the chart to a different sheet go to the Chart Design tab and choose Move Chart.

a. This will give you the option to move the chart to an existing sheet or create a new sheet. (See Figure 15.6)

Figure 15.6

 
5. Use this tool to create a new sheet, and title it Last 10 Years.

a. When you select OK, it creates a new type of sheet, a sheet that only contains a chart. There is no other data,
columns, rows, or cells, whereas the chart on Sheet2 is embedded in the cells.

b. Note that the chart on Sheet2 has been updated with the filter applied to the data, reordered not based upon
age, but on sales. In this case, Bill, who has the highest sales, is at the bottom of the graph.

�. Let’s say we want to reverse this. In order to do that, open up Format Axis again and check the Categories in
Reverse Order box. (See Figure 15.7)

331



a. This will display the categories in reverse order without having to change the base data. That may not be
something that you want to do, but it is an option that is available to you.

b. Go back to the main sheet of data, Sheet1, and remove the filter by pressing Control+Shift+L.

Figure 15.7

 

Line Charts
Let’s now take a look at the top four salespeople and what their sales were for the full ten-year period. 
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1. Select the first four salespeople. Hold down the Control key and select their first ten years of sales as well. Be sure
to not include their age in the selection.

2. Go to the Insert tab, find the line chart options, and insert the first option, a line chart. (See Figure 15.8)
a. Each line is related over time and denotes a distinct salesperson.
b. This should help you quickly determine what the general shape of their sales looks like.

Figure 15.8

 
3. Move the legend to the top of the chart by right-clicking the legend and selecting Format Legend on the right. It will

give you options where to put it.
a. In English, we read left to right, top to bottom, so if you have any type of legend for your chart, it’s best to put it

at the top.
4. Add the chart title Top 4 Salespeople - Last 10 Years.
5. The x-axis is self-explanatory, so you do not need to add a label.
�. Add the vertical axis title Sales.

a. These axis titles can be moved by selecting and dragging.

Select Data
Once this chart has been created, Excel highlights what data is being used to display that chart. Excel has another way
to show you this data, and that’s in the Select Data dialogue box. (See Figure 15.9)
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Figure 15.9

 
The Select Data box shows you what the Legend Entries are, also called Series. In this chart, we have four series, one
for each salesperson. You also have the Horizontal, also known as Category, Axis Labels, which in our case is Years 1–
10.

If we wanted to change anything about these series, select the series you’d like to change and select Edit. You now have
the capability to change both the series name and the values that are displayed. 

To only include the first three series, do the following:

1. Select the fourth series (Kent).
2. Select Remove.

a. When you select OK, you will see that Kent’s series has been removed from the chart.
3. To add it back, expand the highlighted range to include Kent again.

To skip some lines and include Frank at the very bottom, do the following:
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1. Choose Select Data.
2. Select Add.
3. Select the series Frank.
4. The series values are his years 1–10. 

a. You may have to move the chart in order to select this data.
5. When you select OK, you will see that Frank has been added to the chart.

a. Notice that in the Select Data box, on the Category Axis Labels for Frank, instead of Years 1–10, it only says 1–
10.

b. You can manually edit that by selecting the title bar, Years 1–10, from the original data to make that the label
for Frank as well.

To label the sales with an actual year instead of Years 1–10, do the following:
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1. Create a new row at the bottom labeled Year, and in the column for Year 1, type 2000. 
a. Notice how it automatically formats with a dollar sign.

2. Remove 2000 and type 12/31/2000.
a. Notice how it still gives you a monetary value.

3. Press Control+1 to open up the format menu, and change it from Currency to Custom.
a. In this case, we just want it to show the year, so in the Type section, enter YYYY and press Enter. (See Figure

15.10)

Figure 15.10

 
4. To have the years show up consecutively, select the cell to the right and use the =DATE formula.

a. For the year, reference the first cell (2000), and then add +1. The month will always be 12, and the day will
always be 31. 

5. Copy the format from 2000 to the new year so it doesn’t show up as currency, and drag it across for the rest of the
years.

a. They should fill up all the way to 2009.
�. To change the Category Axis Labels from years 1–10 to the actual years, open up the Select Data option again. 
7. In the Category Axis Labels section, select Edit and press OK.

a. The chart will automatically update.
�. Add an Axis Title to the bottom called Calendar Year.

a. Move this to the left.
b. This chart is now finished.

9. Move the chart to a new sheet and call it Top Four Salespeople.
10. Rename Sheet2 to Ages.
11. Rename Sheet1 to Data.
12. On the Data Sheet, select the Year row at the bottom and add a fill color to distinguish it from the rest of the data.
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Waterfall Chart
The waterfall chart is a newer feature in Excel. Waterfall Charts are meant to be cumulative displays of where you
started and where you ended. They are useful to show when something is adding or sometimes taking away from a
cumulative total. (See Figure 15.11)

Figure 15.11

 
Let’s investigate Frank at the bottom of the list.
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1. Select Frank’s ten years of sales.
2. Choose a waterfall chart.

a. You’ll see that it’s climbing up cumulatively over time.
3. Add in the total sales.

a. This will format automatically as an eleventh year, which is incorrect.
4. Right-click to select Format Data Series.
5. Select the column on the chart that represents Frank’s cumulative total, $558,909, and in the Format Data Point

option on the right, select Set as total. (See Figure 15.12)
a. Now, the waterfall chart should display each of the years, and then the total at the far right.
b. The number might appear a little cramped, so feel free to widen up the chart.

Figure 15.12

 
�. Use the Select Data tool to change the series name to Frank.
7. Change the category axis to the years 2000 to 2009.
�. Change the Chart Title to Frank’s 10 Year Sales Contribution.
9. Add a Primary Vertical axis and call it Sales.

10. Add a Primary Horizontal axis and call it Calendar Years.
11. Notice that it is duplicative to have both the sales increments and the sales labeled above the bars. To save space,

select the sales increments on the vertical axis, right-click, and choose Format Axis.
a. Open up the Number option.
b. Under Format Code, type a semicolon (;) and press Add.

i. This hides those increments on the side, and as a result, you can delete the horizontal bars.
12. Go to the Format Data Series Options, and uncheck Show Connector Lines.

a. This will get rid of the gray lines connecting the bars. (See Figure 15.13)
13. Move this chart to a new sheet called Waterfall and move that sheet to the end.
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Figure 15.13

 

Form and Usage
Earlier, it was mentioned that the human eye is not very good at determining the size of the pieces of a pie chart.
However, what if someone were to ask to look at the top four salespeople and their total sales in a pie chart
representing their total contributions? 
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1. Select the first four names of the top salespeople, along with their total sales. 
2. Insert a pie chart.

a. The donut chart is increasing in popularity because of the ability to put in another data point in the center
simply with a text box. 

b. Again, a three-dimensional option is a bad form because you’re not representing three dimensions of data. 
c. For this example, we will use a regular two-dimensional pie.

i. Notice that the human eye has a very tough time telling the difference between the sizes of the sections.
3. Use the Change Chart Type option to change the pie chart to a clustered bar chart.

a. It is recommended that whenever someone asks for a pie chart, you help them by recommending a different
chart that might represent their data a little better, which in this case, is the bar chart.

b. Now we can very easily see the differences between their contributions.
4. Open Format Axis for the vertical axis and choose to show the values in reverse order.

a. Note that this will format the sales numbers at the top.
5. For the horizontal axis, in Format Axis, go into the Labels section and change the label position to None.

a. You can get rid of the grey indicator bars and the legend
�. In the top right of the Chart Design tab, choose Add Chart Element and add Data Labels.

a. Ensure the data labels are in the inside base.
b. Make sure the text color inside the bar contrasts against the background.
c. Notice how much easier it is for your eye to compare the different contributions than it was for the pie chart.

For this reason, please avoid using pie charts.
7. Move this chart to a new sheet and call it Top 4 and move it to the end.

Scatter Plot
The last type of chart you will look at is the Scatter Plot chart. This allows you to compare two different data sets on
each axis. For example, let’s say you want to compare age and total sales to see if there were any correlation or
relationship between the two.
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1. Select the Age column, hold the Control Key, and select the Total Sales column. 
2. Insert a scatter chart, and choose the most basic one.

a. The challenge is that we don’t know which dot relates to which salesperson.
3. To add names to the dots, select the series and use the shortcut to the right of the chart to add chart elements.

(See Figure 15.14)
a. Select to add Data Labels.

Figure 15.14

 
4. As the data labels appear, select them and go to the Format Data Labels option on the side to choose what they

show. 
a. It gives you many options to choose from. In this case, choose Value From Cells, and select their names.
b. In the Format Data Labels option, you can also choose how you would like to position the labels. In this case,

position them to the left.
i. Change their font size so that they fit nicely in the chart.

5. Use the Chart Elements shortcut button to insert a Trendline. 
a. A trendline will show you what is the slope, or general direction, that you see.
b. In this case, you can see that there is a pretty positive relationship between how old you are, and the number of

total sales you brought in.
c. With that trendline, you can also choose to display the equation on the chart in the Trendline options.

i. This could help you basically predict, depending on a given age, what their total sales amount would be.
�. Move this chart by pressing Control+X, and then paste it (Control+V) onto the Ages sheet.

Sparklines and Other Features
For any of the charts, you can go online and use a search engine to find videos to learn how to use them. There are
many uses we won’t be covering. However, there are just a few more things we will be covering in this chapter.
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The first is sparklines. In the Insert tab, on the right side you will find a section called Sparklines. (See Figure 15.15)

Figure 15.15

 

1. Select the Line option.
2. A box will prompt you to select a data range. Select the ten years of data for the first employee, and select OK.

a. This will automatically generate a trendline to the right of the data that will give you a visual insight to the data.
3. Drag this new trendline cell down to see the trend for every salesperson.

a. Because they are lined up beside each other, you will be able to note which lines are trending up and which are
not trending in such a favorable manner

The next feature to learn are treemaps. Treemaps are generally meant to show what is the contribution relative to one
another. For example, each different box could represent a different category, and the relative size would represent how
much that category has brought in terms of sales or units. It will allow you to see that in a visual format. (See Figure
15.16)

Figure 15.16
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One of the other things Excel allows you to do when it comes to charts is to create maps. We will not be going into the
detail of maps in this class, but it is useful to note that this tool can be used to chart geographies. 

The final thing to note when it comes to charts is there are funnel charts, box-and-whisker charts, and radar charts. All
of these have a particular use case value in them. Your job as an analyst or someone that uses Excel is to determine
what is the appropriate visualization to use to get a particular message across.

In a box-and-whisker chart, you may want to show the variability of a given data point over time. In a radar chart, you
may want to show how five different variables relate to one another. With a funnel chart, you may want to show what is
the total potential sales of the market, how much of that market you’re able to reach, and how much of those that you
are able to reach are able to convert to a final sale. There are all sorts of things that these different charts can be used
for, so as you’re getting ready to use Excel to create charts and visualizations, remember that the most important thing
is how quickly people can read and understand the data that’s presented in a given chart. And so, it’s much less about
the complexity of the chart and more about how simple you can make it to get the message across.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/basic_charts.
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Dashboards

In this chapter, we introduce the concept of a dashboard in a spreadsheet.

Practice Spreadsheet

Use this workbook for the chapter.

Getting Started with Dashboards
A dashboard is used to summarize key information. For example, if you were driving, you would use the car’s dashboard
to gather information about the performance of the vehicle and the status of certain tools such as temperature, lights,
and notifications about issues in the car. It wouldn’t tell you everything about what's going on in the engine, but it could
tell you some of the most important things that you might need to know while driving.

An Excel spreadsheet can be used in a similar way: we can create a dashboard that summarizes key information for the
user. This summary of information helps users find what they’re looking for without feeling overwhelmed with
unnecessary content. This chapter will walk you through how to build a dashboard. See Figure 36.1 to see what your
dashboard will look like by the end of this lesson
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Figure 36.1

 
This dashboard is going to be created using a data sheet with information about people at a company. It has some
information about each salesperson, their age, gender, where they live, their cell phone number, and their sales history
for the last five years.

We will simply summarize information for just one salesperson on that dashboard and highlight the key information that
we want to see for that individual.
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1. Rename the sheet with information to Data, and then add another sheet called Dashboard.
Move the dashboard to the left of the workbook. We usually start with the dashboard all the way to the left
because, in English, we read left to right.

2. Create some named ranges. 
a. Select the range of salespeople from Alice to Kent
b. While this range is selected, navigate to the name box in the top left beside the formula bar, and name that

range Person.
i. This can also be done by right-clicking the selected range, selecting “Define Name,” and replacing “Alice”

with “Person.”
3. Go to the Dashboard sheet and select a cell to be your input cell. Format the input cell using the following steps:

a. In the Styles group of the ribbon, you can select a type of cell. Select the Input cell.
b. Right-click on the Input cell option and select Modify. This will prompt a style box. 
c. Select Format and change the fill color of the cell to light yellow. 
d. Make the font Arial size 18, and change the color of the text to black

Next, we’ll add some data validation. It will be easier for the user if they can simply select the name of the
salesperson from a drop-down list. To set up this drop-down list, complete the following:

4. In the tools bar at the top of the Excel page, select the Data tab.
5. In the Data Tools group, select Data Validation.
�. In the dropdown option for what to allow, select List. (See Figure 36.2)

Figure 36.2

 
7. Where it prompts you to type a source, type =person to reference the named range we created in the Datasheet and

select OK. 
a. This will give you a drop-down list that allows you to choose the name of the salesperson.

�. Name the input cell Selected.
9. Copy the headings of the information from the data page and paste them into the dashboard.

a. To paste, use the Paste button in the home tab and select the first option under Paste Values. 
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Functions in a Dashboard
There are a number of different LOOKUP functions that you can use in Excel. VLOOKUP, HLOOKUP, Index, Match
Combination formula, XLOOKUP formula, and many others are different ways to correctly pull back information to the
dashboard. In this chapter, only one of them will be demonstrated, but you are encouraged to search online for how to
use some of those additional methods. Please do not feel that just because this particular method is being
demonstrated in this section that it is the only acceptable method for this class. 

We’re going to use something called the Offset function. The offset function is used to reference a cell that is a certain
distance away from the selected cell. Using the formula, you dictate where the offset should be in regards to the
selected cell by typing how many rows up or down or how many columns to the left or right you’d like to move to select
the offset. Negative numbers will move rows up and columns left. If the row or column should not change, you can put
0 for that argument. The formula will require the first three arguments to be entered: reference, rows, and columns. (See
Figure 36.3)

Figure 36.3

Complete the following to use the Offset function.

1. Below the Age column, we’re going to choose an offset function by typing =OFFSET and selecting a cell to
reference.

a. Your reference will be found on the Data page. Select Salesperson as the reference.
i. Use F4 to anchor it.

2. The number of rows is going to be determined by an embedded MATCH formula. 
a. In the formula bar, after the anchored reference, type MATCH.

i. The lookup value will be the selected person. Type selected into the formula, followed by a comma.
ii. The lookup array will come from the list of persons that you already created. Type person into the formula

bar and select that option. 
iii. Then, choose an Exact Match for the match type. (See Figure 36.4)

Figure 36.4

 
3. For the column, look up again using a MATCH function.

a. This time, the lookup value will be the Age cell on the dashboard.
b. The lookup array will be the headers from Age to Year 5.
c. Again, the match type will be 0, or exact match.

i. There are optional parameters for height and width, but we will leave those blank for simplicity’s sake.
d. Press Enter. Notice how in the dashboard, it now pulls Carl’s age back as 50. 
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When using functions, we want to avoid having to repeatedly edit cells. In this example, if you dragged the formula
across the rows, you’ll see that it just keeps Carl’s age (50). To fix this issue, we should anchor the lookup array properly.
We don’t want to anchor the dashboard reference in C5, but we do want to reference the following lookup array to be the
same every time. See Figure 36.5 for an example of correct formatting. 

After anchoring the array, you should be able to drag the formula across and see the correct information from the
previous sheet. You may need to use the format painter to make sure you get the right number format. 

Figure 36.5

 

Formatting a Dashboard
Now we have all the information about our selected salesperson on the dashboard. The next step is to take the time to
lay out the dashboard in a way that makes it easy for the user to see and understand. 
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1. Select a cell below the information you just entered on the dashboard and type Personal Information to create a
new section or area to place content.

2. Create another section below that’s called Contact Information.
3. Create a third section to the right called Sales Contribution. 
4. To make the titles consistent, use a cell style to set them apart.

a. For example, you can try using Heading 3, and apply it to all three sections by selecting them while holding
down the CTRL key.

5. From the information select Age and Gender along with their corresponding answers, and drag those four cells
beneath Personal information.

a. You can drag the cells so that the layout is horizontal rather than vertical. (See Figure 36.6)

Figure 36.6

 
�. Complete the same actions for the other two sections. 
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a. Home State and Phone will go under Contact information.
b. Years 1–5 will go under Sales contribution. (See Figure 36.7)

Figure 36.7

 
7. Make the row height of the row for the name taller by right-clicking on the desired row on the side, selecting Row

Height, and changing it to 40.
�. Select the two cells occupied by the name, Edward, and use the Merge and Center feature in the Alignment

section.
a. Make sure the Input style is applied to this cell.

Professionalism
On a dashboard, we want to make sure we are following the standards of professionalism.

1. In the View tab, uncheck the Gridlines box.
2. By right-clicking on the letter A at the top of the first column and selecting Column Width, make the first column

width 4. 
3. Delete the extra rows between Edward and Personal information and leave only one row between the end of the

Personal Information section and the start of the Contact information section. (See Figures 36.8 and 36.9)
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Figure 36.8
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Figure 36.9

 
The Sales Contribution section ends up being one of the most important pieces of information in this example, so, let’s
emphasize it.
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1. Move that section up. 
2. Clean up any additional formatting errors that might keep your dashboard from appearing professional. 

a. This includes things such as getting rid of any unnecessary space or extra formatting and making sure things
are aligned and appear uniform in size.

3. Widen the column so that the phone number fits within the cell. 
4. Left-align all the text within the personal and contact information.
5. Put a border around the personal information and the contact information by selecting one extra cell around the

information and apply the border.
a. You may need to move this section in order to be able to select all the cells around it. 

�. With the cells selected, open up the Format Cells box and choose a border.
a. Select a gray border to outline the boxes.

7. Format the Contact information to match the Personal information box.
�. Move the Salesperson name dropdown cell to be centered with the information boxes, and change the column

width to the right and left of it to 4.
a. Select the columns between the columns you just adjusted and change their width to 14. (See Figure 36.10) 
b. This will give you enough space to see everything clearly.

Figure 36.10

 

Next, for Sales contribution, you will complete some calculations based on the particular numbers in that chart. 
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1. Below the Sales contribution section, make space for these calculations in their own cells. In the cell to the right of
the specific years below, use simple functions to look them up. You may need to use the format painter to adjust
any numbers that don’t come out as dollar amounts.

a. Top year
i. For this use, use the =MAX function for the range of sales contributions through the years.

b. Average year
i. Use the =AVG function of the same range.

c. Standard deviation (STDEV)
i. Standard deviation just measures the variability around the average.
ii. Use =STDEV.S of the same range.

d. Worst year
i. Calculated with the =MIN function of this range.

2. Include a chart of his sales.
a. Select the sales information.
b. Select Insert. 
c. Choose a line chart.

i. There are a number of existing format styles, and if you hover over them, you can see what they might look
like. (See Figure 36.11)

Figure 36.11

 
As always, be sure to add labels to the horizontal axis and vertical axis. 

1. Call the vertical axis Sales.
2. Because each point is labeled as Year One, Year Two, Year Three, Year Four, and Year Five, it actually would be

duplicative to have a title. In this particular instance, you can omit the horizontal axis label.
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You also may want to format and add markers to this line.

1. Press CTRL+1 while the line is selected, it pulls up the formatting options. 
2. Make the line a little thinner by making it 1.5. 
3. In Marker Options, select Built-in. 
4. Make the marker a circle the size of 7, and choose the fill as a Solid Fill color. In this case, select white. 
5. Use a solid line on the border, making it the same size as the line at 1.5, and the same color as the line.

It’s important that you understand what information is most needed on the chart. For example, because we show the
sales amount on the axis, we don’t need to label each data point. Those amounts are also listed out above in a table
view in case the users want to see the specific numbers. This chart is used to see the trend of those numbers. 

Now, you can see we have a nice visible trend between the actual point and the trajectory it took to get to the next
point. 

1. Label the chart 5-Year Sales History. 

The numbers associated with the various types of years are some summary statistics about this particular person’s
sales. 

1. Title it Summary Sales Statistics and format it using Heading 3 across both columns occupied by the title. 
2. Again, add a border around the outside. 
3. Move Contact information and Personal information down to make room for Summary Sales Statistics.
4. Move the graph to be in line with the Sales Contribution Data.

a. It may be a little too narrow, so make the columns for this information have a width of 12. 
b. Make the columns to the sides a little bit more narrow at a width of 4. 
c. Now, create an offset of one cell around the entire thing for the border, using the same gray border. 
d. Choose outline and select OK. 
e. You don’t actually need a border around the chart as well, so the shape outline can be removed by selecting No

Outline. (See Figures 36.12 and 36.13)
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Figure 36.12
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Figure 36.13

 

Some other things that can be done to tighten it up a bit might include changing the column widths so that things are
aligned more nicely. 
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1. Hide all of the rows below the dashboard and the columns to the right. 
a. Changing the width of the rows to zero is the same thing as hiding it.
b. This way, it’s very clear that if we pick a different salesperson, we’re able to see what that information is for

that particular person. 
2. Let people know on a dashboard who they should contact if they have questions, and when the data was updated.

Add a note at the bottom that says, Data last updated August 2021. 
a. Depending on what type of information is on the dashboard, you may also want to include the specific date

and time. In this example, we’re looking at years worth of history, so a month is an appropriate time. 
3. Give information on who a user should contact if they need additional information by adding another note beside

the date that says Contact person@email.com with any questions.
a. Use the Explanatory Text feature found in the Styles tab to make it fade into the background. 

4. List the company’s name at the top, or put it above the drop-down list. 
a. Insert a row above the dropdown and call it Company Sales History by Associate. Then format the content by

using a heading format. 
b. Select all columns across the top, choose Heading, and then choose to left-align. This will create a very clear

title here at the top. 
c. If the company had a logo, which in this case it does not, it could be included at the top, and that would help

make it look additionally even more professional. 
d. The last change to make on this is to make the width of the input box match the width of the other boxes

below. To help it look consistent, if we add that same look and feel here where we choose input, and then we
choose to merge and center across all of the cells within the dropdown, it makes it look a little bit more
complete and planned out as we take a step back and look at the whole dashboard. (See Figure 36.14) 

Figure 36.14
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Like many other things in Excel, dashboards are a matter of personal preference. The principles in this chapter can be
applied in different ways depending on what is being presented. For this example, we wanted to summarize the
information for a given associate on a single page, so making it easy for the user to quickly pick a name and see the
information was important. 

As you work on your own dashboards, keep readability and usability in mind.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/dashboards.
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Conditional Formatting 2

Data bar formatting can be modified from the preset to function more appropriately for the data. In this chapter, we’ll
work through different settings that can be applied to the formatting rules. 

Practice Spreadsheet

Use this workbook for the chapter.

First, we need to select the cells to be formatted, press the Conditional Formatting button, and select any preset Data
Bar format.

Figure 23.1
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Notice the data bar fills cells based on the highest value in the selected range by default. In this case, the highest value
is 16, but what if we want the data bar to be based on a higher value like 100? We will need to modify the format rule.

1. Press the Conditional Formatting button on the ribbon toolbar.
2. Select Manage Rules….
3. Select the data bar rule to be modified and press Edit Rule… (See Figure 23.2)

Figure 23.2

 
The window that opens provides options for changing the rule type, format style, minimum and maximum values, and
bar appearance settings. For this example, we’ll change the value settings by selecting the type to be Number and input
0 for the minimum and 100 for the maximum. Confirm the change to close the window. The data bars will update to
reflect each cell’s value in relation to the maximum 100.

Color Scale Rules
Color scaling, also known as a heat map, will fill cells with one of three colors based on the value in the cell. This style
of formatting is used to visually represent low to high values. (See Figure 23.3)
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Figure 23.3

 
For example, we can select the Green - Yellow - Red Color Scale to format high numbers with green, low numbers in
red, mid-average numbers in yellow, and everything between varying in shade. (See Figure 23.4)
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Figure 23.4

 
What if we need to use red for high numbers and green for low or simply different colors? We can select the Red -
Yellow - Green Color Scale instead, or edit the formatting rules to customize the color scheme and value settings. (See
Figure 23.5)

Other color scaling options are available to use only two colors, such as the Green - White Color Scale to format the
highest values in a dark color that progressively lightens toward white for low values.
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Figure 23.5

 

Icon Set Rules
Icon sets are useful for showing a change in value. If we want to see an increase or decrease in price, we’ll need
individual cells with the old and new values. For this example, we’ll set up a random number generator to represent the
change value. (See Figure 23.6)

1. Type =RANDBETWEEN and a left parenthesis ( ( ) in a new cell.
2. Type a bottom value, then a comma ( , ).

a. In this example, we’ll insert -10 as the bottom value.
3. Type a top value, then a right parenthesis ( ) ).

a. In this example, we’ll insert 100 as the top value.
4. Press Enter to complete the formula.

Figure 23.6
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Next, we’ll calculate the price difference by using a formula to multiply the old price by the randomly generated value as
a percentage.

1. Type an equals sign ( = ) to begin the formula.
2. Select the cell containing the old price.

a. In this example, the old price is contained in L3.
3. Type an asterisk ( * ) to multiply.
4. Select the cell containing the randomly generated value.

a. In this example, the random value is contained in M3.
5. Type a forward slash ( / ) to divide.
�. Type 100.
7. Press Enter to complete the formula. (See Figure 23.7)

Figure 23.7

 

Note: We can copy and paste the price difference value over the completed formulas by using Paste Value without the
formula to prevent continuous changes based on the randomly generated number.

Next, we need to add the old price with the price difference to calculate the new price in a separate cell.

Finally, we determine the percentage change by dividing the new price by the old price minus one.

1. Type an equals sign ( = ) to begin the formula.
2. Select the cell containing the new price.

a. In this example, the new price is contained in O3.
3. Type a forward slash ( / ) to divide.
4. Select the cell containing the old price.

a. In this example, the new price is contained in L3.
5. Type a hyphen ( - ) to subtract.
�. Type a 1 and press Enter to complete the formula. (See Figure 23.8)
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Figure 23.8

 
Now we can format the price change percentage cells to include icon sets. The icons can visually show positive or
negative changes. However, the preset settings don’t appropriately demonstrate increase or decrease, so we’ll need to
edit the rule.

The formatting rule settings include icon style and value designations to determine when and what icon is displayed.
(See Figure 23.9)

Figure 23.9
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Format by Formula
Up to this point, we have learned how to format a cell based on the value it contains. Now we’ll learn how to format a
cell based on another cell’s value using formulas. In this example, we want to format a list of part numbers based on
related data cells. (See Figure 23.10)

Figure 23.10

 

We need to create a rule by selecting the cells to be formatted. 

1. Press the Conditional Formatting button in the ribbon toolbar.
2. Select New Rule…. 
3. Select the Use a formula to determine which cells to format rule type. 
4. Press the Format… button to choose a format. 

We’re going to format the part number cells with a light-yellow fill based on if the part’s class is A.

1. Type an equals sign ( = ) in the Format values where this formula is true input field.
2. Select the cell containing the appropriate class value.

a. The selected cell will be anchored by default in the formula. However, we do not want the cell to be anchored
for this formula, so we’ll remove the anchor by pressing F4 or deleted the dollar signs ( $ ).

3. Type an equals sign ( = ) to determine if the selected cell matches the next input.
4. Type double quotation marks ( " ) to indicate a textual string.
5. Type the letter A.
�. Type double quotation marks ( " ) to close the text string and complete the formula (=W3="A"). (See Figure 23.11)
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Figure 23.11

 
Note: To format the full row of cells associated with the appropriate part number, the formatting rule must apply to the
whole range of data, and the formula must anchor the column (=$W3="A"). (See Figure 23.12)

Figure 23.12

 

If we want to format the rows of parts over a specific price, we can create an input cell containing the threshold value.
Then, we'll add a conditional formatting formula to check the part's price in relation to the input cell and format the cells
with a red border.
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1. Type an equals sign ( = ) in the Format values where this formula is true input field.
2. Select the cell containing the part's price.

a. The selected cell needs to anchor the column, but not the row to work properly.
3. Type an greater than sign ( > ).
4. Select the input cell containing the desired threshold value.
5. Confirm formatting rule formula. (See Figure 23.13)

Figure 23.13

 

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/conditional_formattiF.
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Spreadsheet Protection

In this chapter, we’re going to learn about spreadsheet protection. We will learn how to lock cells and protect
worksheets in order to restrict the kinds of things that a user can do on a given worksheet or within a given workbook.
In a dashboard type of worksheet, using locked or unlocked cells helps users focus on what they should interact with
instead of having to guess. These practices ensure a clear and consistent pattern, which means users can easily
navigate the worksheet.

Practice Spreadsheet

Use this workbook for the chapter.

Create a Dashboard
First, you’ll need to create a basic input and output workbook. (See Figure 35.1)

Figure 35.1
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Next, we’ll make a make-believe dashboard to see how these functions might work.

1. In Output 1, column H, multiply the first input by 20. The formula should read =D4*20.
2. Copy the formula into all of the other H column Output cells. 

a. Use the Paste tool in the Home tab in the top right of the page. In the drop-down box under Paste, select Use
Format so you’re only pasting the function.

3. In Output 1, column J, take Output 1 from column H and multiply it by Input 1. The formula should read =H4*D4. 
4. Copy the formula into all of the other J column Output cells.

a. Use the Paste tool in the Home tab in the top right of the page. In the drop-down box under Paste, select Use
Format so you’re only pasting the function. In the end, the sheet should contain all of the information
represented in Figure 35.2.

Figure 35.2

 

Locking the Worksheet
Now that we have a functional dashboard, it’s time to think about how we want the user to interact with it. In this
example, we really only want them to change content in the Input cells, not the calculations in the Output cells. Let’s
look at protection options for this sheet and workbook:

1. Go to the Review Tab. 
2. Go to the Protect section (see Figure 35.3). This section allows you to protect certain parts of this Excel sheet: the

sheet, the workbook, and certain ranges.

Figure 35.3

 

To begin, we’ll work with Protect Sheet. (See Figure 35.3)
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1. Select Protect Sheet. A popup box should appear titled Protect Sheet. (See Figure 35.4)

Figure 35.4

 
The sheet protection is automatically set to allow users to Select Locked Cells and Select Unlocked Cells. Locked and
unlocked cells determine what a user can actually do. There are other features that will allow you to allow or disallow, so
if you don’t want users to be able to do anything except click on cells that are unlocked, you can uncheck the Select
Locked Cells box. (See Figure 35.5)

Figure 35.5

 
At the top of the Protect Sheet popup, there is a text-input cell titled Password to Unprotect Sheet. This allows you to
set a password, but remember that it’s important that you keep the password safe because there isn’t any way to
recover it if you forget it. Try adding a password to this sheet:
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1. Type the password 1234 into the textbox titled Password to Unprotect Sheet. (See Figure 35.5) 
2. Select OK.
3. Reenter the password 1234 in the textbox titled Reenter Password to Proceed. (See Figure 35.6)

Figure 35.6

 
4. Select OK.

The worksheet is now password protected and all of the cells are locked; you won’t be able to change or even select any
cells in the sheet until you reenter the password. 

Unlocking the Worksheet
To unlock the sheet, select Unprotect Sheet and enter the password 1234. (See Figures 35.7 and 35.8) 

Figure 35.7

 

Figure 35.8

 
Note: In the future, we do not recommend that you use a password as it will make it difficult for others to check your
work. The password feature is available, but for the BUS 115 class, you should not use it. 

Locking Cells
You can select which cells you’d like the user to be able to interact with. Use the following steps to lock specific cells. 
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1. Ensure the sheet is Unprotected.
2. Select all of the input cells. Use the CTRL key to select multiple cells.

 Figure 35.9

 
3. Right-click on the selected cells and click Format Cells (see Figure 35.10). You can also use the keyboard shortcut

CTRL+1 as a shortcut.
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 Figure 35.10

 
4. A popup titled Format Cells will appear. Select the Protection tab.
5. There are two checkboxes; the first box, Locked, will automatically be checked. Uncheck that option and select

OK. (See Figure 35.11)
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 Figure 35.11

 
�. Go back to Protect Sheet and check the box Select Unlocked Cells. Select OK. (See Figure 35.12)

Figure 35.12

 
If you try to click any of the cells, you’ll notice that you’ll only be able to select the four Input cells you formatted earlier.
You won’t be able to select any of the other cells in the worksheet. 

Unprotect the sheet and protect it again. This time, check the Select Locked Cells box. Select OK. (See Figure 35.13)
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Figure 35.13

 
This time when you click cells, you’ll notice you can select any of them, but if you try to change or delete the information
in the Outputs box, you’ll receive a popup box telling you it can’t be changed. 

Note: All cells are automatically locked by default in a new Excel sheet. So, you need to make sure that you have the
appropriate cells unlocked while using the Protect Sheet. One way to do this a little more quickly is to use the Quick
Access Toolbar.

 

Quick Access Toolbar
To create a button to quickly protect certain cells on a sheet, follow these steps:
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1. At the top green bar of your Excel, select the drop-down arrow to the left of the title of the workbook. 
2. Select more commands. (See Figure 35.14)

Figure 35.14

 
3. A popup box titled Excel Options will appear. 
4. In the drop-down box under Choose Commands From, select the down arrow. Change it from Popular Commands

to All Commands. (See Figure 35.15)

Figure 35.15

 
5. You will be directed to a list of commands. Press L on your keyboard to quickly find Lock Cell. (See Figure 35.16)
�. Select Lock Cell and then select Add.
7. Select OK.
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Figure 35.16

 
On the quick access bar, next to the drop-down button to the left of the title of the workbook, you’ll see a button that
looks like a lock. 

Figure 35.17

 
Now, when you select a cell that is locked, the icon is highlighted. If you select a cell that’s unlocked, the icon is not
highlighted. 

You can select single cells or an entire range and you can select the lock icon button to lock and unlock the cells
quickly. When you go to the protect sheet menu (especially if you have a PivotTable or PivotChart on your sheet, the
user will not be able to interact with these things unless the specific checkbox is checked. 
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Figure 35.18

 

Protect a Workbook
This chapter primarily focuses on worksheets, but briefly, we’ll cover protecting an entire workbook. 

Figure 35.19

 
1. In the Review tab in the Protection section, you will see an option called Protect Workbook. Selecting this option

allows you to protect the workbook for structure with a password. 
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Figure 35.20

 
When we choose to protect the structure of the workbook, it means that users are not going to be able to make any
typical changes. Locking the workbook is helpful in certain instances, but in the practices discussed in this text, you’ll
mostly focus on protecting the sheets.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/spreadsheet_protecti.
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Basic Pivot Tables

Before we look at Pivot Tables in this chapter, we'll work on creating cross tabulation using function formulas. Cross
tabulation summarizes data for analysis. For this chapter, we'll be using data from a survey performed on 1,500 people
who bought fishing supplies from stores in three locations. (See Figure 25.1)

Figure 25.1

Practice Spreadsheet

Use this workbook for the chapter.

Cross Tabulation
If we want to know the number of customers by location that prefers a specific fishing method, a cross-tabulation will
present the data for analysis. We'll set up the cross-tabulation by using the UNIQUE function in combination with
TRANSPOSE to list the type of fishing method across the columns.

1. Select an empty cell and type =TRANSPOSE followed by a left parenthesis ( ( ).
2. Type UNIQUE followed by another left parenthesis ( ( ).
3. Select the set of data for the Type of Fishing Preferred column.
4. Type a right parenthesis ( ) ) to close the UNIQUE function.
5. Type another right parenthesis ( ) ) to close the TRANSPOSE function.
�. Press Enter to complete the formula (=TRANPOSE(UNIQUE(E2:E1501)) correlating with Figure 25.1).

383

https://drive.google.com/uc?export=download&id=1tm1pbXpP6z5L-QemKM71RIWI_t_IE1Zr


Then, we repeat the steps for the UNIQUE function to label the rows.

1. Select the cell down and to the left of the previously completed cell.
2. Type =UNIQUE followed by a left parenthesis ( ( ).
3. Select the set of data for the Store column.
4. Type a right parenthesis ( ) ) to close the function.
5. Press Enter to complete the formula (=UNIQUE(D2:D1501) correlating with Figure 25.1).

Lastly, we need to populate the cross-tabulation cells with data from the survey information correlating to the column
and row headers. The COUNTIFS function will add the data based on criteria that we will specify in the formula.

1. Select the first cell in the cross-tabulation.
2. Type =COUNTIFS followed by a left parenthesis ( ( ).
3. Select the set of data for the Type of Fishing Preferred column and anchor the references with the F4 key, then

type a comma ( , ).
4. Select the cross tabulation's column header and anchor the reference's row only, then type a comma ( , ).
5. Select the set of data for the Store column and anchor the references, then type a comma ( , ).
�. Select the cross tabulation's row header and anchor the reference's column only.
7. Type a right parenthesis ( ) ) to close the function.
�. Press Enter to complete the formula (shown as =COUNTIFS($E$2:$E$1501,H$3,$D$2:$D$1501,$G4) in Figure

25.2).
9. Copy the formula to the cross tabulation's remaining cells.

Figure 25.2

 
This function's formula can be used for cross-tabulation of other criteria from the survey data, such as gender and age.
Additionally, we can add the totals for each row and column by using the SUM function to total the row or column's
cells.

Insert a Pivot Table
There are two methods to adding a Pivot table. The first method is to select the data set and name it before inserting
the table. The second method skips the range naming and Excel will attempt to guess the desired data range to be used
when opening a Create PivotTable menu.
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1. Select the data set.
2. Type a new name for the range in the top-left box in the formula bar. For this example, the range will be renamed

"data." (See Figure 25.3)

Figure 25.3

 
3. Go to the Insert tab.
4. Select PivotTable to open a Create PivotTable menu.
5. Select the range manually in the Table/Range field or type the equals sign ( = ) and the range name. (See Figure

25.4)

Figure 25.4

 
�. Select to place the Pivot table in a New Worksheet or Existing Worksheet.
7. Press OK.
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Upon creating a Pivot table, a side menu will open with a list of the data range's columns and fields for building the
table. The data items can be placed into the Filters, Columns, Rows, and Values fields by dragging the desired item from
the list.

Figure 25.5

 

Data Analyses and Filters
A Pivot table can function similarly to the previous cross-tabulation and display calculations with a few short steps.

1. Select and drag Store from the list on the left to the Rows box in the PivotTable Fields menu.
2. Select and drag Type of fishing Preferred to the Columns box.
3. Select and drag Store to the Values box to complete the table. (See Figure 25.6)

Figure 25.6
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The data can be removed or rearranged to display other analyses. In another example, the table could show the average
age for male and female customers based on the preferred fishing method. (See Figure 25.7)

Note: Unlike the cross-tabulation using formulas, a Pivot table will not automatically update values if the base data is
changed. However, the table can be manually updated by selecting the table, going to the PivotTable Analyze tab,
pressing the Refresh button, and selecting Refresh All.

1. Select the Pivot table and go to the PivotTable Analyze tab.
2. Press the Clear button and select Clear All.
3. Select and drag Gender to the Rows box in the PivotTable Fields menu.
4. Select and drag Type of Fishing Preferred to the Columns box.
5. Select and drag Age to the Values box.
�. Press the down arrow for the Age value and select Value Field Settings….
7. Change the Summarize Values By to Average.
�. Press OK.
9. Adjust the formatting to Number and reduce decimal places to show one digit.

Figure 25.7

 
Multiple items can be placed in a single box to categorically list values based on the desired criteria. For example, the
table can display the average age of customers that prefer a particular type of fishing method, and also the average for
females and males under that fishing method. Additionally, the table may show the standard deviation of age for each.
(See Figure 25.8) 

Figure 25.8
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1. Insert Type of Fishing Preferred into the Rows box.
2. Insert Gender into the Rows box.

a. Note: The order may also be rearranged to list gender, then the type of fishing.
3. Insert Age into the Values box and change the Value Field Settings… to show Average.
4. Insert Age into the Values box again and change the Value Field Settings… to show StdDev (standard deviation).

Filters can be assigned to select the details to be shown on the Pivot table. Simply drag the list item into the Filters box
for the table to display the filter option and select the data to be filtered. (See Figure 25.9)

Figure 25.9

 
Pivot tables can have an unlimited number of hierarchy levels. For example, if we want to see statistics by gender, and
then fishing method and store location, then each category can be added to the Rows box and arranged in the desired
order. The Pivot table includes a button next to each level for collapsing and expanding the data under the specific level.
(See Figure 25.10)
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Figure 25.10

 

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/basic_pivot_tables.

389

https://books.byui.edu/bus_115_business_app/basic_pivot_tables
https://books.byui.edu/license/copyright


390



Advanced Pivot Tables and Slicers

We are going to continue with pivot tables in this chapter to explore some advanced features. An identical data set to
the previous pivot table chapter will be used with a couple of additions: Money Spent and Quantity Purchased columns.

Figure 26.1

 

Practice Spreadsheet

Use this workbook for the chapter.

The first question we want to answer in this chapter will reuse the pivot table from the previous chapter, and we want to
know the percentages of products purchased in three locations. We will begin by naming the data set for quick
reference and inserting a pivot table in a new spreadsheet with Type of Fishing Preferred in the columns field, Store in
the rows field, and Store in the values field.
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Figure 26.2

Value Field Settings
The initial pivot table in Figure 26.2 does not present the percentage data we need in this scenario. Instead of manually
producing percentages using functions, we can have the pivot table do it automatically by modifying the value settings.

1. Select a cell in the pivot table.
2. Right-click the Count of Store in the Values field of the PivotTable Fields menu.
3. Select Value Field Settings to open the Value Field Settings menu.
4. Select the Show Values As tab.
5. Select the % of Grand Total option from the Show values as drop-down list. (See Figure 26.3)
�. Press OK to apply the change to the pivot table.

Figure 26.3

 
The pivot table will now show the percentage values across the table instead of the previous count totals. The
percentages are based on the grand total count of 1,500 from Figure 26.2. The percent of grand total is useful to
understand the company's total sales, but what if we want to know the percentages of sales by store or by-product? We
could change the Show values as setting to % of Column Total to view sales by store for a geographic perspective, or %
of Row Total to view sales by preferred bait for a product perspective.
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Pivot Charts
If we want to view the data of our new pivot table in a chart, we can create a pivot chart based on the table. For this
scenario, we'll insert a simple clustered column chart.

1. Select a cell in the pivot table.
2. Go to the PivotTable Analyze tab of the ribbon toolbar.
3. Select PivotChart to open an Insert Chart menu.
4. Select Clustered Column from the Column list.
5. Press OK to insert the chart. (See Figure 26.4)

A notable difference with this chart is that it includes a button for selecting filters. Filters can be added by dropping
additional chart items to a relevant field. For example, we could add Type of Fishing Preferred to the Legend (Series)
field to include a filter for types of fishing methods.

Figure 26.4

 

Filter Slicers
If we have three pivot charts to present percentages of grand total, column total, and row total individually, we may also
want the ability to filter the data for all three at once. Slicers can be created to do just that.
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1. Select any one of the pivot tables.
2. Go to the PivotChart Analyze tab of the ribbon toolbar.
3. Press the Insert Slicer button to open a selection menu. (See Figure 26.5)

Figure 26.5

4. Select the categories to be used for slicer filters. (See Figure 26.6)

Figure 26.6

 
5. Press OK to create the slicer(s).

The newly created slicer(s) will only work on the initially selected chart, but we can modify the slicer to work for multiple
charts that use the same data.
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1. Select the Slicer box.
2. Press the Report Connections button in the Slicer tab of the ribbon toolbar.
3. Select the charts to be included in the slicer's control. (See Figure 26.7)
4. Press OK to apply the change.

Figure 26.7

 

Due to slicers working as filters, the built-in filters for each chart become redundant. These filters can be removed by
selecting the chart, going to the PivotChart Analyze tab, pressing Field Buttons, and selecting Hide All.

Additionally, to select multiple options of a slicer filter, pressing the CTRL key before selecting a second or more options
as necessary.

Calculated Fields in a Pivot Table
In another scenario, we need to know the average cost customers paid per unit. To calculate the cost, we'll create a new
pivot table using Money Spent and Quantity Purchased in the Values field. Additionally, Store will be added to the Rows
field. The resulting pivot table will display the total money spent at each store and the amount of product purchased.

Note: The values need to be formatted appropriately with a comma separator and relevant currency symbol by using the
Number Format button in the Value Field Settings menu.

Now we need to find the average cost per product unit. We can do this manually by dividing the money spent by the
quantity purchased, but we want to include it automatically in the pivot table. We'll do this by adding a field.
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1. Select a cell in the pivot table.
2. Go to the PivotTable Analyze tab of the ribbon toolbar.
3. Press the Fields, Items, & Sets button.
4. Select Calculate Field… to open a new menu. (See Figure 26.8)

Figure 26.8

 
5. Name the field Average Price.
�. Edit the formula by inserting Money Spent and typing a forward slash ( / ) to indicate division.
7. Insert Quantity Purchased to complete the calculation (shown as ='Money Spent'/'Quantity Purchased' in Figure

26.9).
�. Press OK to add the new field.

Note: The new field's settings will need to be adjusted to format the value correctly as currency with two decimal
places.

Figure 26.9
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We can extend the results into types of fishing preferred and gender to identify average costs by product and gender. In
Figure 26.10, we can see female customers bought fewer spinners for a higher price per unit cost in Ammon, Idaho.

Figure 26.10

 

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/advanced_pivot_table.
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Logic Functions 3

This chapter will explore advanced logic or conditional functions in Excel, including CountIF, SumIF, AverageIF, and
embedded IF statements in other functions. Each function is capable of evaluating a conditional expression and
returning a designated value if true. Furthermore, these functions include a plural variation to analyze multiple criteria
conditions to narrow down the result.

Practice Spreadsheet

Use this workbook for the chapter.

The exercises in this chapter will use the dataset in Figure 24.1 which includes employee name, gender, position,
tenure, college GPA, and salary. We will add conditional inputs for reference to modify our calculations as needed, and
we will have output cells for each function in this chapter.

Figure 24.1

In previous chapters, if we wanted to find the average salary of employees with a tenure of 10 years, we could use an IF
function to check if the employee's tenure is greater than 10 and return their salary if true or nothing if false. We would
copy the formula for each employee before using an Average function to evaluate the resulting range of cells.
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Figure 24.2

However, instead of evaluating the condition and calculating the average separately, we can use IF logic functions to do
both in one cell and vary the results based on our input cells.

CountIF and CountIFS
The CountIF function can be used to evaluate a range of cells and return a count of items that meet a criteria. In this
example, we will count the number of employees of a specific gender from Figure 24.1.

1. Type =COUNTIF and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing the gender data and type a comma ( , ).
3. Select the input cell containing the gender criteria.
4. Type a right parenthesis ( ) ) to close the formula.
5. Press Enter to complete the function (shown as =COUNTIF(C3:C17,J4) in Figure 24.3).

Figure 24.3

 
The CountIFS function works similarly to CountIF but allows for multiple criteria. If we need to count employees by
gender and their college GPA, CountIFS can evaluate both criteria. In this example, we will need to check if GPA is
greater than the specified input by including a greater than calculation in the function's formula.
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1. Type =COUNTIFS and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing gender data and type a comma ( , ).
3. Select the input cell containing the gender criteria and type a comma ( , ).
4. Select the range of cells containing college GPA data and type a comma ( , ).
5. Type ">" and an ampersand ( & ) to indicate a greater than calculation will be performed.

a. Note: Double quotation marks must be included around the greater than sign for the calculation to work
correctly in this function.

�. Select the input cell containing the GPA criteria.
7. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function (shown as =COUNTIFS(C3:C17,J4,F3:F17,">"&J6) in Figure 24.4).

Figure 24.4

 

SumIF and SumIFS
The SumIF function can be used to calculate the total number of values in a selected range of cells. The formula will
prompt for the range of cells to evaluate, the criteria, and an optional range of cells to be added associated with the
evaluated range. In this exercise, we want to calculate the total salaries of employees with a tenure greater than a
specified number of years in the company.

1. Type =SUMIF and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing tenure data and type a comma ( , ).
3. Type ">" and an ampersand ( & ) to indicate a greater than calculation will be performed.
4. Select the input cell containing the tenure criteria and type a comma ( , ).
5. Select the range of cells containing salary data.
�. Type a right parenthesis ( ) ) to close the formula.
7. Press Enter to complete the function (shown as =SUMIF(tenure,">"&t_1,salary) in Figure 24.5).

Note: Cell ranges are named for ease of reference. You may consider naming ranges similarly. However, please note
that the names are not required to complete the function successfully.
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Figure 24.5

 
Similar to the CountIFS function, the SumIFS function works like SumIF but allows for multiple criteria conditions. For
example, if we need to calculate the total salaries of employees of a specific gender and based on their college GPA, the
SumIFS function can check for both criteria and add the salaries of those employees.

1. Type =SUMIFS and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing salary data and type a comma ( , ).
3. Select the range of cells containing gender data and type a comma ( , ).
4. Select the input cell containing the gender criteria and type a comma ( , ).
5. Select the range of cells containing GPA data and type a comma ( , ).
�. Type ">=" and an ampersand ( & ) to indicate a greater than or equal to calculation will be performed.
7. Select the input cell containing the GPA criteria.
�. Type a right parenthesis ( ) ) to close the formula.
9. Press Enter to complete the function (shown as =SUMIFS(salary,gender,g_1,GPA,">="&gpa_1) in Figure 24.6).

Figure 24.6

 

402



AverageIF and AverageIFS
The AverageIF function is used to calculate an average of values that meet a specific criteria. The function prompts for
a range to evaluate, criteria, and an optional range to calculate. In this case, we want to know the average tenure of
employees that have a tenure below a specified number of years.

1. Type =AVERAGEIF and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing tenure data and type a comma ( , ).
3. Type "<" and an ampersand ( & ) to indicate a less than calculation will be performed.
4. Select the input cell containing the tenure criteria.
5. Type a right parenthesis ( ) ) to close the formula.
�. Press Enter to complete the function (shown as =AVERAGEIF(tenure,"<"&t_1) in Figure 24.7).

Figure 24.7

 
Again, the AverageIFS function allows for multiple criteria to be set. In this example, we want to know the average
tenure of employees by gender with a GPA greater than or equal to a specified number.

1. Type =AVERAGEIFS and a left parenthesis ( ( ) to start the function.
2. Select the range of cells containing tenure data and type a comma ( , ).
3. Select the range of cells containing GPA data and type a comma ( , ).
4. Type ">=" and an ampersand ( & ) to indicate a greater than or equal to calculation will be performed.
5. Select the input cell containing the GPA criteria and type a comma ( , ).
�. Select the range of cells containing gender data and type a comma ( , ).
7. Select the input cell containing the gender criteria.
�. Type a right parenthesis ( ) ) to close the formula.
9. Press Enter to complete the function (shown as =AVERAGEIFS(tenure,GPA,">="&gpa_1,gender,g_1) in Figure

24.8).
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Figure 24.8

 

Standard Deviation Sample
Not every statistical function includes an IF variation. For example, the standard deviation function (STDEV.S), which
calculates the variability around the average of a dataset, does not have an IF logic variation. Instead, we need to embed
an IF function within the standard deviation function to perform the calculation based on specific criteria. In this
exercise, we'll embed an IF function to determine an employee salary dataset for a standard deviation calculation based
on employee tenure greater than a specific number of years.

1. Type =STDEV.S and a left parenthesis ( ( ) to start the function.
2. Type IF and a second left parenthesis ( ( ).
3. Select the range of cells containing tenure data.
4. Type a greater than sign ( > ).
5. Select the input cell containing the tenure criteria and type a comma ( , ).
�. Select the range of cells containing salary data and type a comma ( , ).
7. Type two double quotation marks ( " ) to indicate a blank output.

a. Double quotation marks are typically used for a text string. In this case, no text is included, so the function will
display a blank result if the logic argument is false.

�. Type a right parenthesis ( ) ) to close the IF formula.
9. Type a second right parenthesis ( ) ) to close the STDEV.S formula.

10. Press Enter to complete the function (shown as =STDEV.S(IF(tenure>t_1,salary,"")) in Figure 24.9).

Figure 24.9
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Max and Min Functions
The Max function is another that can use an embedded IF function. If we want to know the maximum GPA of employees
with a GPA greater than a specific value, we will need to use an IF formula to filter the results and identify the maximum
value from the criteria. 

1. Type =MAX and a left parenthesis ( ( ) to start the function.
2. Type IF and a second left parenthesis ( ( ).
3. Select the range of cells containing GPA data.
4. Type >= to indicate a greater than or equal to calculation will be performed.
5. Select the input cell containing the GPA criteria and type a comma ( , ).
�. Select the range of cells containing GPA data and type a comma ( , ).
7. Type two double quotation marks ( " ) to indicate a blank output.
�. Type a right parenthesis ( ) ) to close the IF formula.
9. Type a second right parenthesis ( ) ) to close the MAX formula.

10. Press Enter to complete the function (shown as =MAX(IF(GPA>=gpa_1,GPA,"")) in Figure 24.10).

Figure 24.10

 
The Min function may also use an embedded IF function to determine a minimum value from a filtered dataset. In this
example, we want to know the minimum salary of employees that have a tenure greater than a specific number of years.

1. Type =MIN and a left parenthesis ( ( ) to start the function.
2. Type IF and a second left parenthesis ( ( ).
3. Select the range of cells containing tenure data.
4. Type > to indicate a greater than calculation will be performed.
5. Select the input cell containing the tenure criteria and type a comma ( , ).
�. Select the range of cells containing salary data and type a comma ( , ).
7. Type two double quotation marks ( " ) to indicate a blank output.
�. Type a right parenthesis ( ) ) to close the IF formula.
9. Type a second right parenthesis ( ) ) to close the MIN formula.

10. Press Enter to complete the function (shown as =MIN(IF(tenure>=t_1,salary,"")) in Figure 24.11).

Figure 24.11
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The IF function can be embedded in other functions to determine data to be used based on the desired criteria.
Remember to use it or the IFS function to narrow the data sample using specific conditions.

Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/logic_functions_3.
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Advanced Lookup Functions

The Lookup, Index, and Match functions include some advanced techniques that will be explored in this chapter. We'll
begin with a spreadsheet containing data of ingredients and consumption history for eight weeks from a student-run
business. The data includes prices, vendors, and locations. We need to fill in the item class information determined by
price ranges.

Figure 27.1

Practice Spreadsheet

Use this workbook for the chapter.

We will create a table including Min (minimum), Max (maximum), and Class columns. Each row will determine a
separate price range beginning with $0.00 minimum to $5.00 maximum and increasing by $5.00 thereafter. The final
range is $25.00 to $30.00 which will be designated class A with lower ranges descending through B, C, D, E, and F. The
table should be renamed for quick reference; for this example, it is named classTable. (See Figure 27.2)
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Figure 27.2

 
We'll return to the item class cells in the data spreadsheet and use the VLOOKUP function to look up the Price Per Unit
within the designated classTable array to identify the class letter in column 3. Lastly, the function needs to return a
TRUE value for an approximate match.

Note: A TRUE argument determines a value based on approximation within a range, whereas a FALSE argument can
only return a value if the target reference matches the minimum or maximum range numbers. In this exercise, the target
references vary between the specific range points, so the function needs to find an approximate value.

Figure 27.3

 

Row and Column Functions
The Row and Column functions ask for an optional reference argument. The functions work by identifying the
referenced cell's numerical value in the spreadsheet. For example, =ROW(A1) will return a value of 1 because the
referenced cell, A1, is in row 1 of the spreadsheet. The function =ROW(E1) will also return a value of 1 because the
referenced cell is still in row 1. If the reference cell is in a different row of the spreadsheet, the function will return the
relevant value of the row. The Column function works similarly to identify the numerical position of the column
regardless of the referenced cell's row position.
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If no cell is referenced in the Row or Column function, the value of the function's current cell position will be returned.
For example, if =COLUMN() is inserted in cell E10, it will return the value 5 because the function's cell is in column E
which is the fifth column in the spreadsheet.

On their own, the Row and Column functions are not particularly useful. However, when they are used in conjunction
with another function, they can simplify that function.

Combining VLOOKUP and Column
In this exercise, we want to create a dashboard for Figure 27.1's data to look up information about a particular
ingredient. We can copy and paste the data spreadsheet's column labels to a new spreadsheet and insert a data
validation list of the ingredients under the appropriate Ingredient column. Next, we need to write a VLOOKUP function
beginning with the Vendor column.

1. Type =VLOOKUP and a left parenthesis ( ( ) to begin the function.
2. Select and anchor the cell containing the data validation list of ingredients to identify the lookup value and type a

comma ( , ).
3. Select the data table array wherein the lookup will be performed and type a comma ( , ).

a. You may consider naming the table for quick reference. In Figure 27.4, the table array was named table.
4. Type COLUMN and a left parenthesis ( ( ).
5. Select a cell in the B column followed by a right parenthesis ( ) ) to close the function.

a. In this step, we want to reference column B because the Vendor data is in the second column of the data
spreadsheet. By using the Column function, it acts as a placeholder to return the value 2 to indicate the lookup
will look in the second column of the data table. Furthermore, copying this completed function forward will
adjust the Column function to reference subsequent column values; it will prevent us from manually modifying
the value each time.

�. Type FALSE to specify an exact match.
7. Type a right parenthesis ( ) ) and press Enter to complete the function (shown in Figure 27.4 as

=VLOOKUP($C$10,table,COLUMN(Dashboard!B$1),FALSE)).
�. Reselect the completed cell.
9. Press the small square in the bottom-right corner and drag across the remaining dashboard columns to copy the

function.

Note: Formatting may need to be reapplied for the data to match with the data spreadsheet.
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Figure 27.4

 
The completed dashboard should now reflect the data on the data spreadsheet for the selected ingredient.

Index and Match
The Index and Match functions can accomplish the same result. In this case, the Match function working within Index is
used to search for and match a row in the data table with a designated value. Then it draws a value from a specified
column number which will be identified using the Column function again.

1. Type =INDEX and a left parenthesis ( ( ) to begin the function.
2. Select the data table array wherein the lookup will be performed and type a comma ( , ).

a. As suggested in the previous section, you may consider naming the table for quick reference. In this case, the
table array was named table.

3. Type MATCH and a left parenthesis ( ( ).
4. Select and anchor the cell containing the data validation list of ingredients to identify the lookup value and type a

comma ( , ).
5. Select and anchor the column listing ingredients from the datasheet to identify the data to be searched and

matched with the previous step's argument, and then type a comma ( , ).
�. Type 0 (zero) to indicate an exact match, and type a right parenthesis ( ) ) to close the Match function.
7. Type COLUMN and a left parenthesis ( ( ).
�. Select a cell in the B column and type a right parenthesis ( ) ) to close the Column function.
9. Type a second right parenthesis ( ) ) to close the Index function.

10. Press Enter to complete the function (shown as
=INDEX(table,MATCH($C$10,Ingredients!$B$4:$B$15,0),COLUMN(B1)) in Figure 27.5).
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Figure 27.5

 

XLOOKUP Function
The final function that we can use to lookup information about a particular ingredient from the data spreadsheet is the
XLOOKUP function. XLOOKUP works by looking up a designated value from a selected array and returning the
associated value of another related array. Additionally, the XLOOKUP function can return a predetermined value or
textual note if the initial lookup value cannot be found.

1. Type =XLOOKUP and a left parenthesis ( ( ) to begin the function.
2. Select and anchor the cell containing the data validation list of ingredients to identify the lookup value and type a

comma ( , ).
3. Select and anchor the column of ingredients in the data table and type a comma ( , ).
4. Select the column of vendors in the data table and anchor only the row reference, then type a comma ( , ).
5. Type a textual note in quotation marks such as "Not found" to be displayed if a match cannot be found, then type a

comma ( , ).
�. Type a 0 (zero) to indicate an exact match.

a. Note: The last optional argument labeled "search mode" is best for a larger dataset wherein indicating an order
to begin the search would be beneficial. In this case, the argument will be omitted.

7. Type a right parenthesis ( ) ) and press Enter to complete the function (shown as
=XLOOKUP($C$10,Ingredients!$B$3:$B$15,Ingredients!C$4:C$15,"Not found",0) in Figure 27.6).

Figure 27.6
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/advanced_lookup_func.
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Loan Amortization Schedule

In this chapter, you will build a loan amortization schedule. You’re building this to gain a better understanding of what’s
called the time value of money. The basic principle of the time value of money is that a dollar today is worth more than
a dollar tomorrow, and that interest can work for or against you. 

Practice Spreadsheet

Use this workbook for the chapter.

Entering Inputs
There is a chance you may need to take out a loan at some point, so we will do a simple example of an amortization
schedule for a car loan. In this case, you will be buying a 1990 Honda Accord in North America. Fill out the input
information as found in Figure 34.1.

Figure 34.1

 
Let’s start by understanding what the Scheduled payment for this type of loan would be. There’s a formula called PMT.
The PMT function calculates the payment for a loan based on constant payments and a constant interest rate.
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1. Select the box next to Scheduled payment.
2. Type =PMT(.

a. The first number it will ask you to enter is the rate. 
b. If you open up the dialogue box on the ribbon, it says, “Rate is the interest rate per period for the loan. For

example, use 6%/4 for quarterly payments at 6% APR.” 
3. For the rate, take the annual interest rate divided by twelve payments per year. 
4. Then, it wants to understand the number of periods (nper). There are two years multiplied by twelve payments per

year. 
5. The present value (pv)  of the loan is the loan amount. 
�. The future value (fv) will eventually be zero. Leave the type option argument blank.

This formula results in a scheduled payment of $68.49 in order to start paying off this amount.

The Scheduled number of payments box provides an opportunity to understand how many payments it will actually end
up being. 

1. In the box for Scheduled number of payments, multiply the loan period by the payments per year, which will be 24
payments. 

The Actual number of payments might vary based on the table below. The number of early payments will also be
determined based on the table below. The last box would calculate the total interest that we would pay if we don’t pay
anything extra or early.

To calculate the Total interest, you will use the Cumulative Interest formula (=CUMIPMT). 

1. The rate again is the interest rate divided by the number of payments in a year. 
2. The number of periods would be the loan period in years multiplied by the payments per year. 
3. The present value of the loan is the loan amount.
4. For the start period and end period, if you select the function arguments button, it will tell you that the start period

is the first period of the calculation. In this case, enter 1 for the start period. It also says the end period is the last
period. We know that there are 24 scheduled payments, so enter 24 for the end period, and select OK. 

5. The type asks when you’re going to pay. Select beginning of the period, and push enter. 
�. Use the format painter on the total interest, and you will find that you’re going to pay $45.72 in interest over the life

of this loan. 

Calculate the First Row
Now, navigate to enter in the first row of the schedule.
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1. So, in the first row of the schedule, we’ll calculate the payment number as payment number one, so type 1. 
2. The payment date will be equal to the start date. 
3. The beginning balance will be equal to the loan amount. The scheduled payment will always be the same, so link

this cell to the scheduled payment cell above. 
4. In order to calculate the principal, we need to first know the interest. 

a. To get to the interest, take the beginning balance multiplied by the annual interest rate. 
b. Anchor the annual interest rate, then divide by the number of payments in a year, which will also need to be

anchored, and then press Enter. 
5. The principal is equal to the difference between our scheduled payment minus the interest. Since scheduled

payment is entered as a negative number per this formula, place a negative sign in front of the PMT in the initial
scheduled payment.

a. The reason it’s negative is because it denotes a loan, and you’re paying this money out.
b. Make sure that that is switched correctly in the summary calculations as well as the schedule.
c. So, of the $68 that we pay, $64 goes to principal and $3.95 goes to interest.

�. In the first period, let’s say that we’re not going to make any extra payments, so for that, enter 0.
7. The total payment will be equal to the sum of that extra and our scheduled payment.
�. The ending balance of the loan will be equal to the beginning balance minus the principal portion and the extra

payment.
9. At this point, our cumulative interest is the amount shown in Interest. Use the sum function found in Figure 34.2,

and be sure to lock only the very first argument.
a. That enables the capacity to add cumulatively as you go when it is dragged down.

10. Do the same thing for the cumulative principal using the sum function.
a. Start with the principal amount, press the colon ( : ) key, and close parentheses.
b. In the formula bar, be sure to and edit it in order to lock the first argument.

 Figure 34.2
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Calculate the Second Row
1. For payment number two, select the first cell and add one. (See Figure 34.3)
2. For the payment date, use the EDATE formula, and choose to add a single month. 

a. You will have to update the formatting. Use CTRL+Shift+3, to put it into a date format. 
3. The beginning balance is equal to the ending balance from the previous period. 
4. The scheduled payment will always remain the same. Use the L6 that you’ve referenced previously and if you

anchor that, you can drag that formula down. Copy and paste the formula only. 
a. Again, you may need to use the format painter to format it as currency.

5. The principal is going to follow the same calculation from before.
�. The interest will also follow that same calculation since the cells at the top have been locked.
7. Extra payment again will be zero. 
�. Total payment will be the same formula.
9. Ending balance will be the same formula. 

10. Cumulative interest and cumulative principal will also be the same. 
a. You can see in the formula that both what you paid last period and what you’re paying this period is being

added.

Figure 34.3

 

Calculating the Rest
Now that the second row is built, you can copy the row down the number of periods that you have. In this case, there are
24 periods, so you will need 24 rows. You’ll notice that the beginning balance actually goes negative. The reason for that
is we started paying extra here because the formula started adding for us. If you delete all the values from the
beginning balance column, you’ll see that you end up paying off the loan and have an ending balance exactly at the end
of period 24, which is what we had set in our loan calculation. 

These are the basics of how to make a loan amortization schedule. 

Extra Payments
Let’s say you paid $100 extra in the first period. By doing so, you’ll notice that it actually goes negative in the 24th
period. You finished paying off the loan in the 23rd period. And so, when you navigate to the actual number of payments,
you can use the =COUNTIFS formula. 
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1. Type =COUNTIFS, and select the criteria range of the beginning balance column. 
2. Next, enter that this range is greater than zero. 

The number of early payments, also sometimes called extra payments, would use the =COUNT formula of the extra
payments column. Because there only is one extra payment, you’ll see that cut off an extra period. If you were to pay
another extra $100 in period two, you’ll notice that it cut off three total periods. At the end of this, at the bottom of the
page, you’ll be able to see that, in fact, you finished paying it off in period 21. 

Interest
Loans can be fairly straightforward in terms of how these calculations work. The important function that you need to
know is the payment function (=PMT), where you can calculate how much you’ll owe given very simple inputs. You also
need to understand the total amount of interest that you end up paying over the life of a loan. 

In fact, if you look at what was done by paying $100 extra for those first two periods, you can see that the cumulative
interest paid was $38.74 since you would not calculate anything after you’ve paid off the loan. If you calculate the
difference between the total interest that you were supposed to pay over the life of the loan compared to the interest
that you actually ended up paying down, it’s actually a 15% savings in interest. Now, it may not seem like that much
when the dollars are relatively small like this, but over the course of a large loan, like a home loan, where the dollar
amounts would potentially be in the hundreds of thousands, the amount of interest that you could save would be in the
tens of thousands. 

So, knowing how to make these calculations work and how to create one of these schedules is a vital skill to have for
anyone that will borrow money at any point in their lives. That could be on a credit card, student loans, home loans, car
loans, or any type of money borrowing. You should understand how financial institutions charge you money to use their
funds. 

Potential Home Loan Valuation
Let’s learn a little bit about potential home loan valuation. Given just a very little bit of information, you can use the
payment calculation to calculate what you might owe for a given home that you’re considering purchasing. (See Figure
34.4)
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Figure 34.4

 
To find the payment, using the payment function, take the interest rate divided by the number of periods per year, the
number of periods total, the present value of the loan, and the future value, which will be 0. You’ll see that the payment
for this loan would be $2,395.63 per month, just to cover the loan. 

You can also quickly calculate the amount of interest that you’ll pay over the life of this loan. Using the =CUMIPMT
function, divide the rate by the number of periods per year, select the number of total periods and the present value of
the loan, enter start period 1, ending period of 360, and select that you’ll pay at the beginning of the period. Over the
course of this loan, you will pay more than the value of it originally if you keep the interest rate of 5.99% and keep your
paying minimum amount of $2,395.63. 

Just to show you how valuable this might be, make a copy of these numbers and change the interest rate from 5.99% to
4.99%. The difference in what you pay in interest is $90,000 savings. If you copy it again and bring it down to 3.99%, you
save an additional $85,000 against the previous 4.99% interest rate. If you copy it one last time and change the interest
to 2.99%, this saves us an additional $80,000 against the 3.99% interest. Against the original 5.99%, you’ve saved
$256,000. 

However, in this example, that still means that you’ve paid that amount for your home plus the interest that you paid
over the life of the loan. So, you’ve paid for this home more than it’s worth. If we divide what you paid by the value of the
home, you’ve paid for it 152%. You have quite the ownership in your property at that point. 

Hopefully, this example serves to illustrate how important the time value of money is and how much you can end up
paying or saving, because of course, these numbers could be applied to a savings account that you’re earning interest
on over time and the opposite effect would be the case. 

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/loan_amortization_sc.
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Advanced Charts

In this chapter, we will look at some advanced features for charts and graphs in excel. Specifically, we will look into
forecasting and how you can use advanced features in charts to quickly compare data.

Practice Spreadsheet

Use this workbook for the chapter.

Let’s take a look at a spreadsheet a company might use to forecast data. This spreadsheet has 12 months of data.
There is an expected forecast, high forecast, low forecast, and production capacity. The production capacity represents
what our manufacturing capability is. What’s the maximum number of units we can produce in a given period? (See
Figure 37.1)

Figure 37.1

One thing businesses have to understand about forecasting is that anticipating data isn’t always simple or easy. To
combat that, we estimate the best and worst case scenarios. We’ll organize it from low (worst case) to high (best case).

General Formatting
First, let’s organize this sheet in quarters like businesses do. 

1. Merge and center cells C2 through E2 and label the merged cell “Q1.” 
2. Drag the formatting across by selecting and dragging the bottom right corner of the cell titled Q1 across cells F2–

N2. (See Figure 37.2)
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Figure 37.2

Next, insert the chart.

1. Select the entire range (B2-N6)
2. Select Insert. 
3. Select Charts. 
4. Choose the basic 2D line chart. (See Figure 37.3)

Figure 37.3

 

Unlike previous charts, you’ll notice this chart automatically added two rows of headers as a way to group them
together into quarters. This is a feature you can take advantage of as long as you select both of the header ranges and
they don’t have information in the cells to the left (in this case, cells B2 and B3).
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Format Data Series
Designing the chart is easily managed because almost every element in a chart is formattable. You can access the
format options by completing the following:

1. Right-click a specific object or series in the chart. 
2. Choose Format Data Series. (See Figure 37.4)

Figure 37.4

 

This opens the formatting options in a box to the right of your screen. By selecting different elements of the chart, you’ll
see different types of format menus including the following:

Format Data Series
Format Chart Title
Format Data Series
Format Axis
Format Chart Area
Format Plot Area
 

Each menu includes options like fill-in line, effects, and size and properties. Before you begin formatting, remember: the
goal of a chart is to present data as clearly as possible so you can persuade, inform, or clarify information. Let’s
practice these traits in formatting.

1. Go to high forecast.
2. Go to Format Data series.
3. Select the fill-in line option. (See Figure 37.5)
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Figure 37.5

 
There are many options to customize the line. For this chart, format the line according to the following:

1. Make it a solid line.
2. Change the color of the line to green since it represents the “best case.” 
3. Adjust the width to 1 pt. 
4. Make the line a Dash Type to show that it is only a potential scenario. 
5. Repeat these steps for the low forecast, but instead of green, make the color orange.

The expected forecast is in the middle of the two possible scenarios. Let’s add markers to indicate certain milestones:
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1. Select Marker Options. Select Built-in Marker.
2. Make it a circle. 
3. Change the size to 7.
4. Change the fill color to white to make it look empty. (See Figure 37.6)

Figure 37.6

 
5. Make the border a solid line.
�. Change the color to dark blue and set it at 1 pt. (See Figure 37.7)

Figure 37.7
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We’ll adjust the expected forecast’s line. 

1. Deselect the middle line and then select the middle line again. 
a. This ensures you will deal with the line itself, rather than the markers on the line.

2. In the Format Data Series box to the right of the screen, select the triangle next to Border to collapse the menu. 
a. Two options will appear under the series options icons: Line and Marker. 

3. Select Line. 
4. Adjust the width to 1.5 pt. 
5. Change it to the dark blue color. (See Figure 37.8)

Figure 37.8

 
The chart should reflect Figure 37.9, which shows the range of forecasts.
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Figure 37.9

Legends
Typically, people read from left to right, top to bottom, but for charts, people will look at whatever stands out the most.
We can direct their attention by adding a legend at the top of the chart. A legend clarifies what each color or data set
means. 

1. Select the legend (currently at the bottom).
2. In the Format Legend to the right, select the three bars (Legend Options). 

In the drop-down Legend Options, under Legend Position, select Top. (See Figure 37.10)

Figure 37.10

Always label the axis. Label the vertical axis by using the following steps:

1. Select Chart Design. See Figure 37.11)
2. Select Add Chart Element. 
3. Choose Axis Title. 
4. Select Primary Vertical. 
5. In the textbox, type Quantity.
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Figure 37.11

 
Just like we learned in the previous chapter, we can also use the select data option (see Figure 37.12) to be able to add
additional series to our data set as shown in Figure 37.13.

Figure 37.12
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Figure 37.13

 

Adding More Data
To add data that represents our production capacity, complete the following:

1. Select Select Data. 
2. In the Select Data Source popup box, select Add
3. Select the cell name you would like to add. In this case, select Production Capacity. 
4. Select the Series Value.

a. The cells (C8 through N8) are behind the chart so use your arrow and shift keys to select all of the information.
(See Figure 37.14)

5. Select Okay. A fourth yellow line will appear.
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Figure 37.14

The chart should reflect Figure 37.15; as you can see, sometimes charts get cluttered and it becomes difficult to see
what’s going on.
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Figure 37.15

Series Chart Type
We can adjust the series chart type to simplify this cluttered chart. 
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1. Right-click on a specific series and select Change the Series Chart Type. (See Figure 37.16)

Figure 37.16

 
2. Change the Production Capacity Series to Area Chart. (See Figure 37.17)

Figure 37.17
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3. The chart should reflect Figure 37.18. The new information has been pushed to the background so it doesn’t get in

the way of important information.

 Figure 37.18

 
4. Change the color to light gray to ensure this information adds to the current data without overwhelming the chart.

(See Figure 37.19)
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Figure 37.19

 
Now we can quickly see that while the low cast is always possible and the high cast is sometimes possible, there are
times in January and near the end of the year that we won’t be able to produce everything we need to hit our forecast.
This chart shows that while you could do the math using the data provided, it’s much faster to view the data visually.
See Figure 37.20 to see what your chart should look like now.
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Figure 37.20

Chart Titles
Chart Titles help clarify the sets of data viewers look at. For our example, let’s suppose that this is the dashboard we’re
using to pull in data for different divisions of the company. 

1. Select the Data tab.
2. In Data Tools, select Data Validation. 
3. In the Data Validation popup box, there is a dropdown selection below Allow. Select the dropdown option List. 
4. In the Source textbox, include the following list items (separated by commas):

a. Division A
b. Division B
c. Division C

5. Select Okay. 

If we change the input cell to Division B, the data pulled in the data set would look at a new set and change. We would
want the chart and chart title to change too! To do this, do the following:

1. Create a field below Production Capacity. 
2. Call it =”forecast chart for “ 

a. Use the ampersand to combine the name of the division. (See Figure 37.21)
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Figure 37.21

 
Now when we select the chart title we can go to the formula bar, select Equals, and reference the cell. (See Figure
37.22)

If you change the drop-down, it will change the title of the chart. If our data was connected to a different data source,
the chart would then rearrange the new set of data. 
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Figure 37.22

 

Plot Area
In addition to formatting the series on the chart, you may want to format the plot area itself. Sometimes people like to
have a solid fill in the background. Sometimes, no fill is needed. It depends on what you’re looking for. The same can be
done for the whole chart as well. You can select the inside of the chart and change the fill and set off the chart in the
middle by doing it that way. See Figure 37.23 for an example of how a chart can be formatted.
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Figure 37.23

 
We recommend that you keep the solid fill on the plot and chart area white in most cases because it stands out cleanly
and doesn’t distract the eye with a bunch of new colors, but it depends on how you’ve designed your specific worksheet.

 

Data Labels
Data Labels indicate specific data points. Let’s go over an example:

1. Select and right-click the line for the Expected Forecast.
2. Select Add Data Labels.
3. Right-click and select Add Data Labels. Your chart should reflect Figure 37.24.
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Figure 37.24

Now you should see the number corresponding to the data on the chart itself. Be careful when using these data labels;
they can make the chart look very cluttered. In this example, the vertical axis already shows the number, and unless
there is a specific reason to know an exact number, we do not need the data labels. However, let’s practice formatting
data labels for the future:

First, adjust the size and color of the data labels. (See Figure 37.25)

1. Make the font dark gray and 7 pt. 
2. On the right-hand side in Format Data Labels, choose the far right option.

a. We can choose label options and choose where they should be positioned. 
3. Mark them as Above the line. 
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Figure 37.25

You’ll see on the chart there is a gray area chart behind some of the numbers, which makes it difficult to read. To help it
stand out against the light gray background:

1. In the Format Data Labels table on the right, select the first icon of the paint bucket spilling paint, and open the Fill
menu. 

2. Select Solid Fill.
3. Choose a white color. (See Figure 37.26)

Figure 37.26
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Comparing Charts
For comparison, create a few charts with different formatting:
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1. Make a copy of this chart by selecting and pressing ctrl+C and then ctrl+v. 
2. Select both charts by pressing and holding ctrl. 
3. Choose Shape Format.
4. Choose Align and align them to the bottom of each other. (See Figure 37.27)

Figure 37.27

5. Turn off the gridlines. (See Figure 37.28)

Figure 37.28

�. Select the data range and press ctrl+1 to see the border tab.
7. Add a light gray border by selecting Outline and Inside just in case we need to go back and reference the data

quickly. (See Figure 37.29)
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Figure 37.29

Use the second chart to reference the ranges between the high and low forecasts. We’ll use the next chart to show the
high and low forecast as a range and the expected forecast in the middle. 
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1. Copy the second chart by selecting it and pressing ctrl+C, and then press ctrl+V to paste the copy below the
second chart. 

2. Right-click the high forecast on the third chart.
3. Select Change Series Chart Type. (See Figure 37.30)

Figure 37.30

4. In the pop-up box, select the third icon, Column.
5. Use the Stacked Columns.
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a. This is an accumulative chart format, so it adds series of data on top of each other. (See Figure 37.31)

Figure 37.31
�. Select Cancel.
7. Right-click the high forecast.
�. Select Change Series Chart Type again.
9. Open the last icon, Combo.

10. Select the drop-down arrow next to High Forecast and change it to Stacked Column.
11. Select the drop-down arrow next to Low Forecast and change it to Stacked Column.

a. It will automatically format the low forecast to the top and the high forecast to the bottom. (See Figure 37.32)
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Figure 37.32

 
Reorder the stacks to put the low forecast on the bottom. 

1. Right-click the chart and choose Select Data. 
2. In the Select Data Source popup box, under the Legend Entries (Series) section, there are two arrows (one point up

and one pointing down). Select Low Forecast and select the Up arrow indicated in Figure 37.33. This will adjust the
order of the high and low forecasts. 

a. The list should now read, from top to bottom: Expected Forecast, Low Forecast, High Forecast, Production
Capacity.
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Figure 37.33

 
Change the formatting on the low forecast. (See Figure 37.34)

1. Select Format.
2. Select Shape Outline.
3. Select No Shape Outline.
4. Select Shape Fill.
5. Select No Fill.

Figure 37.34

447



 
On the high forecast, it tells us it goes from the low forecast to the top of the high forecast.

1. In the forecast table, add a cell called “Forecast Range.”
a. This will be the difference between our high forecast and low forecast. 

2. We’ll format it the same, and then copy it over. (See Figure 37.35)

Figure 37.35

This represents the range from the top of the low forecast to the top of the high forecast, and now, we will change this
series to forecast the range number instead of that high forecast. 

At the bottom of the chart the first bar reads:

“179” pt, and at the top we have the old number.
“259” which is referenced inside of the range.

We can format these to blend into the background a little more in order to show a range between which our expected
forecast lies. What you’ll see over time is that the ability of that range increases; in other words, we’re pretty accurate in
January, but as the year goes on and we get further in the future, we show we are a little less confident in where our
ability to forecast actually is.

To format these ranges, we’re going to use a gradient fill. 
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1. We want three gradient stops, one at 0%, one at 50%, and one at 100%.
a. To add or remove a gradient stop, select the icon to the right of the Gradient Stop bar; the icon with the green

plus sign will add a gradient stop, and the icon with a red x will remove a gradient stop. (See Figure 37.36)

Figure 37.36

 
2. In the top stop, change the color to white. (See Figure 37.37)

Figure 37.37

 
3. In the middle stop, change it to a light orange color. (See Figure 37.38)

Figure 37.38

 
4. In the bottom stop, change the color to white at the bottom. (See Figure 37.39)
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Figure 37.39

 

That shows us that the center of the range may be more confident, but the edges are less confident. These colors here
may disappear too early when we select off it. 

1. If that’s the case, change the white to a light orange at the very tips. 
2. Change the transparency to 50% transparent.

a. This lets the background fade in and shows us where we’re at. (See Figure 37.40)

Figure 37.40

 

You can also remove the line so that each dot represents the expected forecast within the broader range that we’re
displaying. (See Figure 37.41)

450



Figure 37.41

 
We can also display, in the Series options, how wide the series are by changing cap width from 150 to 250, or 300.   (See
Figure 37.42)

Figure 37.42

It’s almost the same width as the circle. We can change it back to white on the ends. This is a clearer way to show
where the range is in terms of the shapes.

If we wanted to, in addition to a fill, we could add a border line at a light gray to show us the actual range. (See Figure
37.43)
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Figure 37.43

 
1. Select the base data (B1 through N6).
2. Select Insert.
3. Select Chart.
4. Select Line Chart.

Figure 37.44

 
5. Move the line chart to the bottom left corner
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Your final worksheet should look like Figure 37.45.

Figure 37.45

This chapter reviewed the different ways to share the same data using some of Excel's more advanced charge
functions. Compared to the base line chart we started with, you’ll see there’s quite a bit you can do to improve the visual
presentation of data to help businesses make better decisions.

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/advanced_charts.
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Macros 1

Every action performed in Excel runs a little bit of code that can be recorded into a macro. In this chapter, we will enable
macro recording, create a worksheet, and run a macro to duplicate the actions of creating a worksheet.

Practice Spreadsheet

Open a blank workbook for this chapter.

Enable Developer Toolbar
First, the Developer toolbar must be enabled to have access to macro functions. The toolbar is enabled in the Excel
Options menu.

1. Go to the File tab in the top-left corner of Excel.
2. Press the Options button to open the menu.
3. Select Customize Ribbon.
4. Press the checkbox for Developer in the list on the right to enable the toolbar. (See Figure 28.1)
5. Press OK.
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Figure 28.1

Create a Macro
We need to design a timesheet for a company wherein employees can record their hours by week. A new timesheet
needs to be created for each week, so we need Excel to generate a duplicate sheet at the press of a button. A macro
can perform the task by recording our actions in creating the first sheet, then we can run the macro every time a new
sheet is needed.

1. Go to the Developer tab.
2. Press the Record Macro button.
3. Type a name in the Macro name field.

a. Note: The macro name cannot contain spaces or special characters.
4. (Optional) Type a shortcut key in the Shortcut key field.

a. Combining the Shift key and a letter key is recommended. Excel uses many preset shortcuts (for example, Ctrl
+ S is used for the Save function) that may interfere with your macro on the same shortcut.

5. Select This Workbook in the Store macro in field.
a. The Personal Macro Workbook and New Workbook options have distinct purposes. However, the This

Workbook option will likely be the most effective for collaborative reasons.
�. Type a Description for other users to understand the macro.
7. Press OK to begin recording.
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Figure 28.2

 

Record Actions to a Macro
Upon pressing OK, every action performed in Excel will be recorded in the macro. We will use the time to create and
format a new spreadsheet to be the employee's timesheet.

1. Press the plus symbol ( + ) on the bottom edge of Excel to create a new spreadsheet.
2. Increase Zoom of the spreadsheet to 145%.

a. Use the Zoom slider in the bottom right. 
b. Alternatively, go to the View tab, select Zoom, and type 145 into the Custom field.

3. Resize column A to a width of 4.
4. Resize column B to a width of 20.
5. Resize columns C–G and I to a width of 14.
�. Resize columns H and J to a width of 4.
7. Select and Hide all remaining columns after column J.
�. Select and Hide all remaining rows after row 17.
9. Type Time Sheet in cell B2.

10. Format cells B2–I2 as Heading 1.
11. Type Weekly hours worked by employee in cell B3.
12. Format cells B3–I3 as Explanatory Text.
13. Type Monday in cell C4 and use the auto-fill function to fill the remaining weekdays across cells D4–G4.
14. Format cells C4–G4 as Heading 3.
15. Type Employee1 in cell B5 and use the auto-fill function to fill cells B6–B14.

a. For this practice, we'll use a placeholder for the names and only include 10 employees.
1�. Type Total in cell I4.
17. Type Total in cell B16.
1�. Insert SUM formulas into the Total row and column to add the respective cells in the row or column.
19. Go to the View tab and deselect Gridlines.
20. Select employee and total rows and apply a light gray in between and bottom border lines.
21. Select cell C5 and return to the dashboard spreadsheet. (See Figure 28.3)
22. Go to the Developer tab and press Stop Recording.
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Figure 28.3

 

Run a Macro
The completed macro will perform all of the same steps used to create the timesheet, including a new spreadsheet. To
run the macro, go to the Developer tab and press the Macros button. A menu will open with a list of macros. Select the
appropriate macro and press Run. (See Figure 28.4)

Figure 28.4
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We can make finding and using the macro simpler for other users by creating a button on the dashboard spreadsheet.
There are two methods to create a button. The first is to go to the Developer tab, press the Insert button, and select the
first rectangular box icon under Form Controls for a simple shape button. A window will open and prompt for a macro to
be assigned. Right-click the button and select Edit Text to name and identify the button. (See Figure 28.5)

Figure 28.5

The second method is to go to the Insert tab, press the Shapes button, and select the desired shape. Draw the shape
into a cell or multiple cells. Edit the text to identify the button. Right-click on the button and select Assign Macro…
Choose the appropriate macro and press OK. (See Figure 28.6)

Figure 28.6
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The new button will run the assigned macro to effortlessly create additional timesheets.

Review Macro Code
Recorded macros can be edited by pressing the Visual Basic button in the Developer tab. Visual Basic is a simple
coding application that enables users to edit and create macros for Excel. The application will be explored in more
detail in the next chapter.

Save a Macro-Enabled Workbook
It is important to note that a workbook with macros will need to be saved as a specific file type: Excel Macro-Enabled
Workbook (.xlsm). If the workbook is not saved as macro-enabled, the associating macro(s) will be lost.

Additionally, macro-enabled workbooks will open with macros disabled and a security notice will be displayed under the
ribbon toolbar. Macros are disabled by default because they could potentially contain harmful computer code. You
should only open a macro-enabled workbook from a source that you trust. (See Figure 28.7)

Figure 28.7

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/macro_1.
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Macros 2

This chapter will work more closely with Visual Basic (sometimes called Visual Basic for Applications or VB). First, we'll
record another macro similar to the previous chapter that creates a basic table utilizing various formatting features.

Practice Spreadsheet

Use the workbook you created in the Macros 1 chapter. 

1. Press the Record Macro button from the Developer toolbar.
a. For the purpose of this demonstration, the macro settings can remain as their default.

2. Type the letters A–F into separate cells down the left side of the table's column.
3. Type the numbers 1–5 into separate cells across the table's top row.
4. Format the table's cells with borders.
5. Group columns I and J.

a. Select the I and J columns.
b. Go to the Data toolbar and press the Group button.

�. Type a title for the table in the top left cell.
a. For the purpose of this demonstration, the title can simply be "Table title."
b. The title needs to be in the row above the table's row of numbers.

7. Format the table title's row with Heading 1.
�. Format the number and letter labels in bold. (See Figure 29.1)
9. Press the Stop Recording button from the Developer toolbar.

Figure 29.1

 
Additionally, we will record a macro to remove the table.
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1. Press the Record Macro button from the Developer toolbar.
2. Ungroup columns I and J.

a. Select columns I and J.
b. Go to the Data toolbar and press the Ungroup button.

3. Select all of the table’s cells and press the Delete key.
Note: You will probably notice some of the formatting remains. The delete key removes cell values, but it does not
delete formatting. Continue with the next steps to clear formats. (See Figure 29.2)

Figure 29.2

 
4. Go to the Home toolbar.
5. Press the Clear button and select Clear Formats. (See Figure 29.3)
�. Press the Stop Recording button from the Developer toolbar.

Figure 29.3
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Visual Basic
Next, we'll look at the code composing the macros. Press the Visual Basic button from the Developer toolbar to open
the code in Visual Basic. Here, we can review, edit, and create the code used in Excel macros. (See Figure 29.4)

Figure 29.4

 

Organizing Code
Organizing code by inserting notes is an important practice for you and others to make sense of the code. Notes are
written beginning with a single apostrophe ( ' ) which the program recognizes as separate from the macro code. If text
is written without an apostrophe, the text will be colored red to indicate an error because it is not actual code.
(See Figure 29.5)
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Figure 29.5

 

Editing Code
Recording macros can be helpful for completing repetitive tasks. However, the recorded macro will likely contain a lot of
extra code as a result of selecting cells prior to performing a specific action. In Figure 29.6 below, we can see each
action begins with identifying rows, columns, or a range of cells and performing the action on the selected cell(s) (for
example, Range("E3:L12").Select). As in Figure 29.7, the code can be simplified by removing the selection and
performing the next action on the designated cell(s) directly (for example, Range("E3:L12").ClearContents).

We can take it a step further by simplifying the clear contents and clear formats lines. Instead of performing the actions
to clear content and format separately, the ClearContents action can be changed to Clear, and the code will clear
everything and the clear formats line can be deleted.
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Figure 29.6

 

Figure 29.7

 

Debugging Code
There will be situations wherein misspellings, changes, or other continuity problems between the macro code and the
spreadsheet cause a macro to fail. In the event of an error, Visual Basic will produce an error message and prompt the
user to End or Debug the macro. (See Figure 29.8)
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Figure 29.8

 
Pressing Debug will direct the user to the line of code that failed. The error will be highlighted yellow with an arrow
indicating the line of code. In the following example, the macro attempted to select a range labeled as "abc." However,
the range didn't exist. It may have been a typing error, or the user forgot to update the desired cell(s) with the indicated
label. The code or the spreadsheet can be modified to correct the error. (See Figure 29.9)

Figure 29.9

 

Supplemental Resource
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This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/macro_2.
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Macros 3

There are a lot of helpful functions with macros. We'll explore using message box prompts through macros in this
chapter. In the previous chapters, we recorded macros to create macro code, and we did some light editing to the code.
However, we haven't directly written macro code.

Practice Spreadsheet

Use the workbook you created in the Macros 1 and Macros 2 chapter. 

Message Box
In order to use a message box, we have to write the code in Visual Basic. For this example, we'll create a basic message
box to learn how it works.

1. Open Visual Basic from the Developer tab in the Excel ribbon toolbar.
2. Type Sub firstMessage() as the first line to begin a new subroutine.
3. Type Dim box1 As String in the second line.

a. The keyword Dim stands for dimension. Basically, the code is telling the computer to set aside memory to save
the value of this variable.

4. Type box1 = MsgBox("You created a message box!", vbOKOnly, "Box 1") in the third line.
a. The first argument in the MsgBox function is the text that will appear in the message box to the user.
b. The second argument defines the type of message box. The options include boxes with OK and Cancel

buttons, Yes and No buttons, and others. For this example, a simple OK button will be sufficient.
c. The third argument is the title text for the message box. This text appears along the top of the box.

5. Type End Sub in the fourth line. (See Figure 30.1)
�. Press the Play button in Visual Basic's toolbar to run the code.

Figure 30.1

 
Congratulations! You have created your first message box in Excel using Visual Basic. There are many useful situations
for a message box. For example, at the end of a macro, you may want a message box to notify that the macro has been
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completed successfully. (See Figure 30.2)

Figure 30.2

 

Input Box
In other situations, we may want an input box to allow the user to input a response.

1. Open Visual Basic from the Developer tab in the Excel ribbon toolbar.
2. Type Sub firstInput() as the first line to begin a new subroutine.
3. Type Dim box1 As String in the second line.
4. Type box1 = InputBox("Please enter your name", "Name", "Example Name") in the third line.

a. Similar to the previous MsgBox function, the InputBox function's first and second arguments define the text
displayed in the box's title and main message.

b. The third argument displays example text in the input field. You should be aware that the user will have to
delete this text to type their own.

5. Type MsgBox box1, vbOKOnly, "Your name" in the fourth line.
a. This code will display another box after the user types their name and presses OK in the input box.
b. The first argument will call the saved string (the user's input) instead of displaying a predetermined message

as performed in the previous example.
�. Type End Sub in the fifth line. (See Figure 30.3)
7. Press the Play button in Visual Basic's toolbar to run the code.

Figure 30.3

 
The new input box will prompt the user to enter their name and press OK. Another message box will be displayed with
the user's response. Now we have successfully completed an input box combined with a message box. (See Figure
30.4)
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Figure 30.4

 

Apply If Logic to a Message Box
What if we want to prompt the user with a yes or no question and allow them to follow up by inputting a response? We
may also want to record their response in the spreadsheet for review. Code can be written with logical checks to
perform the desired function.

1. Type Sub logicExample() as the first line to begin a new subroutine.
2. Type Dim answerOne As String, answerTwo As String in the second line.
3. Type answerOne = MsgBox("Did you enjoy this course?", vbYesNo, "Course Eval") in the third line.
4. Type If answer One = vbYes Then in the fourth line.

a. The If and Then keywords perform a logic function to run the next line of code only if the user's response
meets the specified requirement; in this case, the user must answer yes. Otherwise, this If logic check and the
associated code will be skipped.

5. Type MsgBox "Thank you!", vbOKOnly in the fifth line.
�. Type End If in the sixth line.
7. Type If answerOne = vbNo Then in the seventh line.
�. Type answerTwo = InputBox("Please tell us what can be improved", "Improvements") in the eighth line.

a. If the user answers no, this logic check will run code to prompt the user to type a response.
9. Type Sheets ("MessageBox").Range("C10").Value = answerTwo in the ninth line.

a. This line of code will record the user's response to the designated spreadsheet and cell.
10. Type End If in the tenth line. (See Figure 30.5)
11. Type End Sub in the eleventh line.
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Figure 30.5

 

Apply If and Else Logic to Toggle a Chart
This final example demonstrates another use for macro code to hide or display a chart in a spreadsheet. We will create
a checkbox button and source its true or false value (whether or not the box is checked) to a separate cell. Then, the
macro code will reference the indicated cell in an If and Else logic check to hide or display the designated chart.
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1. Create a simple chart referencing random values. After creating the chart, identify its title for later reference.
a. Go to the Home tab in the Excel ribbon toolbar.
b. Press the Find & Select button.
c. Select Selection Pane to show a list of objects in the spreadsheet.
d. Identify the title for the appropriate chart.

i. The eye icons on the right can be used to hide and show the object.
Note: It may be useful to record a macro of this action to copy the code for the macro in step 3.

2. Create a checkbox button to toggle between checked and unchecked, and source its value to a separate cell.
a. Go to the Developer tab in the Excel ribbon toolbar.
b. Press the Insert button and select the checkbox form control.
c. Draw the checkbox button across the desired cells and rename it.
d. Right-click the checkbox button and select Format Control….
e. Select or type an empty cell in the Cell link field.
f. Press OK.
g. Select the designated cell and rename it for quick reference later.

3. Write a macro code in Visual Basic to hide or display the chart based on the button's value.
a. Type Sub showHideChart() in the first line.

i. You should be aware the range name in the parenthesis argument will vary on the name you use.
b. Type If Range("show_chart").Value = True Then in the second line.
c. Type ActiveSheet.Shapes.Range(Array("Chart 2")).Visible = msoTrue in the third line.

i. You should be aware the chart array name will vary on the name designated in Excel. See step 1 to identify
the chart's title.

d. Type Else: in the fourth line.
e. Type ActiveSheet.Shapes.Range(Array("Chart 2")).Visible = msoFalse in the fifth line.
f. Type End If in the sixth line. (See Figure 30.6)
g. Type End Sub in the seventh line.

Figure 30.6

1. Add the macro to the checkbox button.
a. Right-click the checkbox button.
b. Select Assign Macro….
c. Select the recently-made macro.
d. Press OK.

The completed checkbox button will now hide and display the chart. The examples in this chapter are small
demonstrations of macro coding to enhance Excel spreadsheets and user experience. There are more extensive uses
for Visual Basic code in Excel that you can find on the web to help improve your spreadsheets. The best way to learn
macro coding is to practice.
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Supplemental Resource

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/macro_3.
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How to Use Search Engines

This class has two learning outcomes: first, you should be able to use Excel spreadsheets to solve business problems;
second, you should know how to use search engines like Google or DuckDuckGo to find answers to technical questions.
Any program as complex as excel is going to have more material than could ever be covered in a single semester of
class. To help you learn how to learn, this chapter will briefly cover how to use search engines to find answers to
questions you might have.

Excel has dozens of features and functions available for your use, and there are hundreds of ways to use a function, so
it can be difficult to know exactly what to do, especially when you’re first starting. We’ll look into two ways you can
search for a function: first, when you know the name of the function, and second, when you don’t know the name of the
function. 

Best Practices

Start with the name of the program (in this case, Excel).
Clarify what kind of hardware you’re using (for example, Mac or PC). 
Make sure you use correct spelling.
Only open trust-worthy websites. 
Look for articles that use industry terms and formats that will work best with your hardware.

Whether you search using the name of the function or terms that come close, when you search in a search engine,
dozens of articles will appear. You can filter through them using your best judgment; we recommend using Microsoft’s
website since they produce and maintain Excel. However, if you aren’t sure what article will be the most helpful, try right-
clicking on four or five articles and opening them in a new tab. This will let you check a variety of sources to find what’s
most relevant to you.

We’ll start by searching for one of Excel’s most basic functions: the SUM function. 

1. Open your search engine (for example, Google or DuckDuckGo).
2. In the Search Bar, type Excel function SUM.
3. Press the Enter key. 
4. Select article(s) that you think will be the most helpful and read through them until you find what you’re looking for. 

If you aren’t sure what the function name is, try using phrases that describe what the function does. In the case of the
SUM function, the phrase “add numbers” will be most helpful, since that’s what the SUM function does.

1. Open your search engine (for example, Google or DuckDuckGo).
2. In the Search Bar, type Excel function add numbers.
3. Press the Enter key. 
4. Select article(s) that you think will be the most helpful and read through them until you find what you’re looking for. 
5. If needed, further refine your search based on the correct terms.

You can use these best practices to search for other features in Excel, such as Absolute References and Named Range.
Remember to use the resources available to you through your search engine, such as videos and images. 
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Throughout the course, you may encounter practices that don’t have all of the answers written out for you; this was
intentional! You need to practice searching and learning independently to adapt to the program adjustments that come
with time. Learning how to learn additional skills in Excel or any technology is a valuable skill in your personal and
professional life.

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/how_to_use_search_en.
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Why the Standards of Professionalism?

Content is being developed.  No further action is required.  The video is available in the practice assignment.

This content is provided to you freely by BYU-I Books.

Access it online or download it at
https://books.byui.edu/bus_115_business_app/why_the_standards.
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Learning New Functions

In Excel, one of the many ways we are able to accomplish complex tasks is with the help of functions. We are going to
look at some functions that can help us and the syntax of the various functions. Syntax is the structure of the formula
we will use for the function. Most functions will have a syntax that looks similar to this:

= [function name]([information needed for function])

The equal sign (=) is the sign to Excel that we will use as a function. If you don’t input the equal sign, then the function
will not do anything. The function name lets Excel know which function to use. Usually, the function has a shortened
version of the function name that you will put in there. As you learn more functions, you will learn what you need to put
in the function name section. After you put the function name, the next step is putting the parentheses (). The
parentheses separate the function name from the information you will need for the function to run. The information
needed for the function will differ between the different functions, but usually, this information is cell names or ranges,
or sometimes they are options depending on how you want to use the function. 

For example, let’s look at the sum function. The sum function’s purpose is to add numbers together. The syntax of this
function is the following:

= SUM(number1, [number2],...)

The number2 is in a bracket because that means it is an optional input. The sum function adds whatever numbers are
entered in the informational section. If you type =SUM into a cell in Excel and press tab then Excel understands where
the function starts. Once you do so you will notice it will put the first parenthesis for you, and below, it will display a
small box holding the information shown above. That is there to help you remember the syntax of the function for your
convenience. It is also good to note the formula bar at the top of the sheet shows the part of the formula you have
entered. If you click up there, it will display the same box that appeared when you first hit the tab on the formula’s cell. 

If you click on the fx symbol next to the formula bar, it will open a window for you to put the information into with
explanations of the different information you will need to put in and a general description of what the function does.
Next to the text boxes, there is a button with an upward arrow symbol with an underline. Clicking on that button will
allow you to select a cell or range of cells. That way, if you want to add the information in cells instead of manually
inputting the number information, you can do it like that. You can also type the cell names in, or if you used a named
range or named cell, you can always just type that name in. When you use a cell in a formula instead of a number, the
formula will update automatically and show the new result if you change any of the information in any of the cells used
in the formula. So, whenever possible, you should use cell references instead of manually typing in information.

When inputting the information for a function, you can either type/select the cells for the information in the cell, use the
formula bar in a similar manner, or you can use the Fx button to open the window and put the information in there.

Let’s look at a new example for a more complicated function. Input the RANK.AVG function and press the fx key we can
see three different types of values to put in. There are three different arguments for you to put in. The first one is
Number, the second one is Ref, and the last one is Order. If you noticed, both Number and Ref are in bold while Order is
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not. That is because Order is an optional argument. If we were looking at the syntax for the formula, it would be in
brackets to show how optional it is. Now, let’s break down what each of these arguments are. The Number argument is
which number we want to find the rank of. The Ref argument is the range we are ranking. This range could be a list of
numbers, but most likely, it will be a group of cells. The Order argument determines the order in which we rank the list.
Are we ranking highest to lowest or lowest to highest? The question is answered by the Order argument. To use the
Order argument, you either enter a 0 or a 1. Zero means that the highest value will be ranked first, and the lowest value
will be ranked last. If you enter a 1, then the rankings will be reserved 

The important part of this section of the reading is not learning these particular functions but rather being able to see
how you can see the specific syntax or structure of each function and how Excel shows you can get other help. One way
you can find that help is that when you click the fx button on the bottom left of the window that opens up there is a  blue
link that says “Help on this function”. If you click on it then it will open up the Microsoft Support page with specific help
on whatever function you are trying to make. The help page will include a quick summary of the function, a video
showing an example of it, an explanation of the syntax, best practices with the function, and frequently asked questions.
If all of those don’t help solve your concern, there are also links to contacting an Excel expert and a link to a community
answer page. So, in addition to this video, you can also use the video about how to use search engines to help you as
you learn new functions.

This content is provided to you freely by BYU-I Books.

Access it online or download it at https://books.byui.edu/bus_115_business_app/using_functions.
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